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COPYRIGHT

Copyright © 1996-1998 Network Associates, Inc. and its Affiliated Companies. All Rights
Reserved. No part of this publication may be reproduced, transmitted, transcribed, stored in a
retrieval system, or translated into any language in any form or by any means without the
written permission of Network Associates, Inc.

LICENSE AGREEMENT

NOTICE TO ALL USERS: CAREFULLY READ THE FOLLOWING LEGAL AGREEMENT
(“AGREEMENT”), WHICH SETS FORTH GENERAL LICENSE TERMS FOR NETWORK
ASSOCIATES SOFTWARE. FOR THE SPECIFIC TERMS OF YOUR LICENSE, CONSULT THE
README.1ST, LICENSE.TXT, OR OTHER LICENSE DOCUMENT THAT ACCOMPANIES
YOUR SOFTWARE, EITHER AS A TEXT FILE OR AS PART OF THE SOFTWARE
PACKAGING. IF YOU DO NOT AGREE TO ALL OF THE TERMS SET FORTH THEREIN, DO
NOT INSTALL THE SOFTWARE. (IF APPLICABLE, YOU MAY RETURN THE PRODUCT TO
THE PLACE OF PURCHASE FOR A FULL REFUND.)

1. License Grant. Subject to the payment of the applicable license fees and subject to the
terms and conditions of this Agreement, Network Associates hereby grants to you a
non-exclusive, non-transferable right to use one copy of the specified version of the
Software and the accompanying documentation (the “Documentation”). You may install
one copy of the Software on one computer, workstation, personal digital assistant, pager,
“smart phone” or other electronic device for which the Software was designed (each, a
“Client Device”). If the Software is licensed as a suite or is bundled with more than one
specified Software product, this license applies to all such specified Software products,
subject to any restrictions or usage terms specified individually for any of such Software
products on the applicable product invoicing or packaging.

a. Use. The Software is licensed as a single product; it may not be used on more than one
Client Device or by more than one user at a time, except as set forth in this Section 1.
The Software is “in use” on a computer when it is loaded into the temporary memory
(i.e., random-access memory or RAM) or installed into the permanent memory (e.g.,
hard disk, CD-ROM, or other storage device) of that Client Device. This license
authorizes you to make one copy of the Software solely for backup or archival
purposes, provided that the copy you make contains all proprietary notices.

b. Server Use. To the extent that the applicable product invoicing or packaging sets forth,
you may install and use the Software on a Client Device or as a server (“Server”) within
a multi-user or networked environment (“Server Use”) for either (i) connecting,
directly or indirectly, to not more than the maximum number of specified Client
Devices or “seats”; or (ii) deploying not more than the maximum number of agents
(pollers) specified for deployment. If the applicable product invoicing or packaging
does not specify a maximum number of Client Devices or pollers, this license gives you
a single product use license subject to the provisions of subsection (a) above. A
separate license is required for each Client Device or seat that can connect to the
Software at any time, regardless of whether such licensed Client Devices or seats are
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connected to the Software concurrently, or are actually using the Software at any
particular time. 

Your use of software or hardware that reduces the number of Client Devices or seats
that connect to and use the Software simultaneously (e.g., using “multiplexing” or
“pooling” hardware or software) does not reduce the number of licenses you must
have in total. Specifically, you must have that number of licenses that would equal the
number of distinct inputs to the multiplexing or pooling software or hardware “front
end.” If the number of Client Devices or seats that can connect to the Software can
exceed the number of licenses that you have obtained, then you must have a
reasonable mechanism in place to ensure that your use of the Software does not exceed
the use limits set forth in the product invoicing or packaging. This license authorizes
you to make or download one copy of the Documentation for each Client Device or
seat that is licensed, provided that each such copy contains all of the proprietary
notices for the Documentation.

c. Volume Use. If the Software is licensed with volume use terms specified in the
applicable product invoicing or packaging, you may make, use and install as many
additional copies of the Software on the number of Client Devices as the volume use
terms specify. This license authorizes you to make or download one copy of the
Documentation for each such copy of the Software you may make according to the
volume use terms, provided that each such copy contains all of the proprietary notices
for the Documentation. You must have a reasonable mechanism in place to ensure that
the number of Client Devices on which the Software is installed does not exceed the
number of licenses you have obtained.

2. Term. This license is effective for the period of time specified in the product invoicing or
packaging, or in the README.1ST, LICENSE.TXT, or other text file that accompanies the
Software and purports to set forth the terms of your license agreement. Where the
provisions of the Agreement set forth here conflict with the provisions of the product
invoicing or packaging, the README.1ST document, the LICENSE.TXT document, the
product invoice, package, or the other text document will constitute the terms of your
license grant to use the Software. Either you or Network Associates may terminate your
license earlier than the period specified in the appropriate document in accordance with
the terms set forth therein. This Agreement and your license will terminate automatically
if you fail to comply with any of the limitations or other requirements described. When
this agreement terminates, you must destroy all copies of the Software and
Documentation. You may terminate this Agreement at any point by destroying the
Software and Documentation together with all copies of the Software and
Documentation.

3. Updates. During the term of your license, you may download revisions, upgrades, or
updates to the Software when Network Associates publishes them via its electronic
bulletin board system, website or through other online services.
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4. Ownership Rights. The Software and the Documentation are protected by United States
copyright laws and international treaty provisions. Network Associates owns and retains
all right, title and interest in and to the Software, including all copyrights, patents, trade
secret rights, trademarks and other intellectual property rights therein. You acknowledge
that your possession, installation, or use of the Software does not transfer to you any title
to the intellectual property in the Software, and that you will not acquire any rights to the
Software except as expressly set forth in this Agreement. You agree that any copies of the
Software and Documentation will contain the same proprietary notices that appear on
and in the Software and Documentation.

5. Restrictions. You may not rent, lease, loan or resell the Software, or permit third parties
to benefit from the use or functionality of the Software via a timesharing, service bureau
or other arrangement. You may not transfer any of the rights granted to you under this
Agreement. You may not copy the Documentation accompanying the Software. You may
not reverse engineer, decompile, or disassemble the Software, except to the extent that the
foregoing restriction is expressly prohibited by applicable law. You may not modify, or
create derivative works based upon the Software in whole or in part. You may not copy
the Software except as expressly permitted in Section 1 above. You may not remove any
proprietary notices or labels on the Software. All rights not expressly set forth hereunder
are reserved by Network Associates. Network Associates reserves the right to
periodically conduct audits upon advance written notice to verify compliance with the
terms of this Agreement.

6. Warranty and Disclaimer

a. Limited Warranty. Network Associates warrants that for thirty (30) days from the date
of original purchase or distribution the media (for example, the diskettes) on which the
Software is contained will be free from defects in materials and workmanship.

b. Customer Remedies. Network Associates’ and its suppliers’ entire liability, and your
exclusive remedy, shall be, at Network Associates’ option, either (i) return of the
purchase price paid for the license, if any, or (ii) replacement of the defective media on
which the Software is contained with a copy on non-defective media. You must return
the defective media to Network Associates at your expense with a copy of your receipt.
This limited warranty is void if the defect has resulted from accident, abuse, or
misapplication. Any replacement media will be warranted for the remainder of the
original warranty period. Outside the United States, this remedy is not available to the
extent that Network Associates is subject to restrictions under United States export
control laws and regulations.

Warranty Disclaimer. To the maximum extent permitted by applicable law, and
except for the limited warranty set forth herein, THE SOFTWARE IS PROVIDED ON
AN “AS IS” BASIS WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED.
WITHOUT LIMITING THE FOREGOING PROVISIONS, YOU ASSUME
RESPONSIBILITY FOR SELECTING THE SOFTWARE TO ACHIEVE YOUR
INTENDED RESULTS, AND FOR THE INSTALLATION OF, USE OF, AND
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RESULTS OBTAINED FROM THE SOFTWARE. WITHOUT LIMITING THE
FOREGOING PROVISIONS, NETWORK ASSOCIATES MAKES NO WARRANTY
THAT THE SOFTWARE WILL BE ERROR-FREE OR FREE FROM INTERRUPTIONS
OR OTHER FAILURES, OR THAT THE SOFTWARE WILL MEET YOUR
REQUIREMENTS. TO THE MAXIMUM EXTENT PERMITTED BY LAW, NETWORK
ASSOCIATES DISCLAIMS ALL WARRANTIES, EITHER EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND
NONINFRINGEMENT WITH RESPECT TO THE SOFTWARE AND THE
ACCOMPANYING DOCUMENTATION. SOME STATES AND JURISDICTIONS DO
NOT ALLOW LIMITATIONS ON IMPLIED WARRANTIES, SO THE ABOVE
LIMITATIONS MIGHT NOT APPLY TO YOU. The foregoing provisions shall be
enforceable to the maximum extent permitted by applicable law.

Your purchase of or payment for the Software may entitle you to additional warranty
rights, which Network Associates will specify in the product invoicing or packaging
you received with your purchase, or in the README.1ST , LICENSE.TXT or other text
file that accompanies the Software and purports to set forth the terms of your license
agreement. Where the provisions of this Agreement conflict with the provisions of the
product invoice or packaging, the README.1ST, the LICENSE.TXT, or similar
documents, the invoice, packaging, or text file will set forth the terms of your warranty
rights for the Software.

7. Limitation of Liability. UNDER NO CIRCUMSTANCES AND UNDER NO LEGAL
THEORY, WHETHER IN TORT, CONTRACT, OR OTHERWISE, SHALL NETWORK
ASSOCIATES OR ITS SUPPLIERS BE LIABLE TO YOU OR TO ANY OTHER PERSON
FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF
ANY CHARACTER INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF
GOODWILL, WORK STOPPAGE, COMPUTER FAILURE OR MALFUNCTION, OR
FOR ANY AND ALL OTHER DAMAGES OR LOSSES. IN NO EVENT WILL NETWORK
ASSOCIATES BE LIABLE FOR ANY DAMAGES IN EXCESS OF THE LIST PRICE
NETWORK ASSOCIATES CHARGES FOR A LICENSE TO THE SOFTWARE, EVEN IF
NETWORK ASSOCIATES SHALL HAVE BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES. THIS LIMITATION OF LIABILITY SHALL NOT APPLY TO
LIABILITY FOR DEATH OR PERSONAL INJURY TO THE EXTENT THAT
APPLICABLE LAW PROHIBITS SUCH LIMITATION. FURTHERMORE, SOME
STATES AND JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION
OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THIS LIMITATION AND
EXCLUSION MAY NOT APPLY TO YOU. The foregoing provisions shall be enforceable
to the maximum extent permitted by applicable law.

8. United States Government. The Software and accompanying Documentation are
deemed to be “commercial computer software” and “commercial computer software
documentation,” respectively, pursuant to DFAR Section 227.7202 and FAR Section
12.212, as applicable. Any use, modification, reproduction, release, performance, display
or disclosure of the Software and accompanying Documentation by the United States
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Government shall be governed solely by the terms of this Agreement and shall be
prohibited except to the extent expressly permitted by the terms of this Agreement. 

9. Export Controls. Neither the Software nor the Documentation and underlying
information or technology may be downloaded or otherwise exported or re-exported (i)
into (or to a national or resident of) Cuba, Iran, Iraq, Libya, North Korea, Sudan, Syria or
any other country to which the United States has embargoed goods; or (ii) to anyone on
the United States Treasury Department’s list of Specially Designated Nations or the
United States Commerce Department’s Table of Denial Orders. By downloading or using
the Software, you are agreeing to the foregoing provisions and you are certifying that you
are not located in, under the control of, or a national or resident of any such country or
on any such list.

IN ADDITION, YOU SHOULD BE AWARE THAT EXPORT OF THE SOFTWARE MAY
BE SUBJECT TO COMPLIANCE WITH THE RULES AND REGULATIONS
PROMULGATED FROM TIME TO TIME BY THE BUREAU OF EXPORT
ADMINISTRATION, UNITED STATES DEPARTMENT OF COMMERCE, WHICH
RESTRICT THE EXPORT AND RE-EXPORT OF CERTAIN PRODUCTS AND
TECHNICAL DATA. IF THE EXPORT OF THE SOFTWARE IS CONTROLLED UNDER
SUCH RULES AND REGULATIONS, THEN THE SOFTWARE SHALL NOT BE
EXPORTED OR RE-EXPORTED, DIRECTLY OR INDIRECTLY, (A) WITHOUT ALL
EXPORT OR RE-EXPORT LICENSES AND UNITED STATES OR OTHER
GOVERNMENTAL APPROVALS REQUIRED BY ANY APPLICABLE LAWS, OR (B) IN
VIOLATION OF ANY APPLICABLE PROHIBITION AGAINST THE EXPORT OR
RE-EXPORT OF ANY PART OF THE SOFTWARE. SOME COUNTRIES HAVE
RESTRICTIONS ON THE USE OF ENCRYPTION WITHIN THEIR BORDERS, OR ON
THE IMPORT OR EXPORT OF ENCRYPTION EVEN IF FOR ONLY TEMPORARY
BUSINESS OR PERSONAL USE. YOU ACKNOWLEDGE THAT THE
IMPLEMENTATION AND ENFORCEMENT OF THESE LAWS IS NOT ALWAYS
CONSISTENT AS TO SPECIFIC COUNTRIES. ALTHOUGH THE FOLLOWING
COUNTRIES ARE NOT AN EXHAUSTIVE LIST, THERE MAY EXIST RESTRICTIONS
ON THE EXPORTATION OF ENCRYPTION TECHNOLOGY TO, OR IMPORTATION
FROM: BELGIUM, CHINA (INCLUDING HONG KONG), FRANCE, INDIA,
INDONESIA, ISRAEL, RUSSIA, SAUDI ARABIA, SINGAPORE, AND SOUTH KOREA.
YOU ACKNOWLEDGE THAT IT IS YOUR RESPONSIBILITY TO COMPLY WITH ANY
AND ALL GOVERNMENT EXPORT AND OTHER APPLICABLE LAWS, AND THAT
NETWORK ASSOCIATES HAS NO FURTHER RESPONSIBILITY AFTER THE INITIAL
SALE TO YOU WITHIN THE ORIGINAL COUNTRY OF SALE.

10. High Risk Activities. The Software is not fault-tolerant and is not designed or intended
for use in hazardous environments requiring fail-safe performance, including without
limitation, in the operation of nuclear facilities, aircraft navigation or communication
systems, air traffic control, weapons systems, direct life-support machines, or any other
application in which the failure of the Software could lead directly to death, personal
injury, or severe physical or property damage (collectively, “High Risk Activities”).
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Network Associates expressly disclaims any express or implied warranty of fitness for
High Risk Activities.

11. Miscellaneous. This Agreement is governed by the laws of the United States and the
State of California, without reference to conflict of laws principles. The application of the
United Nations Convention of Contracts for the International Sale of Goods is expressly
excluded. The Agreement set forth here is advisory in nature and does not supersede the
provisions of any Agreement set forth in the README.1ST, LICENSE.TXT, or other text
file that accompanies the Software and purports to set forth the terms of your license
agreement. Where the provisions of this Agreement conflict with the provisions of the
README.1ST or the LICENSE.TXT document, the text document will constitute the
terms of your license grant to use the Software. This Agreement may not be modified
except by a written addendum issued by a duly authorized representative of Network
Associates. No provision hereof shall be deemed waived unless such waiver shall be in
writing and signed by Network Associates or a duly authorized representative of
Network Associates. If any provision of this Agreement is held invalid, the remainder of
this Agreement shall continue in full force and effect. The parties confirm that it is their
wish that this Agreement has been written in the English language only. 

12. Network Associates Customer Contact. If you have any questions concerning these
terms and conditions, or if you would like to contact Network Associates for any other
reason, please call (408) 988-3832, fax (408) 970-9727, write Network Associates, Inc. at
3965 Freedom Circle, Santa Clara, California 95054, or visit the Network Associates
website at http://www.nai.com.
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Preface
About This Manual
Thank you for purchasing Nuts & Bolts, a suite of very powerful yet easy 
to use Windows software utilities. Nuts & Bolts helps you keep your PC 
working at optimum efficiency and speed. You can diagnose and repair 
your system and application software; create a recovery disk and image 
snapshots of critical sectors of your hard drives; avoid lost data during 
application crashes; run virus scans to find and remove computer viruses; 
automatically or interactively create backup sets; back up to a protected 
volume file which makes your data recoverable when it otherwise would 
not be; and ensure that your PC meets Year 2000 hardware compliancy. 
Safe & Sound also places a wealth of information about your PC system at 
your fingertips with DiscoverPro.

From the moment you install Nuts & Bolts, it begins protecting your PC. 
First, by guiding you to create a recovery disk that you can use later if 
problems arise. Second, by activating Bomb Shelter, which immediately 
protects you against losing unsaved information in the event that an 
application crashes. Next you’ll want to use Retake to create a backup set 
of your drives’ valuable data that you can restore in case any 
unrecoverable problems arise.

After repairing and protecting your system, you’re ready to use other 
Nuts & Bolts utilities to clean and optimize, prevent and protect, and 
secure and manage its information.

What you’re about to learn:

• What utility programs are included with Nuts & Bolts and what you 
can do with each one.

• What you need before starting.

• How to install Nuts & Bolts software (see Nuts & Bolts Quick Install on 
page xix).

• How to start the Nuts & Bolts utilities.
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Nuts & Bolts Overview
Nuts & Bolts is made up of these suites of utility programs:

Repair and Recover

• Disk Minder (Windows 3.1x/95/98) safely, easily, and quickly 
diagnoses and repairs existing or potential disk problems.

• McAfee Image (Windows 3.1x/95/98) saves an “image” copy of critical 
disk information in a file, and restores the image later if your disk is 
corrupted.

• Rescue Disk (Windows 3.1x/95/98) creates a custom rescue disk that 
you can use to boot up the PC and begin recovery if you can’t start 
from the system hard drive.

• PC Checkup (Windows 95/98) thoroughly analyzes the state of your 
PC’s hardware and software. It can repair many software and 
configuration problems for you. When PC Checkup finishes its 
diagnosis, it produces a full report of any problems. You can let PC 
Checkup fix them, or perform repairs yourself.

• Discover Pro (Windows 3.1x/95/98) shows a wealth of information 
about your hardware and software. It also lets you run diagnostics 
and benchmark tests.

• Undelete (Windows 95) lets you undelete files that you have deleted.

Clean and Optimize

• Cleanup Wizard (Windows 3.1x/95/98) finds duplicate, old or unused 
files that you can delete, compress or move on a drive.

• Disk Tune (Windows 95/98) improves your PC’s performance by 
defragmenting, or rearranging, files or consolidating free disk space on 
the hard disk for maximum efficiency.

• Registry Wizard (Windows 95/98) guides you through easily 
maintaining, troubleshooting or repairing the Registry database.

• Registry Pro (Windows 95/98) lets you manually troubleshoot, edit, 
and repair the Registry database.

• Shortcut Wizard (Windows 95/98) locates any orphaned shortcuts on 
your system that point to deleted or moved files so you can repair or 
delete them.

• Launch Rocket (Windows 95/98) dramatically reduces application 
launch times by directing your system to read parts of applications 
from the hard disk in the most efficient manner. It also copies and 
compresses start-up parts of applications, storing them in a single file 
that it reads, rather than reading multiple files across the hard drive.
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Prevent and Protect

• Bomb Shelter (Windows 3.1x/95/98) protects various critical parts of 
your Windows system from being overwritten by other programs.

• WinGauge (Windows 3.1x/95/98) graphically tracks system memory, 
resources, drives, and performance in real time, providing advance 
alerts and warnings.

• McAfee VirusScan lets you scan your computer for viruses. For 
complete instructions, see the online VirusScan manual PDF file 
provided on the CD disc in the Manuals folder.

• Year 2000 Checker (Windows 3.1x/95/98) lets you test your system 
hardware for Year 2000 compliancy. If it is not, Year 2000 Checker 
installs Y2Kfixer.com to make your PC compliant so it handles dates 
accurately starting on 01-01-2000.

• Trash Guard (Windows 95/98) protects all the files you delete, even 
files deleted in DOS or in 16-bit Windows applications, by sending 
them to the Recycle Bin.

• Retake (Windows 95/98) lets you create automatic or interactive 
backups of selected drives, directories, files or file types. You can back 
up to a protected volume file (a separate area on the drive). A 
protected volume file contains information about each file in every 
sector to ensure that files can be recovered even if the hard drive’s 
directories and data are severely damaged or lost. You can also create 
mirror backups that instantly back up data as you save it, make 
backups after a time delay when the PC is idle, or create manual 
backups.

Secure and Manage

• EZ Setup (Windows 95/98) lets you customize the Windows desktop, 
startup programs, icons, startup and close screens, and so on.

• Launch Pad (Windows 3.1x/95/98) lets you create custom Launch Pads, 
keeping program, document or folder icons handy so you can open 
them fast.

• McAfee Fortress (Windows 3.1x/95/98) encrypts sensitive files so 
unauthorized people cannot access them.

• McAfee Shredder (Windows 3.1x/95/98) permanently deletes files so 
they cannot be restored or rebuilt, and “security wipes” free disk 
space.

• McAfee Zip Manager (Windows 3.1x/95/98) easily creates compressed 
ZIP files, or unzips existing ZIP files.

• Quick Copy (Windows 3.1x/95/98) lets you select files and folders (or 
directories) and quickly copy them from one location to another.
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What This Package Contains
Your Nuts & Bolts software package should include:

• One Nuts & Bolts CD-ROM disc

If your PC does not have a CD-ROM drive, you can obtain a set of 
3.5-inch disks from our Customer Service department.

• This McAfee Nuts & Bolts User’s Guide

• A Registration card

Please fill out and return your Registration card to receive technical 
support and receive new product and product upgrade information.

What You Need Before Starting
To use Nuts & Bolts, you need:

• Nuts & Bolts software (on CD-ROM disc)

• A PC with a 386 SX or above CPU (central processing unit)

• DOS version 3.1x or later (DOS 3.3 for PS/2 models)

NOTE: Microsoft DOS version 7.0 or later is included as part of Microsoft 
Windows 95/98.

• Microsoft Windows 3.1x, Windows 95 or Windows 98

• At least 20 MB (megabytes) of RAM (random access memory)

• One 3.5-inch disk drive

• 18 MB of available hard drive space

• A 16-color VGA monitor that supports 640 x 480 pixels (or better)

• A CD-ROM drive
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Í TIP: This guide assumes you know the basics of using Microsoft 
Windows. You should know how to point, click, double-click, and 
drag. You should also know how to choose commands from menus, 
select options in dialog boxes, and enter, select, and edit text. See your 
Microsoft Windows User’s Guide for details

Getting Started
This section offers Quick Install and Quick Start procedures to help you 
install and start McAfee Nuts & Bolts. You’ll also find information about 
getting online Help.

Nuts & Bolts Quick Install

To install Nuts & Bolts:

1. Insert the McAfee Nuts & Bolts CD into the CD-ROM drive.

The Nuts & Bolts Installer should autoplay (go to step 3), but if it 
doesn’t go to step 2.

2. Do one of the following:

• For Windows 95/98:

Double-click the My Computer icon, the Nuts & Bolts icon and the 
Setup.exe or Setup icon.

• For Windows 3.1x:

Choose the Run command from the File menu.

Type e:\setup.exe  (where “e” is the drive letter for your 
CD-ROM drive) or a:\setup.exe  (where “a” is the drive letter 
for your 3.5-inch drive) and click OK.

3. Follow the on-screen instructions to supply the requested 
information.

Setup requires you to enter information for registering the software.
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Nuts & Bolts Quick Start
You can start any of the Nuts & Bolts utilities from Nuts & Bolts Central.

To start Nuts & Bolts Central in Windows 95/98:

1. Click the Start button on the taskbar.

2. Choose the Nuts & Bolts command directly from the Start menu, or 
from the Start > Programs > Nuts & Bolts menu.

The Nuts & Bolts Central window appears.

Figure 4–1. The Nuts & Bolts Central window gives you access to all 
Nuts & Bolts utilities

To start Nuts & Bolts Central in Windows 3.1x:

1. Double-click the McAfee Nuts & Bolts program group in the Program 
Manager window.

2. Double-click the Nuts & Bolts Central program icon.

The Nuts & Bolts Central window appears.

Graphic Interface Tips and Techniques
Nuts & Bolts supports advanced Windows graphics interface techniques 
that allow you to:

• Create desktop icons for individual Nuts & Bolts utilities. You can 
disable this feature by starting a utility, clicking the Properties button, 
and deselecting its Show Icon on Desktop check box.
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• Drag and drop icons, files, or folders from Program Manager in 
Windows 3.1x or from Windows Explorer or My Computer in 
Windows 95/98 onto the icons of Nuts & Bolts utilities.

• Right-clicking (pressing the Right mouse button) the WinGauge or 
Launch Pad windows to display a pop-up menu of commands. All the 
Nuts & Bolts utilities provide a Right-click pop-up menu when you 
point to their icons in the Windows Explorer or in My Computer. You 
can include some of the Nuts & Bolts utilities as commands in the Send 
To menu.

For details about showing or hiding icons on the desktop, dragging and 
dropping, and displaying pop-up menus by Right-clicking, see the 
respective Nuts & Bolts utilities’ sections in this guide.

Getting Help
Nuts & Bolts provides online Help to give you detailed information about 
the windows, dialog boxes, and options available in each of the Nuts & 
Bolts utilities. It also offers procedures for all the tasks you can perform. 
There are a few basic ways to access Nuts & Bolts’ online Help:

• In Windows 95/98, choose the Programs > Nuts & Bolts > Nuts & 
Bolts Help File command from the Start menu or click the ? button in 
Nuts & Bolts Central.

• In WinGauge or Launch Pad, Right-click and choose the Help 
command.

• In Bomb Shelter, PC Checkup, Retake, Year 2000 Checker, McAfee 
Image, Rescue Disk, Cleanup Wizard, DiscoverPro, Disk Tune, 
DiskMinder, EZ Setup, Registry Wizard, Stronghold, Shredder, 
Shortcut Wizard, and Zip Manager Wizard, click the Help button.

• In Registry Pro and Zip Manager Advanced window, choose the Help 
Topics, What’s This?, or About command from the Help menu.

Technical Support
Technical Support is available from 6 a.m. to 6 p.m. Pacific time, 
weekdays. You can contact Technical Support via telephone and the 
World Wide Web home page. Outside of support hours, you may leave a 
voice message. Technical Assistance Centers are located in California and 
the Netherlands.

If you purchased your product from one of our International Distributors, 
you must contact that distributor for support assistance. Refer to 
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http://www.nai.com on the World Wide Web for information on contacting 
our International Distributors.

Table i describes the various ways to access Technical Support.
:

World Wide Web
You can obtain additional information about Network Associates and its 
products and services from the World Wide Web at http://www.nai.com.

Training
Network Associates offers a comprehensive set of training courses 
focused on hands-on network analysis, monitoring, and troubleshooting 
using products from Network Associates. Courses can be conducted at 
your site, at central locations throughout the globe, or at training centers 
in Menlo Park and Anaheim, California; Chicago, Illinois; and Atlanta, 
Georgia. For more information about these courses, contact your sales 
representative or call Network Associates.

Table i. Contacting the Technical Support Department

North American and International, 0600–1800 (PST), 
Monday–Friday

Telephone Number (North America only) +1-408-988-3832

Telephone Number (other International) +1-650-473-2090

Europe, 0730–1730 (GMT), Monday–Friday

Telephone Number +31 (0) 20 586 6100

Worldwide

World Wide Web (Internet) information http://www.nai.com
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1Repair and Recover 1
Over time as you use your computer, the information stored on the hard 
drives changes. This happens when you save, modify or move documents 
as well as when you install, update or uninstall application programs. As 
the information changes, there is a slim chance that critical information, 
such as the master boot record used to start your PC, can accidentally 
become damaged.

In a perfect world, all application programs would coexist peacefully, 
store their data exactly where they should, and always play by the rules. 
In the real world, this doesn’t always happen. The result can be missing 
files; orphaned shortcuts, fonts or registry entries; inefficient Windows 
settings; or even corrupted data that can prevent you from starting 
Windows, or worse yet, from starting your PC at all.

In a perfect world, the electric power coming into your computer would 
always flow like a clear, placid, spring-fed stream, with no power spikes 
or surges to inadvertently change the state of a critical bit of data, or worse. 
In computing, as in the real world, there may be perfect moments or a 
perfect day at a stream, but a perfect lifetime is exceedingly rare.

If you’ve encountered a problem with your computer, we understand 
your frustration. While you’re trying to get good work done 
quickly—who these days has the luxury of doing work at a leisurely 
pace?—your PC stops in its tracks. Such problems force you to focus on the 
tool rather than on the work itself.

Our advice? First, remain calm. Second, take a deep breath. Third, read 
this chapter, which describes Nuts & Bolts 98’s Repair and Recover 
utilities designed to help you resolve problems with your PC’s system 
software and data.

• Disk Minder–which lets you diagnose and repair existing or potential 
problems with your data and the surface of recordable disk drives 
(any drive that lets you save, or write, data to it).

• McAfee Image–which lets you save an “image” copy of critical disk 
information in a special file, and restore that image file later if you 
need to repair or recover the disk’s information.
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Repair and Recover
• Rescue Disk–which lets you make a Rescue disk for your computer 
that you can use to boot up the PC—if you can’t start from the system 
hard drive—and begin recovery of your system. If you are an 
advanced user, you can add your choice of files to the Rescue disk that 
you might want to have at hand if you need to recover a hard drive 
later.

• PC Checkup thoroughly analyzes the state of your PC’s hardware and 
software. It can repair many software and configuration problems for 
you. When PC Checkup finishes its diagnosis, it produces a full report 
of any problems. You can let PC Checkup fix them, or perform repairs 
yourself.

• Discover Pro shows a wealth of information about your hardware and 
software. It also lets you run diagnostics and benchmark tests.

• Undelete lets you recover files that you’ve deleted even after you’ve 
emptied the Recycle Bin.

After you finish testing your system, and repairing it if necessary, you can 
use Retake to create backup copies of your PCs data. At any point along 
the way, you can use Discover Pro to obtain more information about your 
system.

Disk Minder
Disk Minder lets you safely, easily, and quickly diagnose and repair 
existing or potential problems with the disk drives where you save your 
valuable application programs and data. Disk Minder verifies, and can 
correct automatically or interactively, problems with the partition tables, 
File Allocation Tables (FATs), boot sector, extended boot sector, 
compression structure, directory structures, file dates and times, 
filenames, and clusters. A cluster, the smallest measurement unit of disk 
storage space, is typically four or more sectors on a disk. Disk Minder also 
checks for non-ANSI and duplicate filenames, and can verify the integrity 
of the sectors on a disk by performing read/write tests of the entire 
recordable surface area of the disk.

Why should you use Disk Minder instead of ScanDisk, when ScanDisk 
comes with DOS and Windows?

• ScanDisk cannot correct the most serious errors, such as those with the 
hard drive’s partition table or boot sectors.

• ScanDisk corrects the second most serious problems—cross-linked 
files, and size errors—improperly, never actually fixing the error.

• ScanDisk misses many minor problems that can interfere with 
Windows operations, such as duplicate files or non-ANSI files.
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• Disk Minder can scan your disk in less than half the time it takes 
ScanDisk, making Disk Minder more convenient to use frequently.

When should you use Disk Minder? Immediately after a system crash or 
whenever you receive a message telling you a file cannot be accessed for 
any reason, you should use Disk Minder to verify the integrity of the disk 
containing that file. The earlier you fix a disk problem, the less chance 
there is of it causing a more serious problem down the road.

Í TIP: When you use Disk Minder, always create an Undo file. Then if 
the repairs cause any unexpected or undesirable results, you can 
revert to the Undo file so the disk returns to its state before you ran 
Disk Minder.

You can use Disk Minder in three main ways:

• Fix Errors Automatically Using Default Values–If you are just 
getting started using your PC, if you are uncertain about what errors 
you might want to fix, or if you simply don’t have extra time to 
oversee the disk repair, you can let Disk Minder fix any errors it finds 
for you. You can select either the Fix Errors Automatically Using 
Default Values option in the Disk Minder window, or the Auto Fix 
Errors option in the Disk Minder Properties sheet. Both options make 
Disk Minder automatically fix errors. During the repair, Disk Minder 
verifies data on the selected disks, and fixes any problems it finds 
without asking your advice. If you decide to use this option, you can 
start Disk Minder and leave it running while you’re away from your 
PC, such as before you leave the office at night.

• Report Errors Only–If you are a more advanced PC user, you may 
want to see a report showing any errors on a disk before you decide 
what to do to resolve these errors. You can easily get a detailed report 
about the state of a disk using the Report Errors Only option in the 
Disk Minder Properties sheet. When you select this option and click 
Start, Disk Minder verifies the information on your disk, and 
produces a summary and detail report. It does not make any changes 
to the disk. You can print the detail report of the test results on your 
printer or save it as a text file. This gives you the facts you need to 
decide whether and how to fix disk problems. 
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• Fix Errors Interactively–If you deselect the Fix Errors Automatically 
Using Default Values check box in the Disk Minder window, Disk 
Minder runs an interactive disk repair process by displaying a 
message about any errors it finds. Disk Minder lets you decide 
whether to fix each error or not, and how to fix the error. Each message 
describes the error situation and offers a suggested solution (the 
default choices in the message).

NOTE: Nuts & Bolts 98 provides a DOS, Windows 3.1x and 
Windows 95/98 version of Disk Minder. If you suspect there is a problem 
with a disk’s information, run Disk Minder in Windows. If the disk 
problems prevent you from starting Windows, or if your system has 
recently crashed, use Disk Minder in DOS first. Once you can run 
Windows again, use Disk Minder in Windows to complete any repairs.

No matter which disk repair method you use, you can specify Disk Minder 
properties to specify the kinds of data it checks, whether Disk Minder 
performs read/write tests to verify the integrity of the disk surface, and if 
so, how many times it repeats the read/write tests.

Creating and Reverting to an Undo File
If Disk Minder finds a problem, it asks if you want to create an Undo file 
before making any changes to the disk.

To create an Undo file, click Yes and pick a destination for the Undo file.

To revert to an Undo file, click Undo in the Disk Minder window. Select 
the drive with an Undo file you want to use. Then click OK.

Using Disk Minder to Auto Fix Errors
Using Disk Minder for Windows to automatically fix errors is very easy. 
Just start Disk Minder, select the disk drives to check, select whether you 
want to check the disk surface for read errors, select the Fix Errors 
Automatically Using Default Values check box, and click the Start button. 
Until the process is complete, you can walk away from your PC because 
no further interaction from you is required.
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Using Disk Minder to Report Errors Only
Before interactively fixing errors, you can run Disk Minder with the 
Report Errors Only option selected to examine or print reports describing 
a disk’s problems.

To use Disk Minder to report errors only, start Disk Minder, click 
Properties, select the Report Errors Only check box and click OK. Then 
select the disks to check, whether to scan the disk surface and click Start. 
Disk Minder checks the disk and displays the Summary report.

Disk Minder Summary Report
The Summary report tells you how many errors were found on the 
scanned drive. It also gives you complete information about the status of 
clusters (the smallest storage units of information on a PC drive) on the 
drive. You can click the Detail button to examine, save, or print a Detail 
report about your disk and any errors found and corrected.

Disk Minder Detail Report
The Detail report tells you exactly what Disk Minder found when testing 
your drive. You can click the Print button to print the Detail report. Or 
click the Save button to save this report as a text file for later review.

The Detail report describes the following kinds of information: the total 
number of errors found on the drive, if any; the cluster status information 
(bytes per cluster, available clusters, bad clusters, and the number of 
clusters in the total number of directories, hidden files, and user files); 
Partition Table errors; File Allocation Table errors; Boot Sector errors; 

Click Detail to display details of the repair Click Print to print the report Click Save to save the report
as a text file

If you selected two or more drives, use these
buttons to jump from one report to another
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Extended Boot Sector errors; compression structure errors; directory 
errors; and file errors.

Interactively Fixing Errors
Disk Minder defaults to informing you when it finds an error and letting 
you interactively decide whether or not you want to fix the problem. 
When Disk Minder finds a problem while checking a drive interactively, 
it displays a message that asks you what to do to resolve it. The suggested 
response is indicated by the default settings, including which button is the 
default (in the illustration, the Fix button is the default, which means that 
pressing ENTER, is like clicking the Fix button).

Customizing Disk Minder Properties

You can set Disk Minder properties that determine whether it will only 
report errors or fix them, whether it fixes errors automatically or 
interactively, and what kinds of information it will verify. You may also 
decide whether to test the drive’s recordable surface media and how many 
repetitions of this surface scan you want Disk Minder to perform.

Your Disk Minder options are:

• Report Errors Only–causes Disk Minder to only report errors in the 
Summary and Detail reports.

• Auto Fix Errors–fixes any data or disk errors automatically. This is the 
same as selecting the Fix Errors Automatically Using Default Values 
check box in the Disk Minder window. If you deselect this check box, 
Disk Minder lets you fix errors interactively.

Select Properties options
and click OK
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• Check Partition Tables–verifies partition tables, that define the 
partitions subdividing a physical drive into more than one logical 
drive. Partitions are created using FDISK or other programs, often 
before storing data on the disk. All drives have partition tables.

• Check File Dates + Times–verifies that dates and times associated 
with files are valid. In Windows 95, Disk Minder verifies the Created, 
Modified, and Accessed date and time stamps. In Windows 3.1x, only 
the last modified date and time are saved with each file.

• Check Host Drive First–checks the physical drive where DriveSpace 
or DoubleSpace compressed volume files are stored. Then it checks 
the compressed volume files, or logical disks.

• Check for Valid File Names–verifies that filenames use acceptable 
characters. Valid characters for filenames are numbers 0-9, letters A-Z, 
and basic symbols excluding the backslash ( \ ), greater than ( > ), less 
than ( < ), colon ( : ), double quotations ( “ ), and bar or pipe ( | ). Disk 
Minder for Windows 95 also checks long filenames as well as short 
filenames that follow the 8.3 filename convention.

• Check for Non-ANSI File Names–finds any non-ANSI filenames. All 
characters are uniquely numbered from 0 through 255. Two standards 
exist for numbering characters: ANSI and IBM ASCII. Windows uses 
ANSI, and characters that appear on both numbering systems are 
automatically translated by Windows to their ASCII equivalents for 
use in filenames, which must be stored in ASCII. Some ASCII 
characters do not have ANSI equivalents, in which case, Windows is 
unable to display or access the filename properly. Disk Minder can 
detect and fix this problem.

• Check for Duplicate File Names–checks for duplicate 
filenames—files with the same name in the same directory.

• Test Drive Surface–performs read/write tests of a disk’s recordable 
surface media. This may take some time because the entire disk is read 
and then rewritten. If a sector is damaged, Disk Minder saves the data 
elsewhere so you can try to recover it later. Disk Minder maps out the 
bad sector so it won’t be used in the future.

• Surface Scan Repetitions–becomes active if you select the Test Drive 
Surface check box. Enter a number between 1 and 10, for the number 
of times you want to perform a complete read/write test on the drive’s 
surface. The more repetitions, the longer the process takes, but the 
more confirmation you have that the media can accurately store data. 
If you decide to run several repetitions, you may also want to use the 
Auto Fix Errors option and let Disk Minder perform the tests while 
you are away from your PC.
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Using Disk Minder in DOS
Disk Minder lets you repair disks even if you cannot start Windows.

To use Disk Minder in DOS:

1. Do one of the following at the DOS prompt, and press ENTER:

If you are using Windows 3.1x, type: C:\NUTSBOLT\DMDOS

If you are using Windows 95, type: C:\WINDOWS\DMDOS

Disk Minder searches your PC for drives and then asks you to select 
the drives you want to check from the Drives list.

2. Press the TAB key to change the drives that are currently selected to be 
scanned. Selected drives have an x  beside them in the list.

3. Press the UP ARROW and DOWN ARROW keys to highlight a drive and 
press ENTER to select it.

4. Press the RIGHT ARROW key to move the cursor back to the buttons.

You can select Disk Minder options if you like. Your Disk Minder 
options are: Fix Errors Automatically, Test Drive Surface, Check 
DxSpace Host Drive First, Check for Valid File Names, Check for 
Duplicate File Names, Check Reserved Attribute Bits, and Display 
Summary for Each Drive. For details, see Customizing Disk Minder 
Properties on page 6.

5. Select Start and press ENTER to start checking the drives.

Disk Minder displays a screen showing the kind of data it is checking 
and the options in effect. If the Display Summary for Each Drive 
option is set, Disk Minder displays a summary message showing the 
total number of errors found on each drive, if any. It also shows 
information about the clusters on the drive.

McAfee Image
Although it happens rarely, data stored on a hard drive can become 
damaged in several ways. For example, the electric company may be 
working down the street and accidentally send a spike, or power surge, to 
your PC. Even if you use a surge protector and connect all the computer’s 
power cords and the modem’s phone line to a surge protector (instead of 
connecting them directly to wall connectors), power surges can still reach 
your PC and cause lost or corrupted data.

An important step in preventing disaster is using Nuts & Bolts 98’s Image 
to make a “snapshot” of the most critical areas on your hard drives. Since 
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even a recent backup copy is still not as good as recovering your current 
data, you’ll want to try to recover the latest data first if anything goes 
wrong. If you use Image to make a snapshot of the most crucial 
information on your drives, then if a drive becomes corrupted, you can use 
Restore to restore the most current version of your data.

Rescue Disk saves information that you’ll need if your hard disk ever fails, 
including the boot record, partition tables and FAT information. It’s a 
good idea to run Rescue Disk daily, as well as whenever you’ve 
reorganized a disk’s files using a defragmenter. This ensures that you can 
use Image’s Restore option to restore the latest states of your files and 
folders (or directories). Image stores its information in a file on your hard 
drive. This file is stored using a special, patent-pending method that 
allows the file to be recovered even if the hardware is severely damaged.

NOTE: Set the Image Properties sheet option to run Image automatically 
each time you start Windows. Image will examine your system and 
update the image only if needed. Doing this ensures you always have the 
latest data saved for your disks.

Creating an Image of Your Disks
Creating an image copy of your hard disks as a file (nbimage.dat ) only 
takes a moment. You should create a new image file any time you’ve 
rearranged files or added many new files to your hard drive.

To create an image of your hard drives, select the Create a New Image 
Backup option and click Finish. Image saves the nbimage.dat  file on 
your system hard drive, and displays a message letting you know the 
process is complete. Click OK.

Be sure to create a Rescue disk using Nuts & Bolts 98’s Rescue Disk. Rescue 
Disk places some Image information on your 3.5-inch disk.
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Setting Image Properties
You can set Image Properties to specify whether Image saves the File 
Allocation Tables (FAT), which is a roadmap or index to where all the pieces 
of files on a disk drive are located. Most likely, you’ll want to keep this 
check box selected. You can also have Image create a new image copy of 
your hard disks each time you start Windows (recommended).

Restoring Drives From an Image File
When all else fails, you can restore the critical information on one or more 
drives from an image file. Restoring an image file does NOT recover 
deleted files. If you have deleted data files that you need, you can restore 
a copy of them from your last backup set (protected volume file or 
directory) created with Retake.

NOTE: Do not restore an image, except as a last resort. The Image file does not 
contain your data files, those are located in your Retake backup set.

To restore one or more drives from an image file:

1. Start Image, select the Restore Drive(s) From Saved Image radio 
button, and click Next >.

Select whether to create
an image file or restore
an image file; then click
Finish

The first time you run
Image, it records the
date and time; thereafter,
Image shows you when
the last Image file was
created

Click Properties
to set whether
Image will save
FAT information
and to turn on
Image’s auto-save
option, which
updates the image
each time you
start Windows
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2. Do one of the following and click the Next > button:

• Select an image file to use for restoring your drives from the list of 
those found on your system hard drive.

• Click the Scan >> button to look for additional image files if you 
don’t see the one you want to use. Image scans your hard drives 
for image files. Select one of them and click Next >.

3. Select the hard drives you want to restore and click Next >.

4. Select the kinds of information you want to restore.

Image defaults to restoring the master boot sector, partitions and the 
File Allocation Tables. In most cases, you should use the Image default 
settings. If you are an advanced user, you may want to only restore 
one or two of the options:

• Master boot sector–Select this option if you cannot start the PC 
from your system hard drive. The master boot sector is the sector 
on your system hard disk that contains boot information with 
instructions for starting up your PC.

• Partitions–Select this option if you cannot find a logical drive on 
your PC. Partitions subdivide a physical drive into multiple logical 
drives. Each partition has its own drive letter.

• File allocation tables–Select this option if your files are corrupted 
and you have been unable to repair them using Disk Minder. 
Often much or all of your data may be intact on the disk, but the 
file allocation tables (FATs) may be damaged. By restoring the 
most current copy of a disk’s FAT, you can often recover files that 
would otherwise be lost.

5. Click Finish to restore the drives with the specified kinds of data.

Select an image file from
the list and click Next >
to begin restoring your
hard disks

Click Scan >> to locate
image files stored on
any disk drive on your PC;
you can restore image
files from any drive, even
damaged hard drives
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NOTE: If your Image file is more than a day or two old, or if you have 
optimized your hard disk and have not run Image, try using Disk Minder 
to repair the hard drive first.

Rescue Disk
Rescue Disk lets you create an emergency boot disk that you can use to 
boot up your PC if you encounter a problem that prevents you from 
starting the computer from the system hard drive. The system hard drive is 
the hard drive that contains your Windows directory or folder.

You can use the Rescue disk that is created by default. Or if you are an 
advanced user, you can customize your Rescue disk to add the most 
important files that you may want to use when recovering a failed hard 
drive. For example, you might want to add your CD drive’s driver 
software so you can also access that drive during the recovery process.

To create a Rescue Disk:

1. Click the Next > button in the Rescue Disk Wizard.

2. Do one of the following:

• Go to Step 3 if you want to use the default Rescue disk.

• Click Advanced if you are an advanced user and want to add 
additional files to (or remove them from) the Rescue disk.

3. Click Next >. Then click Finish.

4. Insert a disk into drive A and click OK.

Rescue Disk formats the disk and copies critical startup files to it, as 
well as any files you added. When the process is complete, Rescue 
Disk exits and returns to the desktop.

Using a Rescue Disk
Insert your Rescue disk into drive A, reboot your computer (or turn on the 
power). If your system doesn’t boot, access CMOS and make sure the 
Booting From Floppy option is enabled. Then follow the instructions on 
the screen.
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Disk Minder in DOS
Disk Minder in DOS lets you repair disks even if you cannot start 
Windows. It resolves most disk-related problems such as missing drives, 
inability to access drives, or errors accessing drives.

To use Disk Minder in DOS:

1. Type the following:

C:\WINDOWS\DMDOS

and press ENTER.

Disk Minder searches your PC for drives and then asks you to select 
the drives you want to check from the Drives list.

2. Press the TAB key to change the drives that are currently selected to be 
scanned. Selected drives have an x  beside them in the list.

3. Press the UP ARROW and DOWN ARROW keys to highlight a drive and 
press ENTER to select it.

4. Press the RIGHT  ARROW key to move the cursor back to the buttons.

You can select Disk Minder options if you like. Your options are:

• Fix Errors Automatically–fixes any data or disk errors 
automatically. This is the same as selecting the Fix Errors 
Automatically Using Default Values check box in the Disk Minder 
window. If you deselect this check box, Disk Minder will let you 
fix errors interactively.

• Test Drive Surface–performs read/write tests of the recordable 
surface media on a disk. This process may take some time because 
the entire disk is read and then rewritten. If a sector is damaged, 
Disk Minder relocates the information, saving it elsewhere on the 
disk so you can try to recover the information later. Then it maps 
out the bad sector so it won’t be used for storing data in the future.

• Check DxSpace Host Drive First–checks the physical drive 
where DriveSpace or DoubleSpace compressed volume files are 
stored. Then it checks compressed volume files, or logical disks.

• Check for Valid File Names–verifies that filenames use 
acceptable characters. Valid characters for filenames are numbers 
0-9, letters A-Z, and basic symbols excluding the backslash ( \ ), 
greater than ( > ), less than ( < ), colon ( : ), double quotations ( “ ), 
and bar or pipe ( | ). Disk Minder also checks long filenames as 
well as short filenames that follow the 8.3 filename convention.
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• Check for Duplicate File Names–checks the selected drives for 
duplicate filenames (files with the same name in the same 
directory).

• Check Reserved Attribute Bits–flags files that have any of the 
unused (by Windows/DOS) file attribute bits set. These bits may 
be set on a drive that is shared by OS/2, but otherwise you should 
most likely leave this option deselected.

• Display Summary for Each Drive–The Summary report tells you 
how many errors were found on the scanned drive. It also gives 
you complete information about the status of clusters (the 
smallest storage units of information on a PC drive) on the drive.

5. Select Start and press ENTER to start checking the drives.

Disk Minder displays a screen showing the kind of data it is checking 
and the options in effect. If the Display Summary for Each Drive 
option is set, Disk Minder displays a summary message showing the 
total number of errors found on each drive, if any. It also shows 
information about the clusters on the drive.

Image/Restore in DOS
Image/Restore can recover from drives that have been accidentally 
formatted or completely erased, if Image was recently run.

SysRecover
SysRecover can restore several of the Windows 95/98 startup files, such as 
SYSTEM.INI and the Windows Registry. You should choose this option 
only if Disk Minder finds no problems on your drives and you cannot start 
Windows even in Safe mode.

Recover Backup
Recover Backup can restore files from Retake protected volumes file 
backup sets on drives that have been damaged, erased or accidentally 
formatted.

Unformat
Unformat can restore entire drives that have been recently formatted.
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Undelete
Undelete is a DOS program like the Windows counterpart that lets you 
undelete files even after you have deleted them from your hard drive 
using the DOS delete command. For more information about the Undelete 
program, see Undelete on page 23.

PC Checkup
Nuts & Bolts’ PC Checkup can help you diagnose, repair and recover 
information on your system. It provides exhaustive testing of your PC’s 
system and configuration settings.

Performing a Standard Diagnosis and Repair
You should start with a standard diagnosis and repair. Then you can 
perform an advanced diagnosis and repair if necessary. PC Checkup lets 
you know which repairs you make can be undone later.

To use PC Checkup to diagnose and repair PC problems:

1. Click the Start button and do one of the following:

• Choose the Nuts & Bolts command from the Start menu and click 
the Checkup button.

• Choose the Programs > Nuts & Bolts > PC Checkup command.

The PC Checkup Wizard appears.

2. Click Next > to perform a standard diagnosis first.

NOTE: Clicking Advanced lets you perform advanced diagnostics. This 
option lets you run a more detailed analysis of your PC. You should use 
this option after performing a standard diagnosis as described in this 
procedure. Clicking Undo lets you undo repairs made using PC Checkup. 
For more details about performing an advanced diagnosis and repair, see 
the Nuts & Bolts 98 online Help.

3. Select the items you want analyzed (by default all the options are 
selected).

When you select some of these options, the Properties button becomes 
active, indicating that there are options you can select to fine tune the 
diagnosis of this part of your system. The items you can diagnose are 
described in the Nuts & Bolts 98 online Help.
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4. Click Next >.

PC Checkup begins diagnosing your PC. You can click Skip to skip 
any item, or click Stop to halt the diagnosis. Depending on the number 
of items selected and the speed of your PC, the time it takes to 
diagnose your PC varies.

When the diagnosis is complete, PC Checkup makes a Summary list 
available along with options for repairing any problems it 
encountered during testing.

5. Do any of the following:

• Click the Plus ( + ) button to view individual problems.

• Click a check box to select a problem or all problems for an item 
that you want to fix.

• Select an item or problem in the list and click Explain to get 
information about it.

• Click the Summary button to view or print a list of the problems 
found on your PC.

• Click the AutoFix > button to let PC Checkup fix all the problems 
that it can for you.

• Click the Manual Fix button to select from a list of solutions for 
each item. It steps you through each item, giving you an 
opportunity to automatically fix the problems, manually fix them 
yourself, ignore them for now, and other solutions appropriate for 
those problems.

Click the + button to view individual problems

Place a check mark beside items or problems to fix
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When you do a manual repair, PC Checkup lets you select a solution for 
each item with problems. After you select one of the solutions, the Explain 
button becomes active so you can view an explanation of what that 
solution will do. Once you finish reading the explanation, simply click 
elsewhere to dismiss the pop-up help message. Also, each solution that 
can be undone later is marked with an asterisk.

PC Checkup lets you know how the repair is progressing and describes 
the problem being fixed

You can fix any problems not solved with AutoFix manually. Press < Back, 
select the problems to fix, and click the Manual Fix button.
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Discover Pro
This chapter shows you how to use Discover Pro, a unique utility that lets 
you view a wealth of system information, as well as perform benchmark 
and diagnostic tests. Discover Pro is your complete system analysis tool. It 
can help you understand PC hardware and software configurations, and 
is designed to help you use, analyze, and configure your PC. It provides 
all the information you need to make optimum use of all available 
memory.

Unlike other system information tools, Discover Pro doesn’t simply 
display information that it obtained from Windows. Discover actually 
tests and measures the hardware and software in your system.

NOTE: You should have general knowledge of DOS and Windows 
memory architectures and terminology. See Understanding Windows 
Memory in the Nuts & Bolts 98 online Help.

What you’re about to learn:

• About the Discover Pro window

• About the Discover Pro window’s tabs of information

• How to view detailed information for each tab

The Discover Pro Window
Discover Pro is easy to use and most windows are self-explanatory. Click 
the Help button for context-sensitive help from any window.
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Discover Pro lets you view information about your hardware and 
software. Each tab in the Discover Pro window covers a specific aspect of 
your PC, ranging from a general overview of your system configuration 
through software to benchmark and diagnostic tests. You can click the 
Advanced button at any time to obtain a far more detailed analysis of the 
current tab’s topic.

• System tab–shows information about the most critical hardware 
components of your system, including your CPU, RAM, video, hard 
drives, BIOS ROM and PCI Bus. You can confirm that your CPU 
conforms to the manufacturer’s specifications; check your physical, 
used and free RAM; and confirm your video board type, resolution 
and installed video memory.

• Memory tab–gives you information on Window’s usage of your PC’s 
memory, via easy-to-understand charts and tables. You can identify 
RAM and resource usage for each application and task; view your 
physical RAM, User and GDI Resources free; and so on. Note that 
Discover reports on the actual physical memory (RAM) used by 
programs.

• Software tab–provides you with information about the software you 
are currently running, and the software components of Windows, 
such as the numbers of virtual machines, threads, tasks, virtual device 
drivers and modules. The Software tab also gives details on your DOS 
program segments and bytes used.

Click Edit to
edit an INI file

Click a tab
to bring it
to the front,
making it
active

Click Print to display
the Print dialog
box where you can
decide which
screens to print to
your printer or save
in a text file

Click Advanced
to view the
Advanced
window for the
active tab,
which shows
details about
that aspect of
your system
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• Drives tab–gives you a complete summary of any drive installed on 
your system and of all the directories, folders and files on that drive. 
You can immediately see the total size of each drive, the amount of 
free space, fragmentation levels and the size of your drive’s free slack. 
An easy-to-understand chart gives you a visual overview of your 
drive, its contents and free space.

• I/O Devices tab–shows information on the secondary and optional 
hardware devices installed on your PC, such as sound devices, serial 
and parallel ports, printers (including fax/modems) and network 
data including network type, driver, specification, version and user 
name.

• Benchmarks tab–an easy-to-use method to benchmark the 
performance of your CPU and compare it to average benchmarks for 
three other “commonly configured” PCs.

• Diagnostics tab–a diagnostics center that lets you run diagnostic tests 
on various aspects of your PC, including serial, parallel, hard drive, 
RAM and DMA tests.

Working With Advanced Information
You can view detailed information about any of the tabs in the 
Discover Pro window.

To work with advanced information:

1. Click a tab to bring it to the front.

2. Click the Advanced button.

Discover Pro displays the Advanced window for the active tab. All the 
Advanced windows have these elements in common:

• Icon Panel–Click any of the icons in the panel at the left to view that 
type of information in the panel at the right.

• Detail Information Panel–The detail information shown in the panel 
at the right is for the category indicated by the currently selected icon. 
The detail information is mostly self-explanatory with scrolling lists 
and buttons you can click to obtain additional information or perform 
related tasks, such as running or stopping benchmark tests.
20 McAfee Nuts & Bolts 98



Repair and Recover
Í TIP: In several of the detail information panels, you’ll see legends with 
small color boxes showing the kind of information that is graphically 
represented in that color. If you click a color box, the Color Change 
dialog box appears where you can select a different color to use for 
that legend item.

Figure 1. Example of the Advanced System window – CPU panel

Specifying Discover Pro Settings
Discover Pro lets you specify options (after clicking the Settings button) 
that determine the appearance of the Discover Pro window itself, whether 
you can view one or more category windows at a time, and whether 
Discover Pro should remember the positions of windows.

• Display Style–lets you pick the Discover Pro display style that you 
are most comfortable using. Each display style provides a differently 
designed Discover Pro window. When you select one of the radio 
buttons, Discover Pro displays a preview of that display style, which 
graphically describes that window design.

Click an icon here . . . . . . and Discover Pro changes the panel here.

Point to a bit (bits are onesClick Summary to go back
to the Discover Pro window or zeros) to see its name 
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The Discover display style is the default. It offers a straightforward, 
single-window display of the Discover Pro window. When you click tabs 
or buttons, the contents of the window changes rather than a new window 
opening. The Discover display style is shown in the screen examples 
earlier in this chapter. Most likely, this display style will work very well 
for you.

If you are an advanced user, you may prefer using one of the 
multi-window views: Discover Professional or Discover - Small Size. For 
details about these two display styles, see Using the Multi-Window Views on 
page 22.

• Save Window Positions–lets you save the locations of your Discover 
Pro windows so the next time you start Discover Pro, they appear 
exactly where you last positioned them.

• Only One Window at a Time–lets you display only one window at a 
time when using the Discover Professional or Discover - Small Size 
display styles. While this check box is selected, Discover Pro changes 
the contents of a single window. When this check box is deselected, 
Discover Pro opens multiple, tiered windows.

Using the Multi-Window Views
Discover Pro provides two multi-window views: Discover Professional 
and Discover - Small Size. You can change the view by selecting a different 
Display Style in the Options dialog box that appears after you click the 
Settings button (or choose the Settings command from the File menu in 
one of the multi-window views).

Either one of the multi-window views are a good choice if you want the 
flexibility of displaying multiple Discover Pro windows that you can 
resize and move around on the desktop.

The Discover Professional display style, shown on page 23, is the larger of the 
two windows. It contains large buttons for each category, making them 
very easy to select, so if you have a large monitor, you may like using this 
multi-window view best.

Discover Professional
Preview

Discover-Small
Size preview

Discover preview
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The Discover - Small Size display style is a good choice if you want the 
flexibility of a multi-window view, but you have a smaller monitor and 
need to conserve desktop “real estate.” This window displays the 
categories in a drop-down list box rather than graphically as large buttons.

Undelete
Nuts & Bolts 98 Undelete lets you recover files that you’ve deleted even 
after you’ve emptied the Recycle Bin. Your best chances of successfully 
undeleting a file is immediately after you perform the deletion. Once you 
save additional files after deleting one you’d like to undelete, parts of it 
may have been written over.

The Undelete program displays a Windows Explorer-like view at the top 
and a list of the files you can currently undelete at the bottom. It shows the 
probability of recovery for each file that it can undelete. To undelete a file, 
select it in the list at the bottom and click the Undelete button.

Nuts & Bolts 98 provides both a Windows and DOS version of the 
Undelete program. The DOS version of Undelete is also included on the 
Nuts & Bolts 98 Rescue disk when you create it.

Access Categories
from the Category
menu

Access Categories
by clicking the
graphic buttons

or…

Discover Professional display style

Access Categories
from the Categories
drop-down menu

Discover - Small Size display style
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2Clean and Optimize 2
This chapter tells you how to use Nuts & Bolts to optimize and maintain 
your PC to ensure you always get the maximum performance. The Nuts & 
Bolts’ Clean and Optimize suite consists of six utilities:

• Cleanup Wizard

• Disk Tune

• Registry Wizard

• Registry Pro

• Shortcut Wizard

• Launch Rocket

Cleanup Wizard

Sooner or later, you are going to start running out of storage space on your 
hard disk. And as you fill up the hard disk, the system will slow down. If 
the disk gets very full, your system may even crash. So how can you 
reclaim space?

The first step in cleaning and optimizing your system is to examine all the 
files stored on your hard disk to decide which files you need and which 
you don’t. There are probably many files on your hard disk that you don’t 
use, such as sound files, old data files, and programs you rarely run. Many 
programs use the same files (such as the file that plays video clips, or clip 
art libraries).

Also, when you remove programs from your computer, some parts are 
occasionally left behind. These files don’t do anything. They just take up 
space. What you need is something to tell you which files you don’t need, 
which files you don’t use, which files don’t do anything and which files 
you have multiple copies of. What you need is something that lets you 
decide whether to delete these files completely, move them, or compress 
them so they take up less space. What you need is Cleanup Wizard.

Disk Tune

After you clean up your files, remove or zip those you don’t need, and free 
up space on your hard disk, you need to optimize how and where your 
files are stored on the hard disk.

As you save, change and delete information on the hard disk, and as you 
add and remove programs, this information gets fragmented. That is, the 
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information that makes up a file is not stored in one place, but is scattered 
in pieces across the disk. The storage space that is available for saving new 
data also get broken up and scattered, so that when you save new data, 
this, too gets scattered.

As the disk gets more and more fragmented, it takes longer and longer for 
your computer to find all the pieces that make up the files you need. This 
slows down your system’s performance.

Disk Tune reorganizes your hard disk. It makes sure that individual files 
are stored in one contiguous location and are not broken up, so you can 
access them quickly. It groups the free storage space separate from your 
files, so that your computer can write new data to the disk quickly and 
efficiently. It puts the files you use most frequently at the beginning of the 
disk, so you can access them more quickly.

The Registry

Now that your hard disk has been optimized, you need to look at other 
aspects of your system that affect its performance. For Windows 95 users, 
one area where considerable improvements in performance can be made, 
is in the Windows 95/98 Registry. The Registry is a repository for all the 
information about your hardware, software and network settings, 
configuration settings (such as desktop colors), plug-and-play data, 
program initialization settings, and so on.

Each time you add or remove programs or hardware, or even if you 
change your desktop and customization settings, the Registry is updated. 
These changes can affect the Registry in a number of ways. Some settings 
no longer do anything (especially if you have removed a program). Others 
are no longer in the optimal place. New settings may adversely affect older 
settings, even to the point of rendering applications or hardware devices 
inoperable. And, as the Registry changes, just like the hard disk, it 
becomes fragmented. The more fragmented it becomes, the slower your 
system runs.

Registry Wizard and Registry Pro allow you to troubleshoot and maintain 
the Registry, ensuring that it is optimized for the maximum performance 
of your system.

Shortcuts

In Windows 95/98, a shortcut is a small file, or iconic roadmap, that points 
to another file (an original file). Most often, a shortcut points to an 
application or document file. However, a shortcut can also point to a 
folder, computer, printer, disk drive, or control panel icon. A shortcut is 
like a remote control device that gives you convenient access to the 
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original file it points to, even when the shortcut is kept in a different 
location than the original. You can put shortcuts almost anywhere on the 
desktop and on the Start menu.

As you configure and customize your Windows 95/98 system, you create 
shortcuts. When you move original files to a different folder or drive, or 
delete them, any shortcuts that point to them are left pointing to the wrong 
place. These invalid shortcuts are also called orphaned shortcuts because 
their “parent” is missing. The Nuts & Bolts Shortcut Wizard locates all the 
orphaned shortcuts on your system. It can also search for orphaned 
shortcuts on remote drives (such as shared network drives). Then you can 
decide whether you want it to repair them all for you, repair selected 
shortcuts yourself, or delete selected ones.

Launch Rocket

When you start an application, Windows copies start-up parts of the 
application file and its component files from the hard drive into memory. 
This process can take a few seconds or a few minutes, depending on the 
application’s size, the number of component files, and the location of all 
these files on your hard drive. Launch Rocket streamlines this process 
using your choice of Normal or Super Acceleration.

If you select Normal Acceleration, Launch Rocket tracks the order in 
which the parts of the application load. Thereafter, it instructs the system 
to read these files from the hard drive in the most efficient manner.

If you select Super Acceleration, Launch Rocket monitors how an 
application loads into memory. It copies and compresses the start-up parts 
of the application in the correct order into a single file on the hard drive. 
Thereafter, when you start the application, the system reads this single file 
rather than multiple files spread across the hard drive.

Cleanup Wizard
Eventually, your hard disk will start filling up with information. As it 
does, your system performance deteriorates. It will take longer for your 
computer to access the information you need and, in extreme 
circumstances, your computer may crash when it tries to write to an 
(almost) full disk.

Cleanup Wizard lets you reclaim space on the hard disk by helping you 
identify which files you no longer use, which files you don’t need, which 
files you have duplicates of, and which files just aren’t useful any longer. 
Once you identify these files, you can delete them, move them (perhaps to 
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another drive) or compress them so you can save space but can still 
decompress and use these files in the future.

You should use Cleanup Wizard fairly often, once a week if you use your 
computer regularly or if you create and delete many files. Perhaps once or 
twice a month if you use your PC less often. Regular use of Cleanup 
Wizard improves your system’s overall performance. You can use 
Cleanup Wizard to perform Express Mode or Custom Mode cleanups.

Express Mode checks file categories that it can delete based on the safety 
level you select (the default choice is the safest level of cleanup). You can 
select Express Mode properties to select the safety level you want before 
running the Express Mode cleanup. For details, see Performing an Express 
Mode Cleanup on page 28.

Custom Mode allows you to customize your cleanup, and select the types 
of files you want to locate. You can custom search for duplicate files, 
orphaned files, large files, old files, or all files. For details, see Performing a 
Custom Mode Cleanup on page 29.

NOTE: Cleanup Wizard is not an uninstaller. It lets you cleanup files on 
your hard drives on a broader scale. For instance, by deleting all 
temporary files that are no longer in use, but that were not deleted by the 
application which created them.

Performing an Express Mode Cleanup
The Express Mode cleanup scans your disk for files it can delete based on 
the selected safety level. The safety levels determine which file categories 
should be deleted, such as temporary files and files in the Recycle Bin 
(these could be deleted when the safest level is selected).

After Cleanup Wizard has produced a list of files that meet the Cleanup 
safety level, you can view them before you decide what to with all these 
files.

The golden rule for cleaning up your drives is Zip. Move. Recycle. Don’t 
delete (or shred) your files unless you are 100 percent certain that you do 
not need them. If you compress the files, you will reclaim disk space and 
still be able to decompress and use them in the future.
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To perform an Express Mode cleanup:

1. Select the Express Mode Cleanup radio button.

The default safety level should work fine.

If, on rare occasions, you want to change the safety level, click the 
Properties button and go to Step 2.

If you are using Cleanup Wizard’s safety level, go to Step 3.

2. Select the safety level for the Express Cleanup and click OK.

3. Click Next > to proceed to the Drives Selection window.

4. Select one or more drives and click Next > to begin the search.

Cleanup Wizard searches the selected drives for files, and displays a 
list of the files it finds.

5. Click Next > when you have finished examining the files.

6. Select whether you want to Zip, Move, Recycle, Delete or Shred all the 
files in the list.

7. Follow the on-screen instructions for the action you selected.

Performing a Custom Mode Cleanup
Cleanup Wizard allows you to perform a Custom cleanup, which lets you 
select the categories of files that you want to locate. Custom Mode cleanup 
lets you find categories including temporary files, files in the Recycle Bin, 
screen saver files, TrueType fonts, multimedia files (including sound 
files), backup files (with BAK or OLD file types), and ZIP archive files.

To perform a Custom Mode cleanup:

1. Select the Custom Mode Cleanup radio button and click the Next > 
button.

2. Select one or more drives to clean up and click Next >.

3. Select which categories of files you want to search for and click Next >.

4. Specify the view options to use.

You can also opt to have the results of your search grouped in File 
Type folders, by selecting the Group Files Under File Type Folders 
check box. This is useful if you want to look at files of a similar type 
(such as .MPG files) to determine whether these could be compressed, 
moved, or deleted to reclaim disk space.

5. Click the Next > button after you finish specifying criteria to begin the 
search.
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Cleanup Wizard displays the files that match your search criteria in 
tabular form in Name, Type, Size, Date, Time, and Count columns.

If you selected the Group Files Under File Type Folders check box, 
Cleanup Wizard collects these files into folders according to the type 
of file.

You can click a folder to open it and examine its contents. To get more 
information about a file, right-click the file. Depending upon the file 
type, you will be able to open it, run, it, view it, and so on. You can also 
compare two apparently identical files to confirm whether they are, in 
fact, exactly the same.

You can sort the files inside folders by clicking the column title you 
want to sort by. You can also rearrange the columns by dragging a 
column title left or right to a new location.

6. Select all the files that you want to do something with by clicking each 
file’s check box.

At this stage, you don’t need to decide which files you want to delete, 
compress, and so on.

7. Click Next > when you have finished selecting files.

Now you can decide which files you want to Zip, Move, Recycle, 
Delete, or Shred.

8. Select all the files that you want to Zip by clicking each file’s check box. 
Then select the Zip Files radio button and click the Zip button. Follow 
the on-screen instructions to save the selected files in a Zip archive file.

9. Repeat the general process described in Step 8 to select another group 
of files that you want to, for example, move to a different location. 
Then click the corresponding File Destination radio button (in this 
case, the Move Files button), and so on.

Once you finish disposing of all the files (or when you click OK), 
Cleanup Wizard closes, returning you to the desktop.

Disk Tune
Disk Tune optimizes your hard disk and improves your computer’s 
performance by rearranging files on your hard disk for maximum 
efficiency.

As you modify files, or add them to or delete them from your hard disk, 
they become fragmented. That is, they are not stored in one contiguous 
place, but are scattered across the disk. Similarly, as you add and delete 
information, the free space on your disk also becomes fragmented, further 
causing your computer to save data in a fragmented pattern. Because of 
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this fragmentation, it takes your computer longer to find all of the 
segments that make up the file, and this slows down your computer’s 
performance.

Disk Tune also defragments your Windows Swap File—the file used by 
Windows to store information temporarily so that memory can be freed 
for other applications. A fragmented Swap File also affects the 
performance of your system.

You should run Disk Tune whenever your drive becomes fragmented by 
more than 2 or 3 percent. When you start Disk Tune, it reviews your drive 
and recommends the type of defragmentation and optimization process 
that you should use.

Í TIP: You can monitor the fragmentation levels of your hard disk using 
WinGauge’s Disk Fragmentation gauge.

If you are using Windows 98, Disk Tune lets you use the application log 
file that Windows 98 creates to determine how applications and their 
related files will be optimally stored on your drive.

Using Disk Tune to Defragment or Consolidate a Disk
After you specify one or more drives to tune and click Next >, Disk Tune 
analyzes the drive to determine the most suitable levels of optimization. 
Once the analysis is complete, depending upon the degree of 
fragmentation, Disk Tune recommends one of four methods:

• Reorder and Unfragment–defragments your files and arranges them 
on the hard disk according to all the criteria specified in the Advanced 
options.

• Full Unfragment–defragments your files and writes them to the hard 
disk so that all free space is grouped separately from used space, 
without regard to the File Placement criteria specified in the 
Defragmentation Options dialog box (click the Advanced button).

• Quick Unfragment–defragments your fragmented files and rewrites 
these to the disk without rearranging other files, and without regard 
to the File Placement criteria. Free space remains fragmented.

• Consolidate Free Space–moves files and file segments to the 
beginning of the disk without regard to the File Placement criteria, so 
that all free space appears at the end. Files remain fragmented.

Disk Tune displays a map of your hard drive with blocks that are color 
coded by status. You can watch the map change as Disk Tune analyzes the 
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disk, and you can customize the colors codes and click a block in the hard 
drive map to identify its contents. See The Hard Disk Map on page 34.

Figure 2–1. Disk Tune analyzes your hard drive, displaying a color-coded map of its 
clusters of information

Reorder and Unfragment
As its name suggests, Reorder and Unfragment optimizes a disk drive at 
the highest possible levels. By running Reorder and Unfragment, either 
because Disk Tune recommends it, or because you select Reorder and 
Unfragment instead of Disk Tune’s suggestion, your files will be 
defragmented and reorganized on the disk in the most effective and efficient 
way, according to their levels of usage. Reorder and Unfragment generally 
takes somewhat longer than Disk Tune’s other defragmentation options, 
but results in a better configuration.

If you are using Windows 98, you can select the Advanced option to use 
the application log file that Windows 98 creates with a Reorder and 
Unfragment to determine how applications and their related files are 
stored on your drive.

Reorder and Unfragment arranges information and available space on 
your hard disk in the most logical way. In its default mode, unlike other 
disk fragmentation utilities, Reorder and Unfragment determines which 
programs you use most frequently and which you use least frequently. 
The programs you use most frequently are placed at the beginning of the 
disk, where the access times are the fastest. In its default settings, Reorder 
and Unfragment rearranges your hard disk in the following order:

• Windows components

Click a Legend
Color box to
display the
Color dialog box
where you can
select a different
color for that item

After analyzing
your drive,
Disk Tune
recommends
an optimization
method; you can
select a different
method if you
prefer

Click a block in
the Hard Disk
Map to identify
its contents
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• Recently accessed programs

• Other programs and files

• Free space

However, if you are a more advanced user, Disk Tune allows you to 
specify and customize a wide range of parameters, such as the placement 
of files by category across your disk, the placement of your free space, and 
so on. For full information on customizing the disk tune process, see 
Setting Advanced Options on page 34.

Full Unfragment
Full Unfragment lets you defragment the disk and rearrange the files so all 
free space is kept separate from your files. Full Unfragment ensures that 
there is no free space in between clusters where data is stored, and that the 
files are stored in contiguous sectors to minimize access time. The major 
difference between Full Unfragment and Reorder and Unfragment is that 
Full Unfragment does not consider the importance or usage of a file before 
storing it on disk. Instead, Full Unfragment strives to defragment your 
disk as quickly as possible.

Quick Unfragment
Quick Unfragment defragments files and rewrites them to the most 
optimal available space on the drive. It does not move files around unless 
it is necessary for defragmenting the file. Neither does it consolidate all of 
your free disk space. Quick Unfragment is a fast and convenient way of 
defragmenting your data without spending the time that more detailed 
defragmentation processes require.

Consolidate Free Space
Consolidate Free Space moves files and file segments to the beginning of 
the disk, so that all free space appears at the end. Consolidate Free Space 
does not defragment your files. Indeed, in some cases the fragmentation 
may worsen as a large file stored in a contiguous location, may be broken 
into several new locations as Disk Tune works to remove all free space 
between files. Consolidate Free Space is useful if you quickly need to 
physically group your free space.
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The Hard Disk Map
Disk Tune displays a map of the hard disk with blocks—each block 
consists of a variable number of clusters, depending on the disk’s 
size—color coded to indicate their status, as illustrated on page 32.

As Disk Tune tunes your disk, the position and status of the blocks 
changes, giving you a real-time image of the disk, and of the techniques 
Disk Tune adopts to optimize the disk to improve your system’s 
performance. To customize the Legend colors, simply click a Color box 
and select a basic color or create your own custom color.

You can also identify the contents of a block in the hard drive map by 
clicking it. This is useful if you want an indication of which files make up 
a block, whether these particular files are fragmented, or held (designated 
as unmovable), and so on. The file list offers information on the Cluster 
Number, Contents, Condition, Type, and Attributes of all the files in the 
block. You can also click a column title to sort files by that column.

Setting Advanced Options
You can access Disk Tune’s advanced options by clicking the Advanced 
button. The Defragmentation Options dialog box appears, which provides 
three tabs of options: Functions, File Placement and Directory Sort.

The Functions Tab
The Functions tab allows you to select the functions, safety level and write 
verification levels.

• Zero Free Space–zeros out the free clusters after you finish tuning the 
disk. This wipes out any leftover data from deleted files, and prevents 
recovery using an undelete program.

• Show Final Organization–shows the final map of your disk once you 
have completed defragmentation and optimization.

• Single Sector I/O–reads and writes data on a “single sector by single 
sector” basis. This method is very slow but may be necessary for some 
types of disk drive controllers.

• Remove Deleted Directory Entries–removes deleted entries from 
directories and consolidates active entries to optimize directories.

• Optimize the Swap File–optimizes the Windows Swap File to 
improve the performance of your system.
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• Safe Mode and Exclusive Lock–increases the safety of your data 
during optimization. Safe Mode takes extra steps to ensure that you 
will not lose any drive data even in the event of a power failure. 
Exclusive Lock prevents any other application from accessing your 
disk during the tune-up which would slow down the tuning process.

• Disk Tune provides three verification levels: Verify (slow–ensures 
data written to a new cluster can be read), Compare 
(slowest–compares a relocated file’s contents against the original to 
ensure it is exactly the same), and None (fastest).

• Ordering by Task–(Windows 98 only) Windows 98 tracks how often 
each of your programs are used and maintains this information in an 
application log file. If you select the Ordering by Task option, Disk 
Tune uses this log file to place the most often used programs at the 
front of your drive, so the programs you use most often start as fast as 
possible. Windows 98 also tracks the loading sequence of the 
application modules, so when Disktune reorganizes based on the 
program’s load sequence, the disk looks fragmented when using a 
program to look at the drive’s fragmentation level.

NOTE: When the hard drive is organized using the Ordering by Task 
option, other defragmenters might see the drive as highly fragmented.

The File Placement Tab

Í TIP: The options you specify in the File Placement tab only apply 
when you run a Reorder and Unfragment.

Disk Tune classifies your disk into five regions: Top, High, Middle, Low, 
and Bottom. You can group your files into five categories: Windows 
Components, Recently accessed programs, Recently modified files, User 
specified files, and All Other Files. There are two additional categories: 
Free Space and Unmovable files.

The File Placement tab lets you decide where the five file categories (such 
as Windows Components) should be located in the regions of the disk. 
Normally, you should put the programs and files you use most often at the 
front of the disk (where access times are the quickest).
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Selecting a file category’s check box puts that file category in the 
Placement Strategy panel. You can highlight a category in the panel at the 
right, and move it up or down in the five disk regions. For example, if you 
want to place recently modified files in the middle region of your disk, 
click the Recently Modified Files check box, highlight this category in the 
Placement Strategy panel, and move it to the Middle (light blue) band by 
clicking the Up or Down Arrow buttons.

Most defragmentation utilities put your files at the front of the disk, and 
your available free space at the end. Disk Tune lets you move the free 
space area to any position on the drive, so that it is relocated above or 
below any of the five regions. For example, if you move the free space to 
the front of the disk, then the five regions (Top through Bottom) where 
your files are stored, occupy the remainder of the disk.

Disk Tune decides which of your files are Unmovable. You cannot move 
the Unmovable files and, since they are unmovable, they do not appear in 
the Placement Strategy panel. If you select the Unmovable Files check box, 
you can classify additional files as unmovable.

Directory Sort Tab
Disk Tune places files into drive regions in the order they appear in your 
folders, or directories. The Directory Sort tab lets you change the order 
files are placed in the region, as well as the order in which they appear in 
the folder or directory.

Global Settings Tab
The Global Settings tab lets you customize the appearance of the Hard 
Drive map by selecting the shape of the cluster and sector blocks and the 
minimum size of these blocks. You can also enable or disable the Nuts & 

Click Specify to
set file characteristics
for the corresponding
Category as described
in Specifying File
Categories

Select a Category item
in the Placement
Strategy panel and
click the Up or Down
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move it up or down
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it to the Placement
Strategy panel at
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Bolts Property sheet for supported drives and enable or disable Disk Tune 
in the Context menu for supported drives.

Specifying File Categories
The File Placement tab in Disk Tune’s Defragmentation Options dialog 
box lets you specify file characteristics for three types of file categories:

• Recently modified files

• User specified 1

• User specified 2

In advanced file placement configurations, you can decide where on the 
disk various file groups will be located. Disk Tune divides the disk into 
five regions: Top, High, Middle, Low, and Bottom, and it lets you specify 
in which of these regions the various file categories are placed. In addition 
to the default file categories, Disk Tune lets you create two categories of 
your own file types, such as help files, graphic images, and so on. You can 
also group recently modified files and allocate specific areas of the disk to 
hold them. The dialog boxes where you specify file characteristics of any 
of these customizes file groups are identical, allowing you to create file 
groups for your own exact requirements.

Initially, you need to identify the file types to include in your group in the 
File Specifications text box, using the adjacent Add, Remove, or Clear All 
buttons. After you click Add, you can find individual files to add to your 
list. Disk Tune lets you use wildcards in the Add dialog box to locate all 
files of a certain type. For example, entering *.HLP  locates all the help 
files. You can find all files on your drive, or limit your search for all files in 
a directory (including or excluding subdirectories). Clicking the 
msoffice  directory and entering the filename *.HLP  creates a file 
specification of \msoffice\*.HLP , which locates all the help files in the 
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Microsoft Office directory. You can also include or exclude files that are 
greater than, or less than, a specific size range.

Your other options include:

Using the operators And and Or, so you can group all files you have 
selected in the File Specifications text box. And or Or files must meet the 
criteria you specify in the other check boxes, such as:

• The condition of your files (Fragmented, Optimized or Straddled).

• The attributes of your files, (such as Archive, Read-only, or Hidden).

• The date range of your files, where you can specify a date range (in 
dd/mm/yyyy format) when the files were last modified, last accessed 
and/or created.

In most cases, the defaults provided by Disk Tune should work fine. 
Occasionally, you may need to customize the positions of file categories on 
your disk. In general, files you do not modify, but access frequently, 
should be placed as high (near the beginning) on the disk as possible to 
improve access times. Files that you frequently modify should be placed 
as close to the free space as possible, to decrease the amount of work your 
system has to do.

Registry Wizard
Registry Wizard (for Windows 95/98 only) makes maintenance, 
troubleshooting, and repair of the Windows Registry database a quick and 
easy process. The Windows Registry is a database that replaces many 
functions of Windows 3.x’s AUTOEXEC.BAT, CONFIG.SYS, and *.INI 
files. This Registry contains all the information about the hardware, 
system, programs, and network user settings on your PC.

Each time you add new hardware or software, the Registry is updated. 
Some of these changes can occasionally leave other components 
inoperable, or create problems with other aspects of your system.

Registry Wizard lets you troubleshoot and maintain the Windows 
Registry, ensuring that it is optimized for the maximum performance of 
your system.

The golden rule for using Registry Wizard is: Clean, Repair, Tune-up.

Your overall objectives are to remove unnecessary items, ensure that all 
items point to actual files, sort the Registry so that associated items are 
grouped together, and reduce the size of your Registry so it can be 
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accessed more quickly. In fact, there are many similarities between 
optimizing your hard disk, and optimizing your Registry.

First, you should clean up the Registry. That is, locate items that you can 
safely delete from the Registry, such as your Recent Doc list, the Tip of The 
Day, your Run List, and so on.

Second, you should repair the Registry. That is, identify all of the Registry 
items that point to files that have moved or to nonexistent items, and 
repair or delete them.

Third, after you remove unneeded items and repair the rest, you need to 
tune up your Registry. That is, close the gaps and group associated items 
together. Registry Wizard will walk you through, and perform, all these 
tasks for you.

Select the task you want Registry Wizard to perform and click the Next > 
button. Then go to the corresponding procedure:

• Click Clean and go to Cleaning the Registry on page 39.

• Click Repair and go to Repairing the Registry on page 40.

• Click Tune-up and go to Tuning Up the Registry on page 42.

Cleaning the Registry
The Registry Wizard - Clean dialog box appears after you select the Clean 
option and click Next > in the Registry Wizard.

Select the items to clean up and click Finish.

Registry Wizard removes selected items from the Registry and exits.

Clean lets you remove
unnecessary Registry
items, such as your
Recent Documents list

Repair lists invalid Registry
items; you can automatically
or manually fix them

Tune-up creates a clean
new version of your Registry
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Repairing the Registry
After you select the Repair option and click Next > in the Registry Wizard, 
it scans the Registry and displays the Registry Wizard - Repair dialog box, 
which lists all invalid entries in the Registry.

Most likely, you’ll start by clicking the Repair All button to let Registry 
Wizard repair all the entries that it can. After you do this, Registry Wizard 
displays the Registry Wizard - Repair Report dialog box.

This Repair Report lists the Registry key entries that Registry Wizard can 
fix along with a description of the file (and its location) that will be used to 
repair each Registry key entry.

Select any key entries that you want to fix or not fix, then click the Fix or 
Don’t Fix button, respectively. The selected key entries are fixed or not 
fixed as you specified, and the Repair Report dialog box closes. The 
Registry Wizard - Repair dialog box reappears, displaying the remaining 
key entries that still need to be fixed. You can select a key entry and click 
the Repair button to manually change the value for that key. Or if you are 
an advanced user, you may want to click the Advanced button to go to 
Registry Pro and edit the orphan entries using that Nuts & Bolts utility 
instead of Registry Wizard.
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For more about using Registry Pro, see Registry Pro on page 42.

Click Advanced to
go to Registry Pro
where you can
edit an Orphan key
entry that Registry
Wizard has found in
the Orphan tab list

Select a column title to
change the sort order
of the keys

Select a key handle or
child key and click Repair
to manually edit its value

Click Repair All to let
Registry Wizard repair
invalid key entries

Select an invalid key
entry and click Repair
to manually edit the
value, or delete the entry 
from the database

Click an orphan key
and Registry Pro
selects it in the
list above so you
can edit its value

Point to the separator
bar between these
panels and drag it
up or down to resize
the panels, as has
been done in this
illustration
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Tuning Up the Registry
Registry Wizard’s Tune Up process rebuilds your Registry files in optimal 
order. The Tune Up process does not remove any information. Rather, it 
sorts and compacts the Registry, removing “holes” left by Registry entries 
that have been deleted in the past.

When you rebuild the Registry using the Registry Wizard Tune Up option, 
the current Registry files are saved in your Windows directory as 
system.hlx  and user.hlx . In the unlikely event that you encounter 
any problems in Windows after a tune up, you can restore your original 
Registry by pressing F5 when you see the Starting Windows message 
when you boot, and by then typing REGUNDO at the C:> prompt.

After you select Tune-up and click the Next > button in the Registry 
Wizard, it displays the Registry Wizard - Optimize dialog box asking you 
to exit all currently running programs before you continue.

To tune up the Registry:

1. Exit all programs that are running. Be sure you check the taskbar and 
close any programs that you’ve minimized as well.

2. Click Next >.

Registry Wizard displays a message explaining that a new copy of 
your Registry has been created, and you need to restart Windows to 
apply the new Registry.

3. Click Finish.

4. Click the Start button and choose the Shut Down command.

5. Select the Restart the Computer option. Then click Yes to restart 
Windows and apply the new Registry.

Registry Pro
Registry Pro (for Windows 95/98 only) lets you perform advanced editing of 
the value entries for key handles (the top level folders) and their 
subordinate child keys in the Windows 95/98 Registry database. With 
Registry Pro, you can troubleshoot and repair start-up files defined as 
entries in the Registry. You can import and export registry files, find 
entries containing specified text, or find orphans (entries for programs that 
have moved or no longer exist).
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Í TIP: Choose Key Info from the Help menu to get information on any 
selected key.

Finding a Registry Entry
Choose the Find command from the Search menu (or press CTRL-F3). Then 
enter the value to search for, select where to search, what to display, and 
other search options. Then click Find.

Finding Orphans
An orphan is an entry for a program that has moved or no longer exists.

Choose the Find Orphans command from the Search menu.

Registry Pro displays a list of all the orphans it finds in the database in the 
Orphans tab. You can select an orphan key entry and Registry Pro selects 
it for you in the Registry database in the top two panels of the window. 
You can double-click an orphan entry in the top right panel to change its 
value data. See the illustration in Repairing the Registry on page 40.

Editing a Registry Entry
Double-click a database entry in the top right panel of the Registry Pro 
window as illustrated in Repairing the Registry on page 40.

Importing a Registry File
The Registry file in use on your PC is located in your Windows folder on 
the system hard drive. You can import a Registry file that has been created 
elsewhere, or one exported earlier, into Registry Pro so you can examine it 
or edit its contents. When you export a Registry file, you can save it with 
a unique filename in any location you like. This lets you create and use 
different Registry databases for particular purposes.

To import a registry file:

1. Choose the Import Registry File command from the File menu.

2. Locate a Registry file (with a file type of .REG) and click Open.

Registry Pro opens the Registry file you selected, displaying its key 
handles, child keys, along with key values of a key you select.
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Exporting a Registry File
You can export the open Registry file, saving it with a unique filename and 
a .REG file extension. You might do this to keep Registry files for different 
purposes, or to share a Registry file with someone else.

Choose the Export Registry File command from the File menu.

Refreshing the Registry Database
You can refresh the Registry so it displays the latest data stored in the 
active Registry file in your Windows folder on the system hard drive.

Choose Refresh from the View menu. Registry Pro updates the Registry.

Shortcut Wizard
A shortcut is an iconic roadmap to an application or document file. You can 
double-click a shortcut icon in one location on your desktop to open the 
original file that it points to, which is most likely in another location. You 
can use shortcuts to have convenient access to files that are stored in less 
convenient places, such as inside a folder that is inside a folder that is 
inside a folder…

When you or an application create a shortcut, Windows 95/98 makes a 
direct link in the shortcut to the original file. This link includes the file’s 
path and creation date and time (precise to less than a second). It saves this 
information to help it find a shortcut’s original file when you double-click 
the shortcut. There are some cases when Windows 95/98 cannot find a 
shortcut’s original file, which makes the shortcut an orphan (and no longer 
useful):

• If you delete the original file.

• If you move the original file to a different volume or drive (say you 
move the file from drive C to drive D).

• If the original file is stored on a drive whose drive letter changes (such 
as a mapped network drive).

The following illustration shows an example of the Shortcut Wizard’s own 
icon and a shortcut icon for the Shortcut Wizard. The filenames and icons 
need not be the same. Windows 95/98 lets you change them.
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Windows 95/98searches for a shortcut’s original file if the location has 
changed. If you move the original file to a different folder on the same 
drive, Windows can find it based on the creation date and time (which is 
unlikely to be identical to another file because the time is recorded to 
fractions of a second). It also gives you the chance to Browse and locate the 
original file yourself. If Windows 95/98 cannot find the original file, it 
displays a Problem With Shortcut message listing any nearest matching 
file it finds. You can update the shortcut to point to this nearest matching 
file.

Over time as you work with files, your system may accumulate orphaned 
shortcuts that point to files you’ve moved or deleted entirely. These 
invalid shortcuts take up extra storage space and clutter your desktop. 
Nuts & Bolts’ Shortcut Wizard lets you fix or delete these orphaned 
shortcuts quickly and easily. It can locate any orphaned shortcuts on your 
PC. Once you have a list of them, you can decide to:

• Let Shortcut Wizard repair any orphaned shortcuts possible.

• Repair a selected shortcut yourself.

• Delete one or more shortcuts that you select.

To repair or delete orphaned shortcuts:

1. Click the Next > button.

Shortcut Wizard displays a message indicating it is searching for 
shortcuts. Then it displays a list of any orphaned shortcuts.

2. Decide how to handle the orphaned shortcuts. Your options are:

• Repair All–Click the Repair All button to let Shortcut Wizard attempt 
to repair the orphaned shortcuts. You may want to let Shortcut Wizard 
attempt repairs first, and then either repair or delete the remaining 
items yourself manually.

Shortcut Wizard’s icon
 (the original file)

Shortcut Wizard’s shortcut icon
(an iconic roadmap to the original file)
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• After you click Repair All, the Repair Report dialog box appears, 
showing a list of all the items Shortcut Wizard can repair. Select items 
and click Fix to let Shortcut Wizard repair them. Or click Don’t Fix if 
you want to fix them yourself, delete them manually, or leave them 
intact. The Shortcut Wizard - Orphaned Shortcuts dialog box 
reappears.

• Repair–Select an orphaned shortcut and click Repair to fix the path 
that links it to its original file manually. The Repair Entry dialog box 
appears, which shows the shortcut path and the invalid path. Enter 
the new path or click Browse to find the original file. Click Save to 
repair the shortcut.

• Delete Item–Select one or more shortcuts and click the Delete button 
to remove these orphans from your system.

3. Click Finish when you are done repairing or deleting the orphaned 
shortcuts in the list.

The Shortcuts dialog box reappears, with the remaining entries.

Launch Rocket
The time it takes to launch applications in Windows can vary from a few 
seconds to a few minutes, depending on the size of the application, the 
number of component files that make up the application, and the location 
of these files on your hard drive.

Nuts & Bolts 98’s Launch Rocket Wizard dramatically reduces application 
launch times. It does this in two ways:

• Normal Acceleration–Nuts & Bolts 98 keeps track of the order in 
which various parts of an application load. Thereafter, whenever you 
launch that application, Nuts & Bolts 98 directs your system to read 
those files from the hard disk in the most efficient manner.

• Super Acceleration–Nuts & Bolts 98 monitors how an application 
loads in your system. It copies and compresses the start-up parts of 
that application in the correct order in a single file on the hard disk. 
Thereafter, when you launch that application, the system reads a 
single file, rather than multiple files across the hard drive.

If you move, remove, update or otherwise change the locations of the 
various component files of an application (such as during a disk 
defragmentation), Nuts & Bolts 98 recognizes the change and reconfigures 
the Launch Rocket for the type of acceleration you’ve selected (Normal or 
Super Acceleration). However, on rare occasions, you may need to 
re-Super Accelerate.
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The Launch Rocket Wizard lets you enable the utility and configure its 
settings. With the Wizard, you can:

• Select which applications benefit from Normal Acceleration, which 
benefit from Super Acceleration, and which are excluded from launch 
acceleration. The Wizard displays a list of all applications you have 
run since installing Nuts & Bolts 98. You can right-click a listed 
application to specify its degree of launch acceleration.

• Specify the drive where the acceleration files are stored. Estimated 
disk space for these files is also shown.
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3Prevent and Protect 3
Sooner or later, everyone using Windows will encounter error messages, 
most often caused by misbehaved programs. What you must do to resume 
your work depends upon an error’s cause and degree of seriousness. 
Normally, errors force a program to close. So if an error is minor, you may 
be able to recover and continue working just by closing and restarting the 
program. Very rarely, these errors can be serious enough to prevent you 
from restarting the program, or even worse, from restarting the PC. The 
Nuts & Bolts’ Prevent and Protect suite of utilities take you step-by-step 
through the process of protecting your system against such eventualities 
before they happen:

• Bomb Shelter–provides crash protection and recovery.

• WinGauge–monitors your use of Windows and your programs.

• McAfee VirusScan–checks your software for computer viruses. For 
complete instructions, see the online McAfee VirusScan manual which 
is stored as an Adobe Acrobat PDF file on the Nuts & Bolts 98 CD disc 
in the Manuals folder.

• Year 2000 Checker–lets you test your system hardware for Year 2000 
compliancy. If it is not, Year 2000 Checker installs Y2Kfixer.com to 
make your PC compliant so it handles dates accurately starting on 
01-01-2000.

• Trash Guard–provides delete protection of all the files you delete. It 
even protects files deleted in DOS or 16-bit Windows programs

• Retake–lets you create automatic or interactive backups of selected 
drives, directories, files or file types. You can back up to a protected 
volume file (a separate area on the drive). A protected volume file 
contains information about each file in every sector to ensure that files 
can be recovered even if the hard drive’s directories and data are 
severely damaged or lost. You can also create mirror backups that 
instantly back up data as you save it, make backups after a time delay 
when the PC is idle, or create manual backups.

What you’re about to learn:

• How to set up crash protection and recovery to safeguard your PC 
against application errors.

• How to enable and disable Trash Guard’s delete protection, specify 
any files to exclude from protection, and show or hide Nuts & Bolts 
98’s Delete Protection tab in the Recycle Bin’s Properties sheet.
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• How to monitor your use of Windows and programs, so you get early 
warning of potential problems before they become serious.

• How to constantly back-up your data automatically and in real time 
so that, if worst comes to worst, you have copies of all your files and 
data safe and secure.

Bomb Shelter
Bomb Shelter is a Nuts & Bolts 98 “crash protection and recovery” utility 
that prevents critical regions of your system’s RAM from accidentally 
being overwritten by misbehaving application programs. Bomb Shelter 
also lets you restart a crashed application (an application that has completely 
failed or stopped responding) in order to recover your data.

Í TIP: We recommend that you activate Bomb Shelter so it always runs 
when you run Windows. See Starting Bomb Shelter on page 51. By 
running Bomb Shelter, you ensure that application errors and faults 
do not cause you to lose data, and more importantly, that such 
problems do not cause any damage to your system.

If an application tries to overwrite any critical system RAM regions, Bomb 
Shelter will produce a fault, an error condition, and display a dialog box, 
allowing you to selectively close the faulty application or reenter it so you 
can save your information before closing.

For a variety of reasons, PC users will, sooner or later, encounter faults and 
error conditions—usually caused by an errant application. In most 
circumstances, the application has to be closed, with a corresponding loss 
of any unsaved data. However on occasions, the problem can be more 
serious, requiring a complete system reboot.

In even rarer cases, the error can cause critical areas of your PC’s files to be 
overwritten or otherwise corrupted. To repair the damage created by such 
an error requires lengthy and complex diagnostics and repairs using other 
Nuts & Bolts 98’ utilities. Bomb Shelter is designed to reduce the severity 
of application errors, and to almost completely eliminate the most serious 
errors.

Bomb Shelter can coexist on the same PC with other protection programs. 
However, you won’t need to use another protection program because 
Bomb Shelter provides the most complete protection. It not only protects 
your system against high-level errors that other protection programs miss, 
but it also protects your system against more serious low-level errors.
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Since Bomb Shelter operates at a lower system level than other crash 
protection programs, it will see errors only if any other protection 
program you use misses the error. So if you have Bomb Shelter loaded 
with another crash protection program, the other program will intercept 
some errors. This does not mean that the other program is superior—in 
fact, quite the reverse. Bomb Shelter catches errors at all levels, so though 
you can use other crash protection programs, you really don’t need to.

Starting Bomb Shelter
When you start Bomb Shelter, it automatically activates so it can begin 
protecting your system’s critical areas from being overwritten by 
applications and allow you to recover from crashes. Once loaded, Bomb 
Shelter remains active until you deactivate it.

To start Bomb Shelter:

1. Start Bomb Shelter by doing one of the following:

• Click the Start button and choose the Program > Nuts & Bolts > 
Bomb Shelter command in Windows 95/98.

• Open the Nuts & Bolts folder and double-click the Bomb Shelter 
icon from the Windows Explorer or My Computer window.

• Open the Nuts & Bolts program group and double-click the Bomb 
Shelter icon in Windows 3.1x.

2. Click OK.

Bomb Shelter remains active, and automatically places itself in the 
StartUp folder or group so that it loads the next time you start 
Windows.

Recovering from an Application Error
Bomb Shelter continuously monitors your system to detect when an 
application tries to perform an invalid operation or damage any critical 
part of your system. When such a “Fault” condition occurs, Bomb Shelter 
suspends the application and displays the following dialog box.
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When you see this dialog box, the application has caused an error which 
usually means it has gone astray. Therefore your data may already be lost or 
damaged. This dialog box lets you choose what to do with the faulty 
program. The following options are available:

• Close–closes the application that caused the error and allows you to 
continue working.

• Recover–reactivates the faulty program at a point that should let you 
save your data. This procedure has some inherent risks and you should 
follow the steps in the procedure below when trying to Recover a 
crashed program.

To attempt to recover your work:

1. Use Explorer to make a backup copy of the open document you were 
working with in the application.

2. Click the Recover button in the Bomb Shelter dialog box.

3. Attempt to save your work in the application.

4. Exit the application immediately and restart Windows.

Recovering a Crashed, Locked-Up or Hung Application
Sometimes application errors cause programs to stop responding to the 
keyboard or mouse. In Windows 95/98, Bomb Shelter can “unlock” 
programs and allow you to try to recover any previously unsaved 
information in documents you had open in the application when it 
stopped responding.

To unlock a locked program:

1. Hold down the CTRL and ALT Keys and simultaneously press the 
DELETE key (sometimes labeled DEL).

Bomb Shelter displays the Close Program dialog box.

2. Select the application that has stopped responding.

Bomb Shelter tries to recognize the program and pre-select it for you.

3. Click Close to have Bomb Shelter close the program, or click Recover 
to have bomb shelter try to reactivate the program.
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È IMPORTANT: An application that has stopped responding may have 
other problems as well. Therefore your data may already be lost or 
damaged. If you need to recover your work, follow the instructions in 
the following procedure.

To attempt to recover your work:

1. Use Explorer to make a backup copy of the open document you were 
working with in the application.

2. Click the Recover button in the Bomb Shelter dialog box.

3. Attempt to save your work in the application.

4. Exit the application immediately and restart Windows.

Selecting Bomb Shelter Properties
Bomb Shelter lets you select a variety of properties that determine how the 
utility behaves and what kind of protection it gives you. You can also 
select Advanced properties, which provide settings for advanced users 
and for troubleshooting by Network Associates’ Technical Support 
Engineers.

To select Bomb Shelter properties:

1. Click the Properties button in the Bomb Shelter Wizard.

2. Select the options in the Properties tab and the Statistics tab. Click a 
tab to bring it to the front.

The properties you can select in the Properties tab are:
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• Write protect System– Activates Bomb Shelter’s write protection 
option that protects various critical parts of your system RAM 
from being overwritten. If these areas become overwritten or 
corrupted, your system may lock up or worse.

• Automatic Error recovery–Activates Bomb Shelter’s Program 
Fault dialog box that lets you re-activate crashed programs to try 
to save the data in them. If you disable this option, Bomb Shelter 
does not intercept application errors, and you get the regular 
Windows dialog box for these errors. The Windows dialog box 
does not have a recover option.

• Use Ctrl-Alt-Del to unfreeze–Activates Bomb Shelter’s Close 
Program dialog box, which lets you re-activate programs that 
have stopped responding to attempt to save the data in them. If 
you disable this option, Bomb Shelter will not intercept the 
CTRL-ALT-DELETE key combination, and you will get the regular 
Windows Close Programs dialog box when you press 
CTRL-ALT-DEL. The Windows dialog box does not have a recover 
option.

• Show icon in tray– Tells Bomb Shelter to display the Bomb Shelter 
icon in the Windows 95/98 taskbar tray. Double-clicking the tray 
icon activates the Bomb Shelter Wizard.

The Statistics Tab gives you an up-to-the-minute report on Bomb 
Shelter activity. The information contained in this tab is really only of 
interest to advanced users.

3. Click the Apply button when you finish selecting options for a tab so 
you can continue selecting options for another tab.

4. If you are an advanced user, or if you are working under the direction 
of Network Associates’ Technical Support Engineers, you can click the 
Advanced button to specify advanced properties for Bomb Shelter.

NOTE:  It is strongly recommended that you do not make Advanced selections 
unless you have a very clear understanding of error conditions, faults and 
Windows.

The Bomb Shelter Advanced Properties dialog box appears. Select the 
options you want and click OK.

Í TIP: Bomb Shelter supports blue screen crashes which you can enable 
or disable in the Advanced Properties dialog box.

5. Click OK when you finish selecting properties and the Bomb Shelter 
Wizard dialog box reappears.
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Testing Bomb Shelter
The Bomb Shelter Wizard dialog box offers a testing option that lets you 
activate the Crash-Me test program. This test program lets you simulate 
common application error conditions to check how Bomb Shelter is 
working and verify that your system is protected.

NOTE: The Crash-Me test program is provided for advanced users or for 
use by Network Associates’ Technical Support Engineers. Avoid using the 
Crash-Me test program unless you suspect that Bomb Shelter is not 
working properly. Bomb Shelter must be active when you perform tests. 
Otherwise, your system will have no protection when you simulate error 
conditions and you may have to restart your PC.

Network Associates’ engineers have made every effort to ensure that 
Crash-Me crashes gracefully, particularly with any crash protectors other 
than Bomb Shelter, but prior to running any crash tests, ensure that you have 
saved all your work and have closed all other programs.

To simulate error conditions:

1. Click the Test button in the Bomb Shelter Wizard dialog box.

Bomb Shelter starts the Crash Me program, which displays a dialog 
box where you can choose the type of error to simulate.

The 11 fault types simulate different error conditions and faults that 
can be produced by higher-level applications (such as the General 
Protection Fault) or by low-level programs (such as the Stack Fault or 
Null Stack Pointer).

2. Select the test you want to perform and click the Test button to 
simulate the selected error or fault condition.

Bomb Shelter creates the desired fault/error conditions and displays 
the Bomb Shelter recovery dialog box. 

3. Click the Close button to close the test program, or click the Recover 
button continue using the test program.
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Deactivating Bomb Shelter
You can deactivate Bomb Shelter whenever you like without restarting 
Windows.

To deactivate Bomb Shelter:

1. Start the Bomb Shelter Wizard either by running Bomb Shelter from 
the Nuts & Bolts program group or by double-clicking the Bomb 
Shelter tray icon in the Windows 95/98 taskbar.

2. Click the Deactivate button.

Bomb Shelter unloads from memory and removes itself from the 
StartUp folder or program group so it does not load the next time you 
start Windows.

WinGauge
Although Bomb Shelter protects you from error conditions and faults, you 
should get into the habit of constantly monitoring your system so you can 
take actions to prevent situations where these errors could occur.

WinGauge is a dynamic reporting tool that constantly monitors your use 
of Windows and your applications, to alert you to potential problems 
before they become serious. Information about your system is displayed 
to you in the form of gauges. You select what to monitor, which type of 
gauge to use and, more importantly, when you want notification that your 
specified limits have been reached.

You can choose to have one, a few or many gauges active at any one 
time—with each gauge reporting on the status of your system. The more 
advanced you are, or the more demanding your projects, the more gauges 
you may want to keep active to monitor particular aspects of your 
computer and applications.

By using WinGauge, and by customizing the gauges to your own specific 
needs, you will be warned about potential problems well in time to take 
the necessary preventative steps. WinGauge alerts you so that you can, for 
example, save your data, close programs or take other actions to prevent 
your system from slowing down, crashing, or locking-up. As an added 
bonus, you can also drag application icons and folders into WinGauge, so 
that WinGauge becomes your one-stop system monitoring and 
application launch pad.
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The Most Important Gauges
The following short list summarizes the gauges that are the most 
important to have active, and outlines what they measure:

• Highest Resources–The Highest Resources gauge measures “system 
resources”—small, critical memory regions in Windows itself. When 
any of these regions fill up, your system may crash. You can increase 
your resources by closing some applications.

• Virtual Memory–The Virtual Memory gauge measures how much of 
your disk swap file is in use. The more of your swap file you use, the 
slower your system will run. If your swap file fills up, your system 
may crash. If you find that your virtual memory is frequently high, 
you should consider buying and installing more RAM and making 
more room available on your Windows drive.

• Swap File Requests–The Swap File Requests gauge measures how 
often Windows is accessing the swap file. The more frequent the 
accesses, the less efficient is your overall system.

• Drive Space–The Drive Space gauge measures how much room is left 
on your drives. If a disk fills up while a program is running, your 
system might crash.

Working With Gauges
In WinGauge, you can add, update or remove gauges.

Adding a New Gauge
If a gauge that you want to see doesn’t appear in the WinGauge window, 
you can add it.

To add a gauge to the WinGauge window’s gauge area:

1. Point to a gauge or the empty gauge area and press the Right mouse 
button.

2. Point to or click the New menu.
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3. Do one of the following:

• Choose «gauge name» from the New menu.

• Point to the Memory, Resources, Resources without Hurricane, 
Drive Space, Drive Fragmentation, or Performance Data menu.

• Choose a «gauge name» command from the menu.

WinGauge adds the gauge in the WinGauge window and hides the 
command title from the New menu until you remove the gauge. For 
an explanation of each gauge, see Nuts & Bolts 98’ online Help.

Updating a Gauge’s Information

Í TIP: To specify the Refresh Duration indicating how often gauges will 
be updated, or refreshed, see Changing a Gauge’s Appearance on page 60.

To update a gauge’s information:

If you want an immediate update, point to a gauge, press the Right mouse 
button, and choose the Update command. WinGauge updates that gauge’s 
information. To change the Refresh Duration for a gauge, or to recompute 
its value more frequently, see Change a Gauge’s Actions on page 65.

Removing a Gauge

To remove a gauge from the WinGauge window:

Point to a gauge, press the Right mouse button, and choose the Remove 
command. WinGauge removes the gauge and adds its command to the 
corresponding menu.

Gauge name commands
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Manipulating the WinGauge Window
You can interactively change the appearance of the WinGauge window by 
doing any of the following:

• Resizing only the window

• Resizing gauges and the window

• Rearranging gauges inside the window

Resizing the WinGauge Window
While the WinGauge window is undocked, you can interactively resize 
the window by dragging its sides or corners to a new location.

To resize the WinGauge window:

1. Point to any corner or side of the WinGauge window.

2. Drag the window edge in any direction to a new location.

Resizing Gauges in the WinGauge Window
While the WinGauge window is undocked, you can interactively resize all 
gauges in the window, as shown below. You can also resize all gauges in 
the Properties sheet’s Global tab. See Changing All Gauges’ Global Properties 
on page 64.

To resize gauges in the WinGauge window:

1. Point to any corner or side of the WinGauge window.

Point to a side or corner
of the WinGauge window
and the pointer changes to
a double-tipped Arrow
pointer that indicates
you can drag to resize
the window without
changing the size of
the gauges
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2. Hold down the CTRL key and drag the corner or side of the window 
in any direction to a new location.

Rearranging Gauges in the WinGauge Window
You must have the titlebar visible in order to rearrange gauges. You can 
drag gauges around in the gauge area to move them to a new location in 
the WinGauge window (while the titlebar is shown). You might do this to 
place related gauges in adjacent positions. After rearranging gauges, you 
might group them by changing the borders of adjacent gauges. See 
Changing a Gauge’s Appearance on page 60.

Changing WinGauge Properties
WinGauge allows you to customize the properties of gauges. You can 
select properties for:

• The appearance of the selected gauge or gauge you’re pointing at

• The global dimensions, fonts, and Bubble Help options

• The actions to perform when a gauge reaches a threshold

Changing a Gauge’s Appearance
You can change a gauge’s appearance by selecting its type, refresh 
duration, threshold or data style, size, gauge text, borders, or colors.

To change a gauge’s appearance:

1. Point to a gauge and press the Right mouse button.

2. Choose the Properties command.

3. Select the Appearance properties to use as the default, or to apply to 
the selected gauge.

Point to a side or corner of
the WinGauge window
and the pointer changes to
a double-tipped Arrow
pointer; hold down the Ctrl
key and when you drag to
resize the window, the
gauges all change to a
new size that fills the
WinGauge window
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The Appearance tab lets you decide what sort of gauge you want, its 
refresh duration, size, colors, threshold limits and so on. For details, 
see the Properties Sheet – Appearance Tab section that follows. When you 
have finished specifying the appearance of the gauge, you can click 
Apply to apply the settings to the gauge and leave the Appearance tab 
open, or OK to apply the settings and close the Appearance tab. The 
Default button causes the gauge’s appearance to revert back to the 
WinGauge default settings.

Properties Sheet – Appearance Tab

The Appearance tab contains several sections of options, so that you can 
customize every gauge individually.

Type

You can select the gauge type to use from the drop-down list box. The 
gauge preview shows what the currently selected gauge type looks like.

Type drop-down
list box

Analog Digital LED Histogram

Thermometer Horizontal Bar Vertical Bar Text (%)
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Refresh Duration

The Refresh Duration sets how often WinGauge checks the system to 
update information provided in the gauge. You can set the refresh 
duration for each gauge to your own liking, but there is obviously no point 
in having, say, your disk fragmentation levels checked every 15 seconds. 
The default settings should be OK. To increase or decrease the Refresh 
Duration, drag the slider to the left or right.

Threshold Style

You can highlight the threshold limits on each gauge by marking the 
thresholds as a Line or Color. To set or change the threshold levels, see 
Change a Gauge’s Actions on page 65.

Data Style

Selecting a Data Style of Color Lines, Color Fill, Solid Lines, or Solid Fill 
makes certain Colors options visible. See Colors below.

Size

Selecting double wide or tall, both, or default adjusts the gauge size.

Gauge Text

You can select whether to display a gauge’s title and value, show the title 
vertically or horizontally, and show the value as a percent. You can also 
select where on the gauge the title and value appear.

Colors

You can customize a gauge by changing the colors. To change the color on 
any part of the gauge, select the gauge part and click the Set Color button. 
A standard Windows Color dialog box appears where you can select basic 
colors or define your own custom colors.

Regular
(default lime green)

Text

Regular Background
(default olive green)

Warning Background
(default khaki brown)

Alarm Background
(default maroon red)

(default black)

Text
(default black)
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• Text (default black)–Sets the color for gauge text (visible when Gauge 
Text is set to either or both the Title and Value).

• Regular (default lime green)–Sets the color for regular data usage 
(visible when Data Style is set to Color Lines or Color Fill).

• Regular Background (default olive green)–Sets the color for the 
regular background of the gauge indicator.

• Warning Background (default khaki brown)–Sets the color for the 
warning background of the gauge indicator.

• Alarm Background (default maroon red)–Sets the color for the alarm 
background of the gauge indicator.

• Warning (default bright yellow)–Sets the color for warning data usage 
(visible when Data Style is set to Color Lines or Color Fill).

• Alarm (default bright red)–Sets the color for the alarm data usage 
(visible when Data Style is set to Color Lines or Color Fill).

• Frame (default white)–Select Frame from the Colors drop-down list 
box. Then select an edge of the gauge preview to turn on or off the 
gauge’s highlighted edges. You can also change the color used for the 
frame in the Color dialog box (click the Set Color button).

Text

Regular
(default lime green)

Warning
(default bright yellow)

Alarm
(default bright red)

(default black)

Text
(default black)

Frame
(default white)

Solid Pointer
(set Data Style to
Solid Line)
(default white)

(default black)

Text

Background (set Threshold

(default black)

Text
(default black)

style to None)
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• Background (default black)–Sets the color for the gauge’s data 
background (visible when Threshold Style is set to Lines or None).

• Solid Pointer (default white)–Sets the color for the gauge’s data usage 
indicator (visible when Data Style is set to Solid Lines).

Changing All Gauges’ Global Properties
Global properties you can select for all gauges in WinGauge are: the gauge 
size, fonts used for the title text and value, and Bubble Help.

To change all gauges’ global properties:

1. Point to a gauge and press the Right mouse button.

2. Choose the Properties command.

Click the Global tab to bring the tab to the front. Select the Global 
properties to use as the default or to apply to all gauges.

Properties are described after the Global tab on page 64.

3. Do one of the following:

• Click Default to use WinGauge’s default Global properties.

• Click Apply to apply the settings to all gauges in the window 
(including hidden ones). The Properties sheet stays open.

• Click OK to apply the settings to all gauges in the window 
(including hidden ones). The Properties sheet closes.

Properties Sheet – Global Tab

The Global tab contains several sections of options you can select to 
change the appearance of all gauges.

Change Dimensions

Drag the sliders at the top and left of the gauge preview to resize all 
gauges. As you drag the sliders, the gauge preview changes size in 
real-time to show the current dimensions for all gauges.

Gauge Title Font, Gauge Value Font, and Gauge Font

Click the Select Font button to select a different font family, font style, or 
font size for all gauges’ titles, values, or gauge fonts, respectively. 
WinGauge displays a standard Font dialog box where you can select from 
the fonts available on your computer.
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Í TIP: Title text is visible when the Title check box is selected in the 
Gauge Text section of the Appearance tab. Value text is visible when 
the Value check box is selected. The fonts for titles and values are set 
in the Gauge Title Font section and Gauge Font section. The Gauge 
Font is the font used when you select a gauge type of Text Gauge.

Show Bubble Help

Select the Show Bubble Help check box to display Bubble Help when you 
point to a gauge and wait for the specified delay time. Drag the Delay 
slider left or right to change the delay (in seconds). The shortest delay is 
one second and the longest is ten seconds.

Change a Gauge’s Actions
Although you may have your gauges displayed on the screen, you may 
also want to be notified whenever you reach the threshold limits on any 
gauge. WinGauge allows you to select actions that will be triggered 
whenever any of your thresholds are reached. Depending upon your 
requirements, you can have WinGauge play a sound, display a message, 
or even run an application, to alert you to the status of your system.

To change a gauge’s actions:

1. Point to a gauge and press the Right mouse button.

2. Choose the Properties command.

3. Click the Action tab to bring the tab to the front.

4. Select the Actions properties to apply to a gauge you are creating.

The properties you can select are described after the Actions tab 
illustration below.

5. Do one of the following:

• Click Default to use WinGauge’s default Action properties.

• Click Apply to apply these settings to the gauge.

The Properties sheet remains open.

• Click OK to apply these settings.

The Properties sheet closes. The new Action gauge appears.

Properties Sheet – Action Tab

The Action tab contains several sections of options you can select.
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Invert Alarms

WinGauge allows you to set up your gauges to monitor both increasing 
and decreasing values. Normally, you will want your gauges to show you 
what proportion of an available total you are using. That is, you want to 
see how “full” your gauge is and how close you are to reaching the upper 
limits. Typically, you would use a regular gauge to monitor a value that is 
increasing, such as occupied disk space. But occasionally, you will need to 
monitor a value that is dropping, such as available disk space.

To monitor reducing values, select the Invert Alarms check box.

The roles of threshold levels and alarm levels in Regular Alarms and 
Inverted Alarms are best explained by the following examples:

• If you are monitoring occupied disk space, you would use Regular 
Alarms and could set your warning threshold to 90% full with an 
alarm to be triggered when your disk becomes 95% full.

• If you are monitoring available disk space, you would use Inverted 
Alarms, and could set your warning threshold to 10% available, with 
an alarm being triggered when your available disk space drops to 5%.

Enable Warnings/Enable Alarms

Select the Enable Warnings or Enable Alarms check boxes to receive 
warnings or alarms, respectively, in WinGauge. After you select one or 
both of these check boxes, their related options become active. While they 
are deselected, the related options are dimmed. You can select any 
combination of the following options:

• Threshold–Drag the Threshold sliders left or right to specify the 
percent at which a warning or alarm should take place. The Warnings 
and Alarms thresholds are constrained to each other on the threshold 
range (from Off to 100%). This constraint relationship is determined 
by whether the Invert Alarms check box is selected.

When the Invert Alarms check box is deselected, you can set the Warnings 
Threshold percent equal to or less than the Alarms Threshold percent. 
The Alarms Threshold constrains the range available for the Warnings 
Threshold. For example, if you set the Alarms Threshold to 40%, you 
can subsequently set the Warnings Threshold at a value constrained 
between Off to 40%. You can then drag the Alarms Threshold slider 
above 40% and the Warnings Threshold remains the same. However, 
if you drag the Alarms Threshold slider below the current Warnings 
Threshold’s percent (in this case, below 40%), the Warnings Threshold 
slider “locks in” and decreases matching the Alarms Threshold 
percent.
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When the Invert Alarms check box is selected, you can set the Alarms 
Threshold percent equal to or less than the Warnings Threshold 
percent. The Warnings Threshold constrains the range available for 
the Alarms Threshold.

• Pop-up Dialog–Select the Pop-up Dialog check box to see a pop-up 
dialog box when the gauge, reaches the threshold.

• Sound–Select the Sound check box to select a sound (a .WAV file) to 
play when the threshold is reached for this gauge. After selecting the 
Sound check box, you can click the Folder button to select the sound 
file to use, in the same way that you select sounds for other Windows 
applications or events.

• Run–Select the Run check box to select an application (an .EXE file) to 
run when the gauge reaches the threshold. You can click Folder to 
select the application to use. The Action File dialog box appears where 
you can enter a path to the application file, or browse to find it. You 
can also select whether the application should run in a normal 
window, or be minimized or maximized.

Saving and Loading Gauge Settings
After changing the WinGauge window, you can easily save all your 
settings by name. This lets you reload these settings later. You can save 
multiple WinGauge windows, and quickly reopen any of them you want 
to see or work with. Initially, WinGauge opens the Default.wgp file that 
contains the default settings. Most likely, you’ll want to save settings using 
a unique name that reminds you of their purpose. Once you’ve given the 
settings a name, simply choose the Save command while those settings are 
loaded to resave any further changes you make.

Í TIP: To have WinGauge automatically load using a particular gauge 
settings file in Windows 95/98, specify the filename of the settings file 
in the WInGauge shortcut’s properties sheet.

To save gauge settings:

1. Point to a gauge and press the Right mouse button.

2. Choose the Save As command from the Settings menu.

3. Enter a filename for these settings and click Save.

You should use the .WGP file extension for settings files.
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Í TIP: To reopen saved settings, choose the Load command from the 
Settings menu. See online Help for details about loading a setting 
automatically in Windows.

Docking and Undocking WinGauge

Í TIP: While the WinGauge window is docked, you cannot resize 
gauges interactively by CTRL-dragging. You can, however, rearrange 
gauges in the WinGauge window if the titlebar is showing.

You can dock and undock the WinGauge window at any time.

To dock the WinGauge window:

1. Point to a gauge and press the Right mouse button.

2. Choose the Dock WinGauge command from the Global menu.

The WinGauge window snaps to the closest edge of the desktop. The 
Dock WinGauge command changes to Undock WinGauge.

While the WinGauge window is docked, you can enable the Auto 
Hide feature. This temporarily hides the WinGauge window until you 
point at the edge of the desktop where the window is hidden. 

To undock the WinGauge window:

1. Point to a gauge and press the Right mouse button.

2. Choose the Undock WinGauge command from the Global menu.

The WinGauge window undocks from the edge of the desktop. The 
Undock WinGauge command changes to Dock WinGauge.

Í TIP: You can instantly undock the WinGauge window by dragging it 
away from the edge of the desktop.

Dragging Application Icons Into WinGauge
As well as displaying gauges to keep you informed of the status of your 
system, you can use WinGauge to house application icons and folders, 
giving you a quick and easy one-stop launch pad. In addition to freeing up 
your cluttered desktop, putting application items in WinGauge 
encourages you to visually check the status of your gauges regularly.
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To drag an application icon into WinGauge:

Open WinGauge, open My Computer or Windows Explorer, locate the 
application’s icon, and drag the icon into the WinGauge window. You can 
also drag icons, files or folders from the Desktop into WinGauge.

Figure 3–1. Drag an application icon into the WinGauge window to 
add it as an Action gauge; click an Action gauge to 
launch the application

McAfee VirusScan
Nuts & Bolts 98 comes with McAfee VirusScan, a separate software 
program, that checks your software for computer viruses.

Viruses can infect any computer and cause serious damage. A virus is a 
small program that, when it is inadvertently run, takes control of the 
infected computer. This gives the virus the opportunity to perform 
destructive actions, like deleting or writing over files or changing random 
bits of data.

A virus, like its biological namesake, replicates itself and attaches to 
another program, or any file that can be run (such as a word processing or 
spreadsheet macro). When you run the infected program or macro, you 
unknowingly run the virus. While the virus is running, it has the 
opportunity to clone itself, thus spreading from one disk or drive to 
another. It also has a chance to damage or destroy your valuable 
information.

For complete instructions, see the online McAfee VirusScan manual PDF 
file provided on the CD disc in the Manuals folder. The Adobe Acrobat 
Reader program is also provided on the CD disc so that you can view or 
print the electronic version of this manual.
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Year 2000 Checker
The countdown is on to the year 2000. So what’s all the hubbub about this 
date in the computer world?

What is the Year 2000 Problem?
For nearly a millennia, we have been abbreviating the year to simply two 
digits in date notations. Almost universally, people understand that 
12/01/98 means December 1, 1998. Unfortunately, most computers and 
software followed suit. For details about why this happened, see Why Do 
We Have Y2K Problems With Our Computers? on page 71.

The problem in a nutshell is simple math (which is the language of 
computers). Computers and software most often allocate two digits for the 
year, both when storing the information and when displaying it on the 
screen. Starting in the year 2000, our data will span two centuries. For that 
reason, four digits must be used to accurately sort, calculate and compare 
years in the 1900s and 2000s.

The human eye can instantly recognize that 00 means the year 2000 and 95 
means 1995. Therefore on screen displays, dates are likely to still only 
show two-digit years. But the underlying storage and calculation of dates 
must change.

Using two digits for the year works fine when all the dates are in the same 
century. However, when dates span centuries, calculation problems can 
arise unless computers use four-digit years. For instance, when 
subtracting 06/01/95 from 06/01/05 to determine a person’s age, a 
computer using two digits would produce an incorrect result of -90 
instead of 10 (the accurate result).

Why is the Y2K Issue so Urgent?
The year 2000 is the beginning of the Gregorian calendar year that 
culminates with the start of a new century and a new millennium. It is also 
the year whose first tick of our clock’s second hand will test the date 
handling of computers and software worldwide. What makes this issue 
urgent is that the deadline for bringing computers and software into Year 
2000 (Y2K) compliancy is fixed. We simply cannot turn back the clock and 
still have meaningful data.

So will our computers and software accurately handle this transition from 
dates in the 1900s to dates in the 2000s? Or will our computers suddenly 
miscalculate the date and reset computer clocks to some date only 
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meaningful to the developers, such as January 1, 1990 or January 4, 1980? 
Or worse yet, will our computer systems stop working entirely? These 
situations are all possible. And the Y2K problem is massive, affecting 
governments, private sector business and home users alike.

For this reason, U.S. Government agencies estimate they will spend $2.3 
billion between the 1996 and 2000 fiscal years bringing government 
computer systems into compliancy before the beginning of the year 2000. 
Solving the Y2K issue is the most massive example of human cooperation 
and teamwork to date. In that respect, achieving total compliance before 
2000 will be something to celebrate in itself.

Why Do We Have Y2K Problems With Our Computers?
The Year 2000 issue is a problem now, because of design decisions made 
two or more decades ago by engineers and programmers. These people 
knew that the turn of the century loomed only 20 years in the future. 
However, they were confident that their products would only have a five 
to ten year lifespan. Hardware wears out, and software is enhanced (at 
that time approximately once every year a new release of software was 
made available).

There were other factors involved in those early decisions to use a 
two-digit year. Screen “real estate” (or the area on the screen available for 
displaying information) has always been a precious commodity. Also the 
standard method of noting dates by hand and in printed forms used only 
the last two digits of the year. For these reasons, and for reasons associated 
with the storage space needed to store dates, developers opted to go with 
only two digits to represent the year (that is, 93 is 1993, 86 is 1986, and so 
on).

These developers were confident that their products would be “wall art” 
long before the next century commenced. In that regard, they were right. 
The earliest microcomputers (such as Z80 and 8080 CPUs) and their 
software have long been obsolete and are now in some cases collectors 
items.

What these developers did not predict was that the standard methods of 
storing dates that they defined would become “etched in stone.” They did 
not foresee that their hardware and software, although long out of 
production, might remain in use long into the future due to replacement 
costs. Neither did they expect that using two-digit years would start a 
chain reaction of backward compatibility and design stasis that has caused 
developers to scramble en masse to find and fix every single occurrence of 
Y2K non-compliance in hardware and software alike.
McAfee Nuts & Bolts 98 71



Prevent and Protect
What are the RTC, BIOS, DOS, and Windows Clocks?
Nuts & Bolts 98’s Year 2000 Checker can test the four clocks on your PC. 
They are the RTC, BIOS, DOS and Windows clocks.

The RTC (Real Time Clock) is a device in your computer that maintains the 
time (measuring elapsed time) even when you turn off or unplug your PC. 
Accurate time measurement is needed on your PC, and not just so that you 
can use your computer as a timepiece either. Your PC uses accurate time 
to perform a flow of computing tasks. The RTC clock gives your computer 
the ability to perform tasks in order.

The BIOS (Basic Input/Output System) clock is stored in firmware, such as 
PROM (Programmable Read Only Memory) or EPROM (Erasable 
Programmable Read Only Memory). When you start your computer, the 
BIOS reads the date and time from the RTC. The BIOS is your PC’s “traffic 
cop,” which dictates how software interacts with all the peripheral devices 
in your computer, including the RTC clock. Most software gets the date 
and time from the BIOS, DOS, or Windows clocks. Non-compliant BIOS 
clocks have reset themselves from 12/31/1999 to 01/01/1900 when the 
year 2000 begins.

The DOS (Disk Operating System) clock gets its date and time from the BIOS 
clock, and then makes the current date and time available to you or to any 
application that requests it. You can change the DOS date and time in an 
MS-DOS Prompt window using the DATE or TIME commands. 
Non-compliant DOS clocks have reset themselves from 12/31/1999 to 
01/04/1980 (the date when DOS was originally released, and before 
which it did not need to support a current date).

NOTE: Although seemingly transparent, MS-DOS still runs underneath 
Windows 95/98, so the Year 2000 Checker fixes the DOS date if it is 
non-compliant.

The Windows clock gets its information from the DOS clock, and makes the 
date and time available to Windows applications, or to you via the 
Date/Time control panel. Non-compliant Windows clocks have also reset 
themselves from 12/31/1999 to 01/04/1980.

How to Ensure Y2K Compliancy of Your PC’s Clocks
Nuts & Bolts 98’s Year 2000 Checker can instantly determine exactly what 
the four primary clocks on your computer will do on certain milestone 
dates without some form of correction or intervention. It can also bring 
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these clocks into compliancy by installing the Y2Kfixer.com program, and 
adding a line to your AUTOEXEC.BAT file that causes this program to run 
each time you start your computer. Even if you uninstall Nuts & Bolts 98, 
the Y2Kfixer.com program remains on your system so it continues to be 
Y2K compliant.

What Dates Does Year 2000 Checker Test and Why?
The Nuts & Bolts 98 Year 2000 Checker tests each of the four clocks for the 
following dates. In each case, it starts the tests a few seconds before the 
date and verifies that the transition to the next day’s date is accurate.

01/01/2000

This date is the 2000 rollover. In some applications that perform 
forecasting or handle future dates, this date will be reached before the 
actual calendar date. Examples of this include banking, accounting and 
project management software. In many cases, these programs may begin 
using 01/01/2000 when the previous year begins on 01/01/1999 or even 
earlier. The Year 2000 Checker tests to make sure that all four clocks 
transition accurately from a few seconds before 01/01/2000 into the next 
day.

02/29/2000

The year 2000 is a leap year, so the Year 2000 Checker verifies that this date 
is accurate.

The rule for determining leap years is:

• Years divisible by 4 are leap years except for years ending in 00.

• Years ending in 00 that are divisible by 400 are leap years.

Reports have been made of computers failing to accurately consider 2000 
a leap year (and instead making the year 2001 a leap year).

03/01/2000

Some BIOS clocks go correctly to February 29, 2000 but then continue to an 
inaccurate date of 02/30/2000. So the Year 2000 Checker tests not only 
02/29/2000, but also that it then moves accurately to the first day of March 
(03/01/2000).

01/01/2002

The Year 2000 Checker tests 01/01/2002 to ensure that farther down the 
road your clocks are still handling dates accurately. It also confirms that 
the clocks do not consider the year 2002 to be a leap year.
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What Other Y2K Problems Must You Resolve?
After you ensure that your PC’s clocks are Y2K compliant using Nuts & 
Bolts 98’s Year 2000 Checker, you still need to verify that the software you 
use, and your data itself, is also Y2K compliant.

Check the ways that you use dates in your data (such as embedding dates 
in identifiers like serial numbers). Also check with your computer vendors 
for Year 2000 compliance in all new products or updates you acquire. If 
you are using older software, it is an excellent idea to update it.

If you have custom software, its programmers must examine the source 
code, looking for not only two-digit dates, but also for obscure times when 
dates, week counts, or even day of the week calculations are performed. If 
an inaccurate calculation of leap years is made, even the day of the week 
can be thrown off.

If your PC is connected to a LAN, be aware that networking software 
synchronizes the server clock with your PC’s clock whenever you connect 
to a server. This means that LAN servers must be accurate, or they could 
update workstation clocks resetting them all to the wrong date.

To determine if your system is Year 2000 hardware compliant:

1. Click the Start button and do one of the following:

• Choose the Nuts & Bolts command from the Start menu, click the 
Tools button and choose the Year 2000 Checker command.

• Choose the Programs > Nuts & Bolts > Year 2000 Checker 
command.

2. Click Next >.
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Y2K Checker tests your computer system for compliance. It displays a 
circled red X beside the dates that are non-compliant and a check mark 
in a green box for those dates that are compliant.

3. Click Next >.

If the Y2K Checker finds dates that are non-compliant, it copies the 
Y2Kfixer program to your Windows directory and adds a line to your 
AUTOEXEC.BAT file that causes this program to run each time you 
start your PC. The Y2Kfixer program ensures that your PC’s dates 
remain accurate after January 01, 2000.

NOTE: If the RTC clock fails, but the BIOS clock checks out okay, the 
Year 2000 Checker indicates that your PC is year 2000 hardware 
compliant because the BIOS contains a fix.

4. Click Finish.

If your system clocks were inaccurate, the Y2Kfixer.com program is 
installed on your PC. Each time you start your computer, this program 
runs to correct the date as necessary. Even if you uninstall Nuts & 
Bolts 98 later, the Y2Kfixer.com program remains installed so it can 
continue to protect your system’s dates each time you start your PC.

NOTE: You should leave the Y2Kfixer.com program on your system 
if it is installed to ensure on-going protection of your PC clock dates.
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Trash Guard
When you enable Trash Guard, all deleted files, even ones you delete in 
DOS or in 16-bit applications, are moved to the Recycle Bin. When you 
start the Trash Guard application, you enable it.

To start Trash Guard, choose Programs > Nuts & Bolts > Trash Guard 
from the Start menu. You can also Right-click the Recycle Bin icon in My 
Computer or Windows Explorer, choose Properties, select the Nuts & 
Bolts 98 tab, and select the Enable Trash Guard check box.

Specifying Trash Guard Properties
Trash Guard’s Properties sheet lets you decide if the Trash Guard 
Properties tab appears in the Recycle Bin’s Properties sheet dialog box. 
You can also specify any files to exclude from delete protection.

To add files to exclude from delete protection, click the Add New button. 
Then locate the files to exclude or the path to a folder or directory of files 
to exclude. Or you can use standard wildcard characters to exclude all files 
that have the same file extension or similar names. The wildcard 
characters you can use are:

• Asterisk ( * )–a multiple-character placeholder. For example if you 
enter *.BAK , all files that have the .BAK file extension would be 
excluded from delete protection. Or if you enter ~*.* , all files that 
start with a tilde ( ~ ) and have any file extension would be excluded 
from delete protection.

• Question Mark ( ? )–a single-character placeholder. For example, you 
could enter map??.bmp  to exclude a range of files named map01.bmp  
through map99.bmp .

Trash Guard also lets you select files in the Files To Exclude list and click 
Modify to modify the definition of these files, or click the Remove button 
to remove them from the list of files to exclude.

Retake
The most important asset on your computer is the information, or data, 
you create and store there. Over time, this data grows in size and value. 
The storage devices where you keep this information, although typically 
quite reliable, are still vulnerable to a wide range of environmental and 
human factors that can damage or destroy all or part of the data stored 
there.
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Valuable and vulnerable disk organizational structure information is also 
stored in various places on a hard drive. This includes the boot sector, 
partition tables, directories, the FAT (file allocation table), and other 
structural components. These structural components are used by 
Windows to find data on the drive, organize it, and so on. If any one of 
these components is damaged or destroyed, you will not be able to access 
the data you’ve stored on the drive.

Let’s take a closer look at one of these structural components, the file 
allocation table. The FAT, your drive’s roadmap, points to the locations 
where your files are physically stored on the drive. Files can either be 
stored in contiguous locations or scattered in pieces in different places. 
Since files are not always stored contiguously, the FAT information 
becomes even more indispensable than if files were stored one after 
another, end to end. If a drive’s file allocation table becomes corrupt or 
scrambled (such as may be caused by a virus), your computer will be 
unable to find and assemble all the pieces of your files. This is true even if 
all the files’ data still exists.

Protected Volume Files (The Ultimate Backup Protection)
Nuts & Bolts 98’s Retake utility allows you to create backup sets in 
protected volume files, which is the safest and preferred type of backup, 
and is unique to Nuts & Bolts 98. A protected volume file is a sectioned off 
portion of the drive, sometimes called a logical drive. Retake’s protected 
volume files have some very special characteristics that let Retake 
reconstruct backup files sector by sector, even if the drive’s standard FAT 
is damaged or completely lost. In fact, files can be largely reconstructed 
even if large parts of the drive are unreadable or erased.

The protected volume file also includes enough information in each 
directory entry to completely reconstruct a file’s entire directory tree even 
if all its parent nodes are erased.

Retake provides internal redundancy in the protected volume file backups 
you create. It does this by marking each sector of each file that it backs up 
with identifying information about the sector’s contents and the file that 
sector belongs to. Each sector in a protected volume file contains enough 
information to allow files to be reconstructed from their individual sectors.
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Why You Should Make Regular Backups With Retake
Your data is very valuable and costly to recreate. This means that making 
frequent or even mirror backup copies of the important data on your 
drives is crucial. A mirror backup copy is always identical to the original 
information on the source drive.

Retake automates the back-up process, doing the time-consuming and 
repetitive work for you. It lets you decide which types of files to back up, 
how often to save them, and where you want the backup set located (on 
the same drive, another local drive, or on a shared network drive). With 
Retake, you can create mirror backup sets that are, at any given time, an 
exact replica of the files you’ve selected to back up on the source drive. 
You can also specify a short time delay in the backup, or back up manually 
by copying files to the backup set on your drive if you prefer.

All forms of data storage are susceptible to losing the information they 
hold. The most common types of data storage—hard drives, 3.5-inch 
disks, ZIP disks or SyQuest tapes—are often called permanent storage (thus 
differentiating them from the volatile storage in your computer’s RAM, 
random access memory). Permanent storage means the information 
remains intact even when you turn off your computer. Permanent storage 
does not mean eternal storage.

Many things can cause the data on disks, tapes or drives to become 
garbled or lost: hardware malfunctions, worn out media, electrical storms, 
excessive heat, static electricity, magnets, loose cable or power cord 
connections, and so on. CD discs, though durable, can become scratched 
enough to damage their data. Human actions can also cause lost data, such 
as deleting the wrong folder or formatting the wrong drive. Even a 
well-designed application can sometimes cause its own files to become 
corrupt.

With so much at risk, you have everything to gain by letting Nuts & Bolts 
98’s Retake utility automatically make backup copies for you. You simply 
decide what information is important to you, how you want it to be 
backed up, and where you want the backup copy to be stored. Retake 
takes care of the rest!

How Retake Creates Automatic Backups
When you select to have Retake automatically create a backup set for you, 
it creates the first backup set while you are stepping through the Retake 
Wizard. Thereafter, while the Enable Automatic Backup option is selected, 
it continues to update your backup set at the time delay you’ve specified. 
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If you chose to make Mirror backups, Retake updates your backup set at 
the same time that you resave the original source files.

If you select a write-behind delay longer than zero seconds (a Mirror 
backup), Retake updates the backup set at any time after the specified time 
delay when your PC is idle. This allows Retake to work in the background 
so that it does not interrupt the work you are doing. This is a good option 
to use with the protected volume file backup type since it eliminates any 
speed loss due to more frequent disk accesses and larger file sizes 
associated with the protected volume file backup type.

Defining Your Backup Strategy
After you decide which backup type you want to use (either a protected 
volume file or a directory backup set), the most important questions you 
must answer when defining your own backup strategy are:

• Where will you store the backup set?

• What files are important (which files must be backed up)?

• How often should you or Retake make these backups?

Where Will You Store the Backup Set?
If the survival of your business depends upon your PC being up and 
running at all times (and if money is not an object), the ultimate way to 
protect the data on your PC would be to set up a redundant PC with 
identical sized drives. This backup PC’s only job would be to mirror the 
data on your primary PC. It would be waiting in the wings should your 
first PC fail for any reason. And if that happened, you could simply switch 
your work to the second PC while the first one is repaired.

Often money is a consideration in deciding where you’ll store your 
backup sets. The least expensive way of making backups has traditionally 
been to copy data to 3.5-inch disks, though this is the most labor intensive 
way of storing backups because it requires you to switch disks by hand.

In today’s computer marketplace, you may discover that it is as cost 
effective to acquire a separate backup hard drive where you can keep a 
current mirror backup copy of one or more other drives that you use on 
your PC.

In addition, you may want the backup copy to be stored at a remote 
location, for increased protection. As long as Retake can access a logical 
drive mapped on your PC, it can store the backup set there. That is, the 
backup set can be stored on a shared network drive.
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NOTE:  You can use the Map Network Drive command, available by 
Right-clicking My Computer, to assign (map) a drive letter to a location on 
a network drive. This makes that location a “logical drive” on your PC. For 
more details, see your Windows online Help.

Even if you cannot invest in another drive or disks for storing your 
backups, you can still create a backup copy of your data on the same drive. 
This offers the least protection should that drive fail, but the potential for 
data recovery is increased by having two sets of your most important 
information stored there. It is further enhanced if you select the protected 
volume file backup type, which allows recovery in many circumstances 
even with the drive physically damaged.

NOTE: If your data usually resides on a server, you can make a local copy 
so you can access data even when the server goes down.

What Files are Important to You?
Retake automatically selects files that are typically important to include in 
a backup set. However, you can select other files or types of files to include 
in your backup set.

In addition, you can create multiple backup sets of data for particular 
purposes. Each of these backup sets can be created when and where you 
specify. They can each include exactly the files or types of files that you 
choose. For example, you might create individual backup sets for each of 
your clients if you produce data for clients that is stored on your computer, 
such as advertising layouts, graphic images, books, or accounting data.

How Often Should You or Retake Make Backups?
The more recent your backup set, the happier you’ll be if your PC does 
encounter a problem that compromises the data on your primary drives. 
However, you may want to keep the default Write-behind Delay of 20 
minutes to give you time to recover a previous version of a file if you ever 
need to.
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Í TIP: Save early, save often. While working in applications, you can 
almost always press CTRL -S to save your work as you go. The more 
often you save your work, the less you have to lose at any given point 
in time. You may also want to be sure the auto-save option is selected 
in your applications for more frequent backups.

Creating a Backup Set
Creating a backup set, either manually or to be updated automatically, in 
Retake is very easy. Retake’s default choices should work fine, though you 
may want to add additional folders or file types to your backup list.

To create a backup set:

1. Click the Start button and do one of the following:

• Choose the Nuts & Bolts command from the Start menu and click 
the Retake button.

• Choose the Programs > Nuts & Bolts > Retake command.

2. Click the Next > button while the Create a New Backup Set radio 
button is selected.

3. Select whether to back up to a Protected Volume File or a Directory. 
Then click Next >.
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Protected Volume File–The Protected Volume File is the preferred 
backup type. A protected volume file is a sectioned off portion on the 
drive. It has special characteristics to ensure that even if 
organizational structures, such as the file allocation table on the drive 
is corrupted or lost, or the data becomes scrambled, the files in the 
backup set can be reconstructed. Retake stores extra information (in 
each sector for each file and also in a separate directory) to provide 
this level of protection. For details, see the Protected Volume Files (The 
Ultimate Backup Protection) on page 77.

NOTE: You can copy files into a protected volume file manually using 
My Computer or Windows Explorer to add them to your backup set 
and instantly protect them.

There are two drawbacks to using a protected volume file backup 
type. The first drawback is that three percent more storage space is 
required for the extra information that will be used to reconstruct the 
files in the event of a problem. The second drawback is that a 
protected volume file is slightly slower because it has to manipulate 
more information in more areas on the disk and more disk accesses are 
required. This is a marginal performance degradation, which you can 
eliminate by also selecting a Write-behind Delay of seconds or 
minutes.

Directory–The Directory backup type makes another copy of the files 
and directories selected for backup in a different location. This type of 
backup creates no performance drain on the system and it’s simple to 
manage the backup area. You can use My Computer or Windows 
Explorer to cut or copy files in or out of the backup location or delete 
the files. The drawback of selecting a directory backup type is that the 
files are no more protected than if you had created a backup copy 
yourself.

4. Specify the target destination where the backup set will be created and 
click Next >.

5. Click the Settings button if you want to customize any of the settings 
for this backup set.

Volume Settings

• Backup Type–Displays the currently selected backup type 
(Protected Volume File or Directory).

• Enable Automatic Backup–While this check box is selected, 
Retake automatically updates this backup set as you update the 
files it contains based on the time delay you specify.
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• Name of Backup Set–If you are saving this backup set to a 
non-Windows 95/98 or NT drive (such as to a UNIX server on 
your network) be sure to follow the 8.3 naming convention for this 
name.

• Write-behind Delay–Select the Mirror (0) write-behind delay if 
you want your backup set to remain in constant synchronization 
with the original files as you change them. Select a write-behind 
delay in seconds or minutes if you want your backup to be created 
during times when your PC is idle starting at any time after the 
time delay you select.

NOTE: A write-behind delay in seconds or minutes is 
recommended if you are using the protected volume file backup 
type and want to eliminate the slight speed reduction caused by 
extra disk accesses in more locations on the drive.

• Protected Volume Drive Letter–(available only for backup sets stored 
as a Protected Volume File). The drive letter you want to use for the 
Protected Volume File backup set.

• Keep Deleted Files For–Select how long you want the backup set 
to keep files whose original counterparts have been deleted from 
your system.

• Limit Size of Backup Volume–Drag the slider left to reduce the 
backup volume size limit or right to increase the backup volume 
size limit.

Backup Drive

Drive and Directory Folders appear in the Backup Drive list so you 
can select any of the ones you want to add to your backup set. Click 
folders to open and close them. Click the check boxes to place a check 
mark beside the drives or directories that you want to back up.

Document Types

You can select groups of files that you want to include in your backup 
set by selecting their file type. The file type, such as TXT (for a text file), 
indicates the file’s purpose. Retake displays a list of all the registered 
file types in Windows 95/98. The file types with check marks show the 
types of files that will be included in your backup set.
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Retake obtains its list of registered file types from Windows. You can 
view or add registered file types in My Computer or Windows 
Explorer.

If you are not yet familiar with file types and want to see them, you 
can open My Computer or Windows Explorer, choose the Options 
command from the View menu, and click the File Types tab.

In the Options dialog box you can examine the list of the registered file 
types on your system. These are the file types that will be available to 
you in Retake. You can add new registered file types in the Options 
dialog box to make them available to Retake the next time you run it.
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Many file types are standard, such as BMP and PCX which are used 
by paint applications like Microsoft Paint, or TIF which is a standard 
file type for TIFF graphic images. Each application’s documents 
typically have a file type (which may or may not be registered in 
Windows). For example, Microsoft Word documents may be stored 
using registered file types of DOC, RTF or TXT, depending on the file 
type selected when saving the document.

NOTE: You can also view file types directly in My Computer or 
Windows Explorer. Choose the Options command from the View 
menu, click the View tab, and make sure the HIDE MS-DOS FILE 
EXTENSIONS FOR FILE TYPES THAT ARE REGISTERED check box is 
deselected. Registered file types are also listed in the File Types tab in 
the Options dialog box. The other place where file types appear is in 
the Save As dialog box of Windows applications.

6. Click Apply to apply changes. Then click OK when you are done.

If you want to make a backup set manually, deselect the Enable 
Automatic Backup check box.

If you’ve selected the 3.5-inch drive or a removable media drive that 
provides less space than needed for the backup set, follow the 
instructions on the screen and switch disks or tapes when instructed.

7. Click Next >, enter a backup volume name and click Next > again.

8. Click OK.

Restoring Files from a Backup Set
If you encounter a problem with the information on your drive, you can 
restore one or more of the files in your Retake backup sets.

NOTE: Unless you create a backup set containing the entire contents of a 
drive, you should never drag and drop or copy/paste the contents of a 
Retake backup set’s <drive letter> folder into a drive icon or window. 
Though the folder names match between a Directory type backup set and 
the folders on the drive, the files inside are most likely very different. By 
default, Retake only backs up files it considers essential, such as INI, TXT, 
RTF, DOC and WRI files. It backs them up using the original hierarchical 
directory structure from the source drive. You will know where to restore 
each file, if you need to, based on its location in the backup set. It does not 
automatically back up application or DLL files, nor does it back up the 
Windows directory without your explicit instructions to do so.
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Í TIP: You can use the bootable disk created by Rescue to restore files 
from a backup set located on a damaged drive.

To restore a backup set:

1. Open Windows Explorer or My Computer and open the backup set.

If the backup set is a Directory type backup, the folder name (by 
default) is Backup_1, Backup_2, and so on. If the backup set is a 
Protected Volume File, it is located at the same level as your physical 
drives.

2. Find the files to restore and use Drag and Drop or Copy/Paste to copy 
files from your backup set to the location where you want them.

Modifying or Deleting Backup Sets

Modifying an Existing Backup Set

To modify a backup set:

1. Click the Start button and do one of the following:

• Choose the Nuts & Bolts command from the Start menu and click 
the Retake button.

• Choose the Programs > Nuts & Bolts > Retake command.

2. Select the backup set to modify and click the Properties button.

3. Change the settings and click OK when you are done. Click Finish.

Deleting a Backup Set
If you created a Retake backup set as a protected volume file, you cannot 
delete it in My Computer or Windows Explorer. You can only delete the 
protected volume file using Retake.

If you created a Retake backup set as a directory, you should still delete it 
using Retake; however, you can delete the backup directory via My 
Computer or Windows Explorer.

To delete a backup set:

1. Start Retake.

2. Click Next > while the Delete a Backup Set radio button is selected.
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3. Select the backup set to delete and click Finish. Then click Yes to 
confirm the deletion.

Repairing and Rebuilding a Backup Set
If you encounter a problem with the backup set itself, you can repair or 
rebuild it. For example, if your computer crashes while the backup is being 
created or updated automatically, the backup’s contents may be 
incomplete or damaged. Retake automatically checks the backup’s 
integrity when you start Windows. If it is damaged, Retake starts and asks 
if you want to repair the backup set.

To repair or rebuild a backup set:

1. Start Nuts & Bolts 98’s Retake utility and click Next > while the Repair 
or Rebuild Backup Set radio button is selected.

2. Do one of the following:

• Click the Repair button and click Next > if you can see the backup 
set in My Computer or Windows Explorer, but the information is 
somehow damaged. For example, if a backup was not finished 
due to a power outage or computer crash.

• Click the Rebuild button and click Next > if you can no longer see 
the backup set (for example if the protected volume file is no 
longer visible in My Computer or Windows Explorer).

NOTE: Performing a Rebuild is a time-consuming process 
because Retake searches your entire system to find all backup sets 
that are stored there.

3. Select the drives that contain a protected volume file you want to 
restore. Then click Next >.

The Restore utility searches the selected drives for protected volume 
files or backup directories. If it finds a protected volume file, a 
message appears asking if you want to Save As, Ignore, or Ignore All.

4. Click the Save As button and select where you want the restored 
volume file to be placed. Then click Save.
McAfee Nuts & Bolts 98 87



Prevent and Protect
88 McAfee Nuts & Bolts 98



4Secure and Manage 4
This chapter explains how to use Nuts & Bolts 98 to secure your valuable 
information so it remains private from unauthorized access. It also 
describes how to manage your system to customize the appearance and 
behavior of Windows; how to keep the programs, documents and folders 
you use most often at your fingertips; and how to quickly and effectively 
archive information or exchange it with others. The Nuts & Bolts 98 Secure 
and Manage suite consists of five utilities:

• EZ Setup–lets you customize the appearance of Windows, including 
the desktop, startup programs, icons, startup and close screens.

• Launch Pad–lets you create customizable Launch Pad windows 
where you can place any desktop icon so it is easily accessible.

• McAfee Fortress–lets you encrypt and decrypt files, and build 
self-decrypting executables

• McAfee Shredder–lets you permanently erase selected files or 
non-file data on your hard drives.

• McAfee Zip Manager–lets you create Zip files, expand Zip files, and 
build self-expanding executable Zip files.

• Quick Copy–lets you copy the files or folders that you select fast.

What you’re about to learn:

• How to set up the behavior of Windows during startup; the 
appearance of Windows’ logo screens; the Windows Explorer’s 
behavior and appearance; the appearance of icons and behavior of the 
mouse and CD player on the Windows desktop; the programs that run 
automatically at Windows startup and appear in the Start > Program 
menu; and the location commands available on the File > Send To 
menu in My Computer or the Right-click pop-up menu.

• How to create Launch Pad windows to keep the icons you use most 
handy on your desktop so you can get to your work quickly.

• How to encrypt and decrypt files so only authorized people can gain 
access to the information they contain, while anyone who intercepts 
your files will only see unintelligible cipher text.

• How to permanently erase information on your hard drives so that no 
one can reconstruct it later.

• How to compress and decompress files to archive or exchange them 
with others in the most compact, cost-effective, and safely 
transmittable form.
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EZ Setup
EZ Setup lets you customize the appearance of Windows (the Windows 
desktop, startup programs, icons, startup and close screens, and so on). 
Although you can perform some customization using the Control Panel, 
EZ Setup lets you change the appearance of these objects more fully and 
easily than in the Control Panel.

System

The System tab lets you set Startup options that determine what Windows 
does during startup. The System tab also lets you decide whether to 
display logo screens (and what images should appear in these screens) 
when you start Windows and shut down or turn off your computer from 
within Windows.

Explorer

The Explorer tab lets you specify settings that affect the Windows 
Explorer’s menu speed, shortcuts, history and other settings.

Desktop

The Desktop tab lets you add, hide and rename desktop icons. You can 
change a program’s icon image and its properties. EZ Setup also lets you 
define the mouse sensitivity for double-clicking and dragging, whether to 
play audio and data CDs automatically, and whether to wrap shortcut 
names.

Startup Program and Program Menu

The Run/Add/Remove tab lets you add, remove, edit, and set properties 
for programs that automatically run when you start Windows, and for 
programs that appear on the Start > Program menu.

Send To Menu

The Send To tab allows you add, remove, edit, and set properties for the 
commands that appear on the File > Send To menu in My Computer. 
Commands on the Send To menu specify locations where you want to 
send the files you’ve selected in a drive or volume window that is open 
inside My Computer. For example, you might add an application or a 
folder to the Send To menu.

Context Menu

The Context Menu tab lets you customize the commands that appear in 
the Windows Context menu. This is the menu that appears when you 
right-click objects on the desktop or open areas or windows.
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Nuts & Bolts

The Nuts & Bolts tab lets you select Nuts & Bolts enhancements, such as 
Common, Start Menu, Background Pattern and Other enhancements.

Specifying Startup Options or Logos
The System tab allows you to configure your system by setting a variety of 
Startup options that customize how Windows behaves when it starts. The 
System tab also lets you decide whether to display logo screens (and what 
images should appear in these screens) when you start Windows and shut 
down or turn off your computer in Windows.

Figure 1. The EZ Setup window

The System options are:

• Boot to Windows–Select this check box to start Windows when you 
start your computer. When you deselect this check box and restart 
your computer, it boots up and takes you to the DOS prompt (usually 
the C:\>  prompt). To start Windows from this prompt, type WIN and 
press ENTER.

• Boot delay in seconds–Select or enter the number of seconds of delay 
you want when booting the PC. You can increase the boot delay to 
have extra time for pressing the Windows startup hot keys.

Click Change to open a different file to use
for the selected screen (you can select a
bitmap .BMP or a log .SYS file)

Select the
screen to
change, edit,
or reset to
the default

Click Default
to reset the
selected
screen to the
default image

Click Edit to open the
selected screen in a
Paint window where you
can edit the image

Click the Up
or Down
Arrow buttons
to change the
Boot delay
or select the
number and
type a new
value

Click a tab to
bring it to the
front
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• Safe mode warning message–Select this check box if you want 
Windows to display a warning message if it starts in Safe mode. If 
Windows cannot start normally for some reason, it starts in Safe mode, 
so you can make changes to eliminate the problem.

• Enable network in safe mode–Select this check box if you want to 
start Windows in Safe mode including network capabilities.

• Enable fail safe mode–tells Windows to boot in Safe mode, even if 
everything appears to be OK.

• Always load DoubleSpace drivers–Most likely you should keep this 
check box selected. The DoubleSpace driver is the file named 
Dblspace.bin . It is used to access drives compressed using 
DoubleSpace. DoubleSpace is a disk compression method that creates 
a compressed drive, which is actually a compressed volume file, or 
CVF, (usually named DBLSPACE.001) that is stored on your hard 
drive.

• Always load DriveSpace drivers–Most likely you should keep this 
check box in its default state. The DriveSpace driver is a file named 
Drvspace.bin . It is used to access drives compressed using 
DriveSpace. DriveSpace is a Windows 95/98 disk compression 
method that creates a compressed drive which is a compressed 
volume file (usually named DRVSPACE.001) that is stored on the hard 
drive.

• Enable non-native drive double buffering–This option is set 
automatically by Windows and generally should not be changed. 
Select this check box to avoid lock-ups or errors if your PC has an ISA 
controller card and a DOS driver, and if you have over 16MB of RAM 
in your PC. If your PC does not have an ISA disk controller card or if 
you use an ISA disk controller card, but have 16MB or less of RAM, 
keep this check box deselected because the double buffering could 
slow down the performance of your computer and it provides no 
benefit below the 16 MB threshold for ISA cards.

• Enable boot-time hot keys–Select this check box if you want to be able 
to use the Windows startup keys (also called shortcut or hot keys). 
Press these hot keys after the Windows starting message appears and 
before the Windows 95/98 startup screen appears.

• Name of Disk Scanner–Choose Disk Minder or Scan Disk (only for 
the OEM SR2 version of Windows 95 or later) to pick which one you 
want Windows 95 to start if it encounters a problem with a disk.

• Display startup logo–Select this check box to have the Windows 
Startup logo to appear whenever you start Windows.

• Display shutdown logo–Select this check box to have the Windows 
Shutdown logo to appear whenever you restart the PC in Windows.
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• Display turnoff logo–Select this check box to have the Windows 
Turnoff logo to appear whenever you turn off the computer after 
shutting down Windows.

• Screen drop-down list box–Choose a logo screen name and the screen 
preview shows the current image for that logo screen. Then you can 
use the Change, Edit or Default buttons to change, edit, or reset the 
default image for the chosen logo screen, respectively.

• Change–Select a screen in the pop-up menu. Then click Change to 
select a bitmap image (.BMP) or logo file (.SYS) to use for it. Note, 
Start-up images must be 320 x 400 color images—several are provided 
in the Nuts & Bolts directory.

• Edit–Select a screen in the pop-up menu. Then click Edit to edit the 
image displayed in the logo preview. EZ Setup opens the image in a 
standard Paint window.

• Default–Select a screen in the pop-up menu. Then click Default to use 
the default bitmap image for this screen.

Specifying Menu Speed, Settings, Shortcuts and History
The Explorer tab lets you customize the Windows Explorer’s behavior and 
appearance.

Your Explorer options are:

• Menu speed–Drag the slider left to make menus appear faster, or 
right to make them appear more slowly.

• Settings–Select the check boxes for these self-explanatory settings.

Drag the slider
left to make
menus appear
faster, or right
to make them
appear slower

Select the shortcut indicator type Click the Folder
icon button to

display the
Change Icon
dialog box
where you can
select a
custom shortcut
icon by filename

Click Clear Now
to clear the
corresponding
history defaults
now
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• Shortcuts–Select a shortcut indicator to use to visually distinguish 
shortcut icons from regular file icons. The shortcut indicator is part of 
all shortcut icons on your desktop. The default shortcut indicator is a 
small curved arrow inside an outlined white box.

You can also click the Folder button to select any icon to use as the 
custom shortcut icon. After you select an icon, EZ Setup displays it in 
the Explorer tab as the currently specified Shortcut Icon.

Í TIP: You can modify any shortcut icon supplied with EZ Setup 
using Discover to extract the icon to a file. Click the Software tab, 
the Advanced button, and the App Resources icon. Then select EZ 
Setup in the Modules list, select the icon in the Resources list at the 
lower left, and click the Extract Resources to File button.

• History–Select the Clear at Logon check boxes for the history 
information you want Windows to clear when it starts. History 
information includes the run history of programs most recently run, 
the history of documents most recently opened, the last find files 
settings, and the last find computer settings. You can also click Clear 
Now to instantly clear the corresponding history information.

Specifying Windows Desktop Icons and Behavior
The Desktop tab lets you add, hide, and rename desktop icons. You can 
change a program’s icon and properties. EZ Setup also lets you select the 
mouse sensitivity for double-clicking and dragging, and whether to play 
audio and data CDs automatically or wrap shortcut names.

The Desktop options are:

• Click Add to select a file whose icon you want to add to the Windows 
desktop.

• Click Hide/Show to hide or show the selected desktop icons on the 
Windows desktop.

• Click Rename to change the name of the selected desktop icon.

• Click Change Icon to change the image used for the selected desktop 
icon.

• Click Properties to display the Properties sheet for the selected entry 
in the Desktop Icons list. This gives you the same information you see 
after selecting an icon in My Computer or Windows Explorer and 
choosing Properties from the File menu.
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• Double Click–Enter, or click the Up/Down arrow buttons to select, 
the hot zone size in pixels for double-clicking. The hot zone is the 
number of pixels you can move the mouse when double-clicking 
before Windows assumes you are not clicking twice. This is not the 
speed of the double-click, which you set in the Mouse control panel. 
Rather, this is the distance you can move the mouse in between the 
two clicks. The higher the number, the larger the hot zone—and more 
movement is allowed during the double-click.

• Drag–Enter, or click the Up/Down arrow buttons to select a number 
that indicates the mouse sensitivity for dragging objects on the 
desktop. The higher the number, the longer the pause before an object 
begins following the Arrow pointer when you drag. This lets you 
move the mouse a bit when selecting an object before Windows 
interprets your action as dragging that object. The lower the number, 
the faster and more closely an object follows the Arrow pointer when 
you begin dragging it.

Í TIP: If the Drag mouse sensitivity number is set very low, and you 
slightly move the mouse while clicking an application icon (in 
Windows Explorer or My computer) to select that icon, Windows 
will interpret your action as dragging instead of selecting the icon. If 
this happens, a shortcut icon for the application is created instead 
of the icon being highlighted, which indicates it is selected.

• Auto Play–Select the check boxes to have Windows to begin playing 
audio or data CDs automatically when you insert them into your CD 
drive while the desktop is active.

• Shortcut Name Display–Select the Wrap Shortcut Names on Desktop 
check box if you want long shortcut icon names to wrap to multiple 
lines rather than extending across a single horizontal line.

Specifying Startup and Start Menu Programs
The Run/Add/Remove tab lets you add, remove, edit, and specify 
properties for programs that automatically run when you start Windows, 
and for programs that appear on the Start > Program menu.

The Run/Add/Remove options are:

• Programs Run Automatically at Windows Startup–Click Add to add 
a new program to run automatically at Windows startup. The next 
time you start Windows, the program starts automatically. These 
programs will be added to your StartUp folder.
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Í TIP: Hold down the Shift key immediately after the Windows 
Starting screen appears (or after logging in) and Windows will 
skip loading the files in your StartUp folder.

Select a program and click Remove to remove it from the Windows 
Startup folder. The next time you start Windows, the program no 
longer starts automatically.

Select a program and click Edit to edit the program’s filename or path.

Select a program and click Properties to view its Properties sheet. The 
Properties sheet shows where the program is beginning from: 
Registry or StartUp.

• Add/Remove Program Menu–When you load programs into 
Windows 95/98, they can register their install program with the 
Add/Remove Programs control panel. This section shows you which 
programs are registered this way. When you run Control Panel and 
open the Add/Remove Programs control panel, you see the same list.

If you double-click an item in this list, it runs the associated Setup 
program, which generally allows you to add or remove features of the 
program. For example, the Microsoft Office Add/Remove option 
would allow you to remove Office components, or add ones that you 
originally did not install. This EZ Setup screen lets you view or modify 
all registered install/deinstall utilities.

Specifying Send To Menu Commands
The Send To tab lets you add, remove, edit, and select properties for the 
commands that appear on the File > Send To menu. The Send To menu is 
also sometimes available in the context-sensitive pop-up menu that 
appears when you Right-click the mouse button, such as when you point 
to an icon in My Computer. Commands on the Send To menu specify 
locations where you want to send the files you’ve selected in a drive or 
volume window that is open inside My Computer or Windows Explorer. 
For example, you might add an application or folder to the Send To menu.

The Send To options are:

• Click Add to add a new program to the File > Send To menu, available 
in a drive window you open in My Computer.

• Select a program and click Remove to remove it from the File > Send 
To menu.

• Select a program and click Edit to change the program’s name in the 
Send To Locations list, which is how the corresponding command will 
appear in the Send To menu.
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• Select a program and click Properties to view its Properties sheet.

Customizing the Context Menu
The Context Menu tab lets you disable, enable or delete commands in the 
top section of the Windows Context menu. You cannot remove the Open, 
Edit or Print commands, and you cannot add any commands to the top 
section of the Context menu.

The Context menu is the pop-up menu that appears when you right-click 
an object or the empty portion of a window. The Context menu for a file 
usually consists of several sections containing commands, with sections 
divided by a horizontal separator bar. The first command in the top 
section is generally Open, where the bold type indicates the default 
choice. The default is the command performed when you double-click the 
file icon. There are usually other Context menu commands in the first 
section, such as Edit, Print, Debug, Quick View and so on.

The actual list of commands in the top section of a Context menu is 
determined by the file’s extension, and a context menu handler performs 
the action specified when a particular command is selected. EZ Setup’s 
Context Menu tab displays the relationship among file types, Context 
menu commands, and Context menu handlers from two different 
viewpoints. The default viewpoint, is to show all the Context menu 
handlers (except those for Open, Edit or Print) as root nodes of a 
hierarchical tree.

Disabling or Enabling a Context Menu Handler

To disable a particular Context menu handler, expand its node by clicking 
the Plus sign or double-clicking the icon.The child nodes revealed indicate 
the Context menu commands performed by that particular Context menu 
handler. Some Context menu handlers perform only one command, 
whereas others perform several.

In most cases, each Context menu command has a check box beside it. By 
selecting or deselecting the check box, you can enable or disable each 
command performed by a Context menu handler. For different file types, 
a different Context menu handler can perform the same command. To 
disable a particular Context menu command for more that one file type, 
you must disable it separately for each file type.

Some Context menu commands have a folder icon next to them, instead of 
a check box. This is the case when the same Context menu handler is used 
to perform the same Context menu command on more than one file type. 
In this case, expand the node to reveal the various file types that the option 
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applies to and select or deselect them individually. If a Context menu 
command has a check box next to it, its corresponding Context menu 
handler only performs that command on one file type. You can expand the 
Context menu command node to reveal the particular file type.

To view or disable all the Context menu commands for a particular file 
type irrespective of which context menu handler performs them, click the 
By File Type radio button. This causes the registered file types to display 
as root nodes of a hierarchical tree. You can then expand the node of the 
file type you are interested in to display all the Context menu commands 
(except Open, Edit or Print) for the top section of the Context menu 
associated with that file type.

Then you can select or deselect the check boxes as in the default viewpoint, 
and the two viewpoints remain consistent with each other. Each Context 
menu command node can be further expanded to reveal the Context menu 
handler that performs a command for a particular file type.

Removing a Context Menu Command

In addition to disabling and enabling Context menu commands, EZ Setup 
allows them to be permanently removed from the Windows Registry.

NOTE: Permanently deleting Context menu commands is not 
recommended unless you are positive that you will never use them. A 
warning message appears to let you confirm these deletions before they 
happen.

You can remove a Context menu command either by clicking the Remove 
button or by right-clicking the command and choosing Remove from the 
EZSetup Context menu.

NOTE: EZSetup Context menus cannot be modified by EZSetup.

After you remove a Context menu command in this way, it can only be 
restored by the application that inserted the command in the Context 
menu originally (or by hacking at the Windows Registry). On the other 
hand, you can easily restore commands whose check boxes you deselect 
using EZSetup.
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Specifying Nuts & Bolts Enhancements

Figure 2. The Nuts & Bolts tab

The Nuts & Bolts tab lets you enable and configure the following Nuts & 
Bolts enhancements:

Common Dialog Enhancements

• Show Recent Documents History List–Adds a button at the top right 
corner of the standard Open dialog box. When you click this button, a 
list appears of the recent documents the program has opened.

• Show Recent Folders History List–Adds a button at the top right 
corner of the standard Open dialog box. When you click this button, a 
list appears of folders that contain files recently opened by the 
program.

Start Menu Enhancements

• Enable Cascading Control Panel Menu–Displays the Control menu 
in a cascading menu. The Control menu is available when you click 
the top left icon in a window’s Title bar.

• Enable Cascading Run Menu–Adds a cascading menu to the Run 
dialog box that shows the most recent commands performed using the 
Run dialog box.
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Background Pattern

• Enable Background Pattern–The background pattern lets you specify 
a pattern for Wizard windows and dialog boxes in Windows.

• Select Background–Shows a standard Open dialog box where you 
can select the bitmap (BMP file) to use for the background.

Other Enhancements

• Enable Icon Animation–animates desktop icons.

• Enable Disktune Context Menu–adds access to Disk Tune from the 
Windows Explorer Context menu. To use Disk Tune via the Context 
menu, open Windows Explorer, select a disk drive and click the right 
mouse button. Then choose the Defragment command from the 
Context menu.

• Nuts & Bolts Disk Drive Property Sheet–to access this Property 
sheet, open Windows Explorer, select a disk drive and click the right 
mouse button. Choose Properties from the Context menu and click the 
Nuts & Bolts tab.

• Enable Quickcopy–adds Quickcopy to the Windows Explorer 
Context menu.

Launch Pad
Launch Pad is a simple and efficient way for you to access programs, files 
and folders without either cluttering up your desktop with numerous 
icons, or wading through the Start and Program menus to locate and open 
the applications you want to work with.

You can drag application, document and folder icons into Launch Pad, 
and rearrange or delete them in the Launch Pad window. A Launch Pad 
window can contain any icon (such as an application, document or folder 
icon) that you want to open with a single mouse click.

Starting Launch Pad
To start Launch Pad, click the Launch Pad icon on your desktop, or choose 
the Launch Pad command from the Start > Programs > Nuts & Bolts 98 
menu. An empty Launch Pad appears, which is a small window.

Adding, Updating and Removing Icons
You can add icons to Launch Pad by dragging an application icon, folder 
or file from its location on the desktop, Windows Explorer, or My 
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Computer into Launch Pad. Or you can right-click an empty area in the 
Launch Pad window and use the New command to create a new icon.

To remove an icon, Right-click the icon and choose the Remove command 
from the Launch Pad menu.

Manipulating the Launch Pad Window
You can interactively customize a Launch Pad window by resizing it or its 
icons, rearranging icons in Launch Pad by dragging them, 
docking/undocking Launch Pad, and having Launch Pad hide until you 
need it.

Hiding and Showing Launch Pad
You can hide Launch Pad and restore it to your desktop in two different 
ways. If you want to use Launch Pad to launch an application and then 
have Launch Pad disappear from your desktop, Right-click in the Launch 
Pad and choose Hide LaunchPad from the Global menu.

To show Launch Pad, double-click the Launch Pad icon in the taskbar icon 
tray. Once you have started an application by double-clicking it, Launch 
Pad hides again.

The Enable Auto Hide command lets you hide a docked Launch Pad. Once 
auto hidden, Launch Pad reappears if you point to the edge of the desktop. 
It hides again if you move the pointer away from the edge.

To restore Launch Pad permanently, Right-click and choose the Disable 
Auto Hide command from the Global menu.

Docking & Undocking Launch Pad
Docking locks Launch Pad to the nearest edge of your desktop, where it 
will remain as an uppermost Window (just like your taskbar).

To dock Launch Pad, drag Launch Pad close to any edge of the desktop 
where you want it to be docked. Then point inside the Launch Pad 
window and Right-click. Choose the Dock Launch Pad command from the 
Global menu, and Launch Pad snaps to the edge of the desktop.

To undock Launch Pad, Right-click and choose the Undock Launch Pad 
command from the Global menu.

While Launch Pad is docked, you can temporarily hide Launch Pad by 
enabling the Auto Hide feature (choose the command from the Global 
menu). To see Launch Pad, you just have to point to the edge of the 
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desktop. To show Launch Pad again, choose the Disable Auto Hide 
command from the Global menu.

Resizing the Launch Pad Window
You can change the shape of the Launch Pad by dragging one of its corners 
or edges. As you resize the window, the number of rows and columns of 
icons changes, but their order and size remain the same.

Resizing Icons in Launch Pad
You can resize Launch Pad and all the icons inside the window by holding 
down the CTRL key as you drag the corner or edge of the Launch Pad 
window. As you resize, the sizes and dimensions of the icons adjust to fit 
your new Launch Pad window.

Saving and Loading Settings
Launch Pad lets you save your settings by choosing the Settings > Save or 
Save As from the Launch Pad menu. The Launch Pad filename uses a file 
extension of .LPD. You can reload these settings using the Settings > Load 
command.

Changing Launch Pad Properties
You can customize the appearance and text of an individual icon, or make 
global changes to icon dimensions, fonts and Bubble Help, through the 
tabs in the Properties sheet. These, and other commands that you access 
from Launch Pad, work the same way as those that you use for 
customizing WinGauge.

McAfee Fortress
McAfee Fortress lets you encrypt sensitive files so that unauthorized 
people cannot access them. This is particularly useful if you keep personal 
or sensitive data on your system, or if you want to send files to another 
person, such as electronically over the Internet. You can have McAfee 
Fortress as an icon on your desktop, and drag files into the icon for 
encryption. McAfee Fortress automatically opens when you drag files into 
it.
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About Encryption
Encryption is the ciphering of information to convert plain text to cipher 
text. During encryption, McAfee Fortress uses an algorithm (your choice 
of Blowfish or DES) and a secret key to produce pseudorandom bit 
sequences that are combined with the plain text in the file to produce 
cipher text.

The person who receives the encrypted cipher text file uses the same 
algorithm and key to decrypt the information. Decryption reverses the 
process—in what is called symmetric encryption (which means the same 
algorithm and key are used to encrypt and decrypt a file)—by subtracting 
the same pseudorandom bit sequences to restore the original file.

È IMPORTANT: Is encryption legal? Yes. However, the U.S. 
government places strict export controls on encryption software. 
Network Associates, Inc. has developed an export version of McAfee 
Fortress, licensed by the U.S. Department of Commerce.

McAfee Fortress lets you send an encrypted file to someone else, even if 
they don’t use McAfee Fortress. You can do this by building a 
self-decrypting executable (.EXE) file. A self-decrypting file has a 
decrypting program, together with the encrypted document. When you 
run the program, it asks for the password and then decrypts the file if the 
correct password is given.

McAfee Fortress Password Protection
Both McAfee Fortress and the files you encrypt using McAfee Fortress are 
protected with a password you create. McAfee Fortress passwords are 
case sensitive, which means that uppercase letters are not the same as 
lowercase letters. So a password of ocean5sea  is different than 
OCEAN5sea or OCEAN5SEA. You must remember not only your 
passwords, but the case you used to originally enter them. McAfee 
Fortress encourages you to verify the password and its case by asking you 
to confirm it (enter it twice) when you first define it.

You should not share your McAfee Fortress password with anyone else, and 
you should only share the password to an encrypted file with that file’s 
recipients. When you send an encrypted file to someone, you also need to 
send them the password for the file. Send a file’s password separately 
from the encrypted file.

Choose your passwords carefully, making sure you do not use a password 
that another person might easily guess. Using people’s names, pet’s 
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names, hobbies, or other familiar words are not recommended. For 
example, if your office walls are adorned with pictures of Porsches, you 
would not want to use Porsche  as your McAfee Fortress password. 
Furthermore, it is a good idea to mix letters, numbers and symbols, such 
as an exclamation point ( ! ), dollar sign ( $ ) or ampersand ( & ), in your 
passwords, making them more difficult to guess. The ultimate password 
is one that is a random mix of letters, numbers and symbols, though that 
is harder to remember. Also, a longer password is better than a shorter 
one, and we recommend that you use at least 8 characters for passwords, 
however using 12 characters gives you even better protection. 

Encrypting a File
You can encrypt a file to protect it. Encryption is ciphering information 
using an algorithm and a key to convert plain text to cipher text.

To encrypt a file:

Í TIP: You can click the Properties button to select McAfee Fortress 
properties before you begin encrypting a file.

1. Select the Encrypt a File radio button and click the Next > button.

2. Enter the path to one or more files to encrypt or click the Browse 
button to select files to encrypt. Then click the Next > button.

3. Enter a password for the file you are encrypting, and type the 
password again to confirm it.

4. Click Finish.

When the files have been encrypted, McAfee Fortress closes and 
returns you to the desktop.

Decrypting a File
You can decrypt files that have been encrypted with McAfee Fortress. 
Decryption is the conversion of encrypted text into regular text using 
mathematical equations to reverse the encryption process.

To decrypt a file:

1. Select the Decrypt a File radio button and click the Next > button.

2. Enter the path to one or more files to decrypt or click the Browse 
button to select files to decrypt. Then click the Next > button.
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3. Enter the password specified when the encrypted files were created.

4. Click Finish.

When the files have been decrypted, McAfee Fortress closes and 
returns you to the desktop.

Building a Self-Decrypting Executable File
You can build a self-decrypting executable file (an EXE file) using McAfee 
Fortress. This ensures that you or other people can decrypt the file (if they 
enter the correct password) even if McAfee Fortress is unavailable.

To build a self-decrypting executable file:

1. Select the Build a Self Decrypting Executable radio button and click 
the Next > button.

2. Enter the path to one or more files to encrypt or click the Browse 
button to select files to encrypt.

3. Click the Advanced button to specify self-decrypting file properties if 
you want.

The Advanced options let you customize the behavior of the 
self-decrypting application. For more details, see Selecting 
Self-Decrypting File Properties on page 107.

4. Specify options you want for the self-decrypting file and click OK.

5. Click the Next > button.

6. Enter a filename and path for this self-decrypting executable file and 
click Next >.

You can also click Browse to select a path for storing this file.

7. Enter a password for the file you are encrypting, and type the 
password again to confirm it.

8. Click Finish.

When the self-decrypting files have been encrypted, McAfee Fortress 
closes and returns you to the desktop.
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Selecting McAfee Fortress Properties
You can select properties for encryption, file deletion and the desktop.

To select McAfee Fortress properties:

1. Click the Properties button.

2. Select properties you want to use and click Apply. Then click OK.

Your options are:

• Algorithm–Select either the Blowfish or DES (Digital Encryption 
Standard) cipher, or algorithm.

Designed by Bruce Schneier (schneier@counterpane.com), 
Blowfish, the newer and faster algorithm, is a block cipher with a 
variable length key, designed for 32-bit computers.

DES is a 56-bit encryption standard developed by IBM under the 
auspices of the U.S. Government. DES uses the 56-bit key to 
perform a series of nonlinear transformations on a 64-bit block of 
data. Triple DES encrypts a file using three passes of DES with 
variations of the key, which makes it the slowest algorithm. 
However, it is the most tested algorithm and is likely to be the 
most secure.

• Key Length–McAfee Fortress selects a default key length for the 
currently selected algorithm. The longer the key length, the more 
secure (but somewhat slower) the encryption.

• Compress Before Encrypting–Select this check box if you want 
McAfee Fortress to compress a file before encrypting it. This is a 
good idea if you plan to electronically send a file to someone 
because it reduces transmission time and cost. If you are 
encrypting a file that is already compressed, you can deselect this 
option.

• File Deletion–Select what you want McAfee Fortress to do with 
the original files after it finishes encrypting them, if anything. 
Your options are to: keep the original files after encryption, delete 
the originals, or shred the originals. If you shred the original files, 
you can also select whether to use a Shred Level of Quick or U.S. 
Government Multipass, which makes seven passes of shredding.

• Desktop–Select whether you want the McAfee Fortress icon to 
appear on your desktop (this lets you quickly drag and drop 
selected files onto the icon to encrypt or decrypt them). You can 
also select to add the McAfee Fortress command to the Send To 
menu.
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Selecting Self-Decrypting File Properties
McAfee Fortress lets you specify file properties for the self-decrypting files 
you build. These include a text caption, a main text description, what icon 
to use for the file, and other settings. The other settings let you make 
self-decrypting files that:

• Prevent the user from changing the destination where the decrypted 
files are placed.

• Let the user view the contents of the files.

• Always overwrites earlier versions of the same file.

• Automatically decrypts files.

• Executes a command (that you specify in the Command Line text box) 
after the decryption is complete.

• Decrypts to either the current or a temp directory.

McAfee Shredder
When you save a file in Windows, it is stored in multiple pieces (in clusters 
made up of multiple sectors) on the disk. Windows also saves a roadmap, 
or index, that points to these clusters in two copies of the FAT (File 
Allocation Table). The FAT contains the directions to all the pieces of your 
files, so that applications can find them again later.

When you delete a file, all the information stored in that file is not actually 
erased from your disk. Instead, Windows simply frees the clusters where 
the file was stored, making those locations available in the FAT. 
Thereafter, applications can write new information to those clusters. This 
means that all or part of your files can be reconstructed even after you 
delete them. Undelete programs can reconstruct a deleted file very easily, 
especially immediately after you delete the file and before you save any 
new information that might be written over the deleted file’s contents.

For privacy and security reasons, you may want to be positive that the 
information stored in files you delete is permanently erased from your 
computer. McAfee Shredder does this for you by “security wiping” 
deleted files so they cannot be restored or rebuilt using undelete utilities. 
Unlike other file security erase programs, McAfee Shredder erases even 
the filename and the compressed data on DriveSpace drives. Note that it 
is not possible to shred network files, or files compressed with 
compression other than DriveSpace in an absolutely secure manner.
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Í TIP: You can select McAfee Shredder properties to specify the 
shredding level to perform. You can select Quick, which shreds the 
information once, or U.S. Government Multipass, which makes seven 
passes of repeatedly erasing the data.

McAfee Shredder also lets you completely erase other critical non-file 
information that might still be accessible on your disk. The non-file data 
on your disk is the free disk space, file slack, and deleted filenames. When 
you shred a file, McAfee Shredder erases this non-file data for the file you 
shred. However, this information can still be accessible for other files 
you’ve deleted in the past. When you are working with files, Windows 
creates and deletes temporary copies of your work. To be certain that no 
left-over, confidential items are hiding in the free space on your drive, you 
may want to periodically shred the non-file data. When you do this, you 
can no longer undelete previously deleted files.

Free disk space is the amount of currently available disk space on your hard 
drive. It can contain information from files you’ve saved and then deleted 
in the past.

Windows allocates storage space in clusters of sectors that have a 
predetermined size. However the files you save rarely use all the storage 
space reserved for them. The extra, unused storage space reserved for a 
file, but not used, is called file slack. Like free disk space, the file slack may 
contain old data from files you’ve deleted in the past.

In Windows 95, filenames can be up to 255 characters long. This means 
you may have entered sensitive information as part of a filename. And just 
as Windows does not actually erase data in a file when you delete it, it 
does not erase the filenames of deleted files either. McAfee Shredder can 
erase these deleted filenames for you.

Shredding Selected Files
You can shred files using drag and drop, which is a fast way if all the files 
are centrally located. Or if the files are in several places, you can shred 
them by starting McAfee Shredder and selecting the files to erase.

To shred files using drag and drop:

1. Select files in My Computer or Windows Explorer and drag them onto 
the McAfee Shredder icon on the desktop.
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If you have selected the McAfee Shredder properties option to Prompt 
Before Shredding, a message appears listing the first file you dragged 
onto the McAfee Shredder icon. It asks you to confirm that you want 
to shred this file.

2. Do one of the following:

• Click OK to shred the listed file. Repeat this step for each file.

• Click OK to All if you’re positive you want to shred all the files 
you dragged onto the McAfee Shredder icon.

• Click Skip to not shred the listed file and continue selecting 
whether to shred any other files you dragged onto the McAfee 
Shredder icon.

• Click Cancel to return to the desktop without shredding the listed 
file or any others you dragged onto the McAfee Shredder icon.

To shred files in the McAfee Shredder:

1. Select the Select a File to Erase radio button and click Next >. 

2. Do one of the following:

• Enter a path for one or more files to erase, separating each path 
with a space character.

• Click the Browse button to locate one or more files to select.

Select one or more files and click Open.

Í TIP: To select multiple adjacent files, hold down the SHIFT key 
while clicking filenames. To select multiple non-adjacent files, 
hold down CTRL while clicking.

3. Click the Finish button.

If the Prompt Before Erasing check box is deselected in the McAfee 
Shredder Properties dialog box, McAfee Shredder erases the files, 
closes, and returns to the desktop.

If the Prompt Before Erasing check box is selected, a confirmation 
message appears. Go to Step 4.

4. Do one of the following:

• Click OK to shred the listed file. Repeat this step for each file.

• Click OK to All if you’re positive you want to shred all the 
specified files.

• Click Skip to not shred the listed file and continue selecting 
whether to shred any of the remaining files you specified.
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• Click Cancel to return to the desktop without shredding the listed 
file or any others you specified.

Shredding Non-File Data
You can shred non-file data, which is any combination of free disk space, 
file slack, or deleted file names, at any time. Most likely, you’ll want to do 
this after you install Nuts & Bolts 98. If you always use McAfee Shredder 
instead of deleting files in Windows, this non-file data will be shredded as 
part of each file you shred. So if you sometimes delete files, you’ll want to 
periodically shred the non-file data again.

È IMPORTANT: After you shred non-file data, you will not be able to 
undelete any deleted files that utilized this information.

To shred non-file data:

1. Select the Erase Non-File Data radio button and click Next >.

2. Select the information to erase (any combination of Free Disk Space, 
File Slack, and Deleted File Names).

3. Select the drive where you want to erase the selected non-file data and 
click Next >. Then click Finish.

A message appears showing you how the non-file data erasure is 
progressing. When the process is complete, McAfee Shredder closes 
and returns you to the desktop.

McAfee Zip Manager
A zip file is a file that has been compressed and which, therefore, takes up 
less space than it did in its original, decompressed form. A zip file can 
contain one or more files. That is, you can group together several files and 
zip them to form a single, zipped file.

The Nuts & Bolts 98’ McAfee Zip Manager is a complete zip management 
utility that you can use in two ways: via ZipMan Wizard or the advanced 
McAfee Zip Manager.

ZipMan Wizard provides you with all the zip file management features 
you will normally use. It takes you, step by step, through the process of zip 
file creation and extraction.

Advanced McAfee Zip Manager is more suited to people who are 
experienced with manipulating files, to those who want to work 
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independently of a Wizard, or to those who want to take advantage of 
McAfee Zip Manager’s advanced capabilities, some of which are not 
accessible from ZipMan Wizard.

McAfee Zip Manager can become an integral part of your Windows file 
management operations. You can drag files from any location directly into 
the McAfee Zip Manager icon, and you can Right-click a file, and choose 
McAfee Zip Manager from Windows 95/98’s Send To menu to send that 
file directly to McAfee Zip Manager.

Zip Files
There are three good reasons why you would want to create zip files. First, 
zipping files (especially those that you don’t use often) is an effective way 
of reclaiming hard disk space. In general, a zipped file takes up about half 
as much space as its unzipped counterpart.

Second, zipping is a good way to create, manage and store collections of 
related files as archival back-ups. By grouping files, zipping them as a 
single file, and transferring them to a 3.5-inch disk (or other drive) you can 
create archive back-ups of data without tying up large amounts of disk 
space.

Third, you can efficiently share zipped files with other people. Most of the 
larger files you download from the Internet are zipped, so you can 
download them quickly. And by zipping files, you can use one or more 
3.5-inch disks to transfer large amounts of data between computers.

McAfee Zip Manager also lets you create self-extracting zip files, which 
are especially helpful if you share zip files with other people who may not 
have Nuts & Bolts 98’ McAfee Zip Manager or another program to unzip 
the files. A self-extracting zip file contains the decompression portion of 
the McAfee Zip Manager and enables the zip file to extract itself on 
another computer.

Í TIP: When you use the Cleanup Wizard to perform file maintenance, 
one of your options is to zip files. This allows you to compress files 
first rather than shredding, moving, recycling, or deleting them. 
Zipping files you want to dispose of is a good way to verify that none 
of the files are ones you actually need before permanently removing 
them from your system.
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ZipMan Wizard
ZipMan Wizard provides an easy way to use a Wizard-style interface to 
perform the most common tasks. If you do not regard yourself as an 
advanced user of Windows utilities, you will find that ZipMan Wizard lets 
you perform almost all the zip file management tasks you ever need, 
including creating zipped archives, creating self-extracting zip archives, 
adding to zip archive files, unzipping files, and so on. ZipMan Wizard also 
lets you make a default association with Windows Explorer. That is, you 
can simply double-click any zipped file in Explorer to have ZipMan 
Wizard automatically unzip that file and place the extracted file in any 
directory you specify.

And, you can drag files from any location into the ZipMan icon on your 
desktop, just like you drag files that you no longer want into the Windows 
Recycle Bin. After you drag zipped or unzipped files into the ZipMan 
Wizard icon, ZipMan Wizard automatically opens with those files ready 
for you to zip or unzip them.

Advanced McAfee Zip Manager
If you are an advanced Windows utilities user, you may want to use the 
advanced McAfee Zip Manager. The advanced McAfee Zip Manager 
provides a file manager-like interface that lets you perform more 
advanced tasks, such as deleting a file from a zip archive, verifying the 
integrity of a zip archive, adding zip archive comments to files, and so on.

Using ZipMan Wizard
You can use the ZipMan Wizard to perform four separate zip file 
management tasks:

• Extract Files from archive–lets you unzip files (either from your zip 
archives or from another source) and save them to your specified 
directories.

• Create archive–lets you create zip archives in any directories and 
specify which files you want to zip and place in these archives.

• Add files to existing archive–lets you zip files and place them in 
existing archives.

• Build self-extracting archive–lets you convert an existing archive, 
containing one or more zipped files, into an unzipping program that 
can decompress the files without the use of McAfee Zip Manager or 
another unzip program.
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Selecting McAfee Zip Manager Properties
You can specify the properties that you want McAfee Zip Manager to 
have. The properties that you select apply to both ZipMan Wizard and 
advanced McAfee Zip Manager, but you can override some of these 
properties if you are working in advanced McAfee Zip Manager.

Setting Explorer and Startup Options
The General tab in the McAfee Zip Manager Properties sheet offers the 
following options:

• Make default association–allows you to have McAfee Zip Manager 
as your default zip utility. If McAfee Zip Manager is your default, you 
can unzip zipped files in Windows Explorer, simply by 
double-clicking them.

• Add to Send To menu–adds McAfee Zip Manager to the Windows’ 
Send To menu. You can Right-click a file in Windows Explorer and use 
the Send To > ZipMan command to send the file to McAfee Zip 
Manager.

• Install Desktop Icon–places a ZipMan icon on the desktop, allowing 
you to open McAfee Zip Manager from your desktop, and drag files 
into the ZipMan icon for zip file management.

Setting Compression and Source Location Options
The Zip tab in the McAfee Zip Manager Properties sheet offers these 
options:
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• Compression Options–There are three compression options: Save 
Folder Information, Save Current Folder, and Recurse Folders. If none 
of these check boxes are selected, any files you zip, regardless of which 
folder (or directory if you are using Windows 3.1x) they originate 
from, will be saved without any folder information. When you unzip 
these files, they simply appear in the folder where you unzip them.

Save Folder Information–saves the folder name with the files you 
select. When you unzip these files, McAfee Zip Manager checks 
whether the same folder names exist as subfolders at the location 
where you want to place these extracted files. If the subfolders do not 
exist, McAfee Zip Manager creates them.

Save Current Folder–allows you to group all files using their current 
folder, so that the folder information is saved even for files added 
without a folder.

Recurse Folders–allows you to save the files that may exist in any 
subfolders of the folder where you are currently working. If, for 
example, you drag a folder called My Documents  into ZipMan, and 
if this folder contains files and two subfolders (say one named Word 
and another called Excel ), setting the Recurse Folders option lets you 
save the contents of the Word and Excel folders as well. Used on its 
own, the Recurse Folders option will not save the sub-folders’ paths. 
When you extract the files, they are all put into the folder you select 
when you extract them.

You can select any combination of Save Folder Information, Save 
Current Folder, and Recurse Folders to customize the compression of 
your files. For example, selecting all three check boxes saves all the 
files in your current folder and subfolders together with the path 
information. When you extract these files, the folders and subfolders 
are created as subfolders of the folder you select for the extraction 
process.

• Source of Files to Compress–these options let you default to a 
selected folder. You can use these options to accelerate the process of 
locating the folders where your files are located, especially if you 
normally store the files you want to compress in a specific folder.

Current Folder–automatically brings up the current folder where you 
are working.

Archive Folder–lets you default to your specified archive 
folder—useful if you always keep your ‘files-to-be-zipped’ in a special 
folder.

Last Folder–automatically opens the last folder where you were 
working—useful if you have created or saved files in one of your 
folders and now want to zip them.
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Setting Overwrite, Destination and Other Options
The Unzip Options let you customize the overwrite and extraction 
features of your zip file management tasks. You can specify whether the 
extracted files should overwrite existing files with the same name located 
in the folder where you are placing the extracted files, or whether you 
want to be notified that files with the same name already exist. You can 
also establish your default extraction folder as your current folder, the last 
folder where you were working, or a special, dedicated ‘extraction’ folder.

Extracting, Archiving or Adding Files
You can easily extract files, create archive files (zip files), and add files to 
an existing archive (zip the files and add them to a group of existing 
zipped files). To do this, simply select the applicable radio button in the 
ZipMan Wizard window and follow the step-by-step on-screen 
instructions. In each case, ZipMan Wizard walks you through the entire 
process, helping you identify and select the files you want and the 
locations where you want to put the final compressed or extracted files.

Building Self-extracting Archives
You can use ZipMan Wizard to build self-extracting archives—zipped 
files that can be unzipped without the use of an unzip utility. In ZipMan 
Wizard this is a two-stage process. First you need to identify the zipped 
files that you want to convert into self-extracting archives, then you create 
a self-extracting file. You can rename the file to ensure that you keep the 
original zipped files on your system.

Switching Between the Wizard and McAfee Zip Manager
Click the Advanced button in any ZipMan Wizard window to 
automatically go to the advanced McAfee Zip Manager.

Click the ZipMan Wizard tool button in the McAfee Zip Manager window 
to instantly go to ZipMan Wizard.

Using Advanced McAfee Zip Manager
Advanced McAfee Zip Manager provides all the capabilities of ZipMan 
Wizard, plus other, more advanced zip file maintenance features. You 
would use advanced McAfee Zip Manager if you are a more advanced 
user, are familiar with archiving and extracting files, and if you want to 
perform many complex archiving and extraction tasks.
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McAfee Zip Manager Tool Buttons

Í TIP: Point to a McAfee Zip Manager tool button and the status bar at 
the bottom of the window displays a brief description of the tool 
button’s purpose.

The McAfee Zip Manager tool buttons on the toolbar allow you to quickly:

• Create a new archive

• Open an existing archive

• Delete an existing archive

• Obtain information about your current zip archive

• Add files to a zip archive

• Remove files from an archive

• Delete files from the archive

• Switch to ZipMan Wizard

McAfee Zip Manager Menus
As with all Windows programs, the menus let you perform the same 
actions as the tool buttons, as well as perform more specialized and 
detailed tasks. In particular, the Make Self-Extracting Archive 
command—which you can choose from the Actions menu—lets you 
greatly customize the properties of self-extracting files you build.

Menu bar
Toolbar

Column title boxes

File table
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McAfee Zip Manager File Table
The File table in the McAfee Zip Manager window displays the files you 
are currently manipulating. You can select files by clicking them, using 
standard Windows selection techniques. You can rearrange the columns 
by dragging the column title boxes left or right to a new location. You can 
click any column title to sort the files by that information. You can also 
drag files from any location (such as from Windows Explorer) directly into 
the McAfee Zip Manager File table—an effective and efficient method of 
selecting and managing files and archives that follows standard Windows 
file management conventions.

Quickcopy
Nuts & Bolts 98 Quickcopy lets you copy files and folders from one 
location to another faster than using Windows Explorer’s standard copy 
methods. Use EZ Setup to add Quickcopy to the Windows Context menu. 
For more information, see the Nuts & Bolts 98 online help.
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	Deactivating Bomb Shelter
	To deactivate Bomb Shelter:
	1. Start the Bomb Shelter Wizard either by running Bomb Shelter from the Nuts & Bolts program gro...
	2. Click the Deactivate button.



	WinGauge
	The Most Important Gauges
	Working With Gauges
	Adding a New Gauge
	To add a gauge to the WinGauge window’s gauge area:
	1. Point to a gauge or the empty gauge area and press the Right mouse button.
	2. Point to or click the New menu.
	3. Do one of the following:


	Updating a Gauge’s Information
	To update a gauge’s information:

	Removing a Gauge
	To remove a gauge from the WinGauge window:


	Manipulating the WinGauge Window
	Resizing the WinGauge Window
	To resize the WinGauge window:
	1. Point to any corner or side of the WinGauge window.
	2. Drag the window edge in any direction to a new location.


	Resizing Gauges in the WinGauge Window
	To resize gauges in the WinGauge window:
	1. Point to any corner or side of the WinGauge window.
	2. Hold down the Ctrl key and drag the corner or side of the window in any direction to a new loc...


	Rearranging Gauges in the WinGauge Window

	Changing WinGauge Properties
	Changing a Gauge’s Appearance
	To change a gauge’s appearance:
	1. Point to a gauge and press the Right mouse button.
	2. Choose the Properties command.
	3. Select the Appearance properties to use as the default, or to apply to the selected gauge.

	Properties Sheet – Appearance Tab
	Type
	Refresh Duration
	Threshold Style
	Data Style
	Size
	Gauge Text
	Colors


	Changing All Gauges’ Global Properties
	To change all gauges’ global properties:
	1. Point to a gauge and press the Right mouse button.
	2. Choose the Properties command.
	3. Do one of the following:

	Properties Sheet – Global Tab
	Change Dimensions
	Gauge Title Font, Gauge Value Font, and Gauge Font
	Show Bubble Help


	Change a Gauge’s Actions
	To change a gauge’s actions:
	1. Point to a gauge and press the Right mouse button.
	2. Choose the Properties command.
	3. Click the Action tab to bring the tab to the front.
	4. Select the Actions properties to apply to a gauge you are creating.
	5. Do one of the following:

	Properties Sheet – Action Tab
	Invert Alarms
	Enable Warnings/Enable Alarms



	Saving and Loading Gauge Settings
	To save gauge settings:
	1. Point to a gauge and press the Right mouse button.
	2. Choose the Save As command from the Settings menu.
	3. Enter a filename for these settings and click Save.


	Docking and Undocking WinGauge
	To dock the WinGauge window:
	1. Point to a gauge and press the Right mouse button.
	2. Choose the Dock WinGauge command from the Global menu.

	To undock the WinGauge window:
	1. Point to a gauge and press the Right mouse button.
	2. Choose the Undock WinGauge command from the Global menu.


	Dragging Application Icons Into WinGauge
	To drag an application icon into WinGauge:
	Figure 3–1. Drag an application icon into the WinGauge window to add it as an Action gauge; click...



	McAfee VirusScan
	Year 2000 Checker
	What is the Year 2000 Problem?
	Why is the Y2K Issue so Urgent?
	Why Do We Have Y2K Problems With Our Computers?
	What are the RTC, BIOS, DOS, and Windows Clocks?
	How to Ensure Y2K Compliancy of Your PC’s Clocks
	What Dates Does Year 2000 Checker Test and Why?
	What Other Y2K Problems Must You Resolve?
	To determine if your system is Year 2000 hardware compliant:
	1. Click the Start button and do one of the following:
	2. Click Next�>.
	3. Click Next�>.
	4. Click Finish.



	Trash Guard
	Specifying Trash Guard Properties

	Retake
	Protected Volume Files (The Ultimate Backup Protection)
	Why You Should Make Regular Backups With Retake
	How Retake Creates Automatic Backups
	Defining Your Backup Strategy
	Where Will You Store the Backup Set?
	What Files are Important to You?
	How Often Should You or Retake Make Backups?

	Creating a Backup Set
	To create a backup set:
	1. Click the Start button and do one of the following:
	2. Click the Next�> button while the Create a New Backup Set radio button is selected.
	3. Select whether to back up to a Protected Volume File or a Directory. Then click Next�>.
	4. Specify the target destination where the backup set will be created and click Next >.
	5. Click the Settings button if you want to customize any of the settings for this backup set.
	6. Click Apply to apply changes. Then click OK when you are done.
	7. Click Next�>, enter a backup volume name and click Next�> again.
	8. Click OK.


	Restoring Files from a Backup Set
	To restore a backup set:
	1. Open Windows Explorer or My Computer and open the backup set.
	2. Find the files to restore and use Drag and Drop or Copy/Paste to copy files from your backup s...


	Modifying or Deleting Backup Sets
	Modifying an Existing Backup Set
	To modify a backup set:
	1. Click the Start button and do one of the following:
	2. Select the backup set to modify and click the Properties button.
	3. Change the settings and click OK when you are done. Click Finish.


	Deleting a Backup Set
	To delete a backup set:
	1. Start Retake.
	2. Click Next�> while the Delete a Backup Set radio button is selected.
	3. Select the backup set to delete and click Finish. Then click Yes to confirm the deletion.



	Repairing and Rebuilding a Backup Set
	To repair or rebuild a backup set:
	1. Start Nuts & Bolts 98’s Retake utility and click Next�> while the Repair or Rebuild Backup Set...
	2. Do one of the following:
	3. Select the drives that contain a protected volume file you want to restore. Then click Next�>.
	4. Click the Save As button and select where you want the restored volume file to be placed. Then...
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	EZ Setup
	Specifying Startup Options or Logos
	Figure 1. The EZ Setup window

	Specifying Menu Speed, Settings, Shortcuts and History
	Specifying Windows Desktop Icons and Behavior
	Specifying Startup and Start Menu Programs
	Specifying Send To Menu Commands
	Customizing the Context Menu
	Disabling or Enabling a Context Menu Handler
	Removing a Context Menu Command

	Specifying Nuts & Bolts Enhancements
	Figure 2. The Nuts & Bolts tab


	Launch Pad
	Starting Launch Pad
	Adding, Updating and Removing Icons
	Manipulating the Launch Pad Window
	Hiding and Showing Launch Pad
	Docking & Undocking Launch Pad
	Resizing the Launch Pad Window
	Resizing Icons in Launch Pad
	Saving and Loading Settings

	Changing Launch Pad Properties

	McAfee Fortress
	About Encryption
	McAfee Fortress Password Protection
	Encrypting a File
	To encrypt a file:
	1. Select the Encrypt a File radio button and click the Next�> button.
	2. Enter the path to one or more files to encrypt or click the Browse button to select files to e...
	3. Enter a password for the file you are encrypting, and type the password again to confirm it.
	4. Click Finish.


	Decrypting a File
	To decrypt a file:
	1. Select the Decrypt a File radio button and click the Next�> button.
	2. Enter the path to one or more files to decrypt or click the Browse button to select files to d...
	3. Enter the password specified when the encrypted files were created.
	4. Click Finish.


	Building a Self-Decrypting Executable File
	To build a self-decrypting executable file:
	1. Select the Build a Self Decrypting Executable radio button and click the Next�> button.
	2. Enter the path to one or more files to encrypt or click the Browse button to select files to e...
	3. Click the Advanced button to specify self-decrypting file properties if you want.
	4. Specify options you want for the self-decrypting file and click OK.
	5. Click the Next > button.
	6. Enter a filename and path for this self-decrypting executable file and click Next >.
	7. Enter a password for the file you are encrypting, and type the password again to confirm it.
	8. Click Finish.


	Selecting McAfee Fortress Properties
	To select McAfee Fortress properties:
	1. Click the Properties button.
	2. Select properties you want to use and click Apply. Then click OK.


	Selecting Self-Decrypting File Properties

	McAfee Shredder
	Shredding Selected Files
	To shred files using drag and drop:
	1. Select files in My Computer or Windows Explorer and drag them onto the McAfee Shredder icon on...
	2. Do one of the following:

	To shred files in the McAfee Shredder:
	1. Select the Select a File to Erase radio button and click Next�>.
	2. Do one of the following:
	3. Click the Finish button.
	4. Do one of the following:


	Shredding Non-File Data
	To shred non-file data:
	1. Select the Erase Non-File Data radio button and click Next�>.
	2. Select the information to erase (any combination of Free Disk Space, File Slack, and Deleted F...
	3. Select the drive where you want to erase the selected non-file data and click Next�>. Then cli...



	McAfee Zip Manager
	Zip Files
	ZipMan Wizard
	Advanced McAfee Zip Manager
	Using ZipMan Wizard
	Selecting McAfee Zip Manager Properties
	Setting Explorer and Startup Options
	Setting Compression and Source Location Options
	Setting Overwrite, Destination and Other Options

	Extracting, Archiving or Adding Files
	Building Self-extracting Archives
	Switching Between the Wizard and McAfee Zip Manager
	Using Advanced McAfee Zip Manager
	McAfee Zip Manager Tool Buttons
	McAfee Zip Manager Menus
	McAfee Zip Manager File Table
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